
To save a workspace
1. Choose File, Workspace.
2. Type a workspace name in the list box or choose an existing name to overwrite a previous workspace.
3. Click Save.
4. Click Done.

{button ,AL(`wind_ws_over;ws_proc;;;;',0,"Defaultoverview",)} Related Topics



To load a workspace
1. Choose File, Workspace.
2. Choose a workspace name from the list box.
3. Click Load.
4. Click Done.

{button ,AL(`wind_ws_over;ws_proc;;;;',0,"Defaultoverview",)} Related Topics



To delete a workspace
1. Choose File, Workspace.
2. Choose a workspace name from the list box.
3. Click Delete.
4. Click Done.

{button ,AL(`wind_ws_over;ws_proc;;;;',0,"Defaultoverview",)} Related Topics



To create an album
1. Choose File, New.
2. Choose File, Save As.
3. Choose a drive and folder where you want to save the album.
4. Choose MULTIMEDIA MANAGER Albums in the Save as type list box.
5. Type a filename in the box.

{button ,AL(`items_albums_over;album_proc;;;;',0,"Defaultoverview",)} Related Topics



To create a sub-album
1. Select the album you want to add a sub-album to.
2. Choose Edit, Insert Sub-Album.
3. Type a name for the sub-album in the To box.
Note

Sub-albums are placed in alphabetical order under their parent album in the left viewing area. In the right 
viewing area, they always appear before individual items, and can be ordered by name or by date.

{button ,AL(`items_albums_over;album_proc;;;;',0,"Defaultoverview",)} Related Topics



To open an album
1. Choose File, Open.
2. Choose the drive and folder where the album is saved.
3. Click the name of the album.

{button ,AL(`items_albums_over;album_proc;;;;',0,"Defaultoverview",)} Related Topics



To sort items in an album
1. Choose View, Sort By.
2. Choose how you want to sort the items in the album. You can sort by filename, file type (all .BMP files 

together, for example), file size (ascending order), or date the item was inserted in the album.

{button ,AL(`items_albums_over;album_proc;items_proc;;;',0,"Defaultoverview",)} Related Topics



To add items to an album from the drive window
1. If the drive window is not already displayed, Choose View, Drive Window.
2. Open the folders until the item(s) you want to add to the album are displayed in the right viewing area of the 

drive window.
3. Select the item(s).
4. Choose Edit, Copy.
5. Open the album or sub-album you want to add the item(s) to.
6. Choose Edit, Paste.

{button ,AL(`items_albums_over;album_proc;items_proc;;;',0,"Defaultoverview",)} Related Topics



To move items from one album to another
1. Open the album or sub-album containing the item(s) you want to move.
2. Select the item(s).
3. Choose Edit, Cut.
4. Open the album or sub-album you want to move the item(s) to.
5. Choose Edit, Paste.

{button ,AL(`items_albums_over;album_proc;items_proc;;;',0,"Defaultoverview",)} Related Topics



To copy items from one album to another
1. Open the album or sub-album containing the item(s) you want to move.
2. Select the item(s).
3. Choose Edit, Copy.
4. Open the album or sub-album you want to copy the item(s) to.
5. Choose Edit, Paste.

{button ,AL(`items_albums_over;album_proc;items_proc;;;',0,"Defaultoverview",)} Related Topics



To change the drive and path link for item(s)
1. Open the album or sub-album containing the item(s) that have file links you want to change.
2. Select the item(s).
3. Choose Edit, Batch Edit.
4. On the File Links page, choose Update Drive and/or Update Path.
5. Type the drive and path name in the boxes. If you do not remember the entire path, you can use Browse to 

find the correct one.
Note

Do not enter the drive name in the Path box. You must enable the Update Drive option if you want change 
the drive, even if the path you select by browsing specifies a different drive.

{button ,AL(`items_proc;batch_over;;;;',0,"Defaultoverview",)} Related Topics



To export a file
1. Open the album or sub-album containing the item that references the file you want to export.
2. Select the item.
3. Choose File, Export.
4. Choose the drive and folder where you want to export the file.
5. Choose a file type from the Save as type box.
6. Type a filename in the box.

{button ,AL(`items_proc;export_multi_howto;batch_overview;;;',0,"Defaultoverview",)} Related 
Topics



To export multiple files
1. Open the album or sub-album containing the item(s) that reference the file(s) you want to export.
2. Select the item(s). 

You can export all the files referenced in an album by selecting the album in either viewing area.
3. Choose File, Export.
4. Choose the drive and folder where you want to export the file.
5. Choose a file type from the Save as type box.

Files are saved with their original filenames and the new extension.

{button ,AL(`export_file_howto;items_proc;batch_overview;;;',0,"Defaultoverview",)} Related Topics



To add albums to the bookshelf
1. Open the album you want to add to the bookshelf.
2. Choose Edit, Bookshelf, Add.
Note

You can only add root albums to the bookshelf.

{button ,AL(`album_proc;bookshelf_proc;;;;',0,"Defaultoverview",)} Related Topics



To open albums from the bookshelf
1. Choose an album from the bookshelf list box.
2. Choose Edit, Bookshelf, Open.

{button ,AL(`album_proc;bookshelf_proc;;;;',0,"Defaultoverview",)} Related Topics



To delete albums from the bookshelf
1. Choose Edit, Bookshelf, Contents.
2. Choose the album you want to delete.

{button ,AL(`album_proc;bookshelf_proc;;;;',0,"Defaultoverview",)} Related Topics



To change thumbnail properties
1. Open the album or sub-album that contains the thumbnail(s) that have properties you want to change.
2. Select the item(s).
3. Choose Edit, Batch Edit.
4. On the Thumbnail page, choose options to change the color type, resolution and compression method of the 

thumbnail.
{button ,AL(`thumbnail_proc;thumbnail_over;;;;',0,"Defaultoverview",)} Related Topics



To embed file data into an item
1. Open the album or sub-album containing the item(s) that have file data you want to embed.
2. Select the item(s).
3. Choose Edit, Batch Edit.
4. Enable the Update Data option.
5. Choose Embed data from Link.
Note

The file contents are now embedded in the item. You can delete the file from your hard disk if you want to 
save space.

{button ,AL(`archiving_over;archive_proc;;;;',0,"Defaultoverview",)} Related Topics



To copy embedded data to a file
1. Open the album or sub-album containing the item(s) with the embedded data you want to copy.
2. Select the item(s).
3. Choose Edit, Batch Edit.
4. Enable the Update Data option.
5. Choose Create Link from Embedded Data. If the original file already exists, you are asked if you want to 

overwrite it with the data embedded in the item.

{button ,AL(`archiving_over;archive_proc;;;;',0,"Defaultoverview",)} Related Topics



To delete embedded file data from an item

Warning
If you delete the original file from your disk after you embed its contents into the item, you should not 

discard the embedded data if you wish to work with the file again. Choose the Create Link from Embedded Data 
option in the File Links page of the Batch Edit dialog box to recreate the original file on your disk.

1. Open the album or sub-album containing the item(s) that have file data you want to discard.
2. Select the item(s).
3. Choose Edit, Batch Edit. 
4. Choose Discard Embedded Data (re-link).

{button ,AL(`archiving_over;archive_proc;;;;',0,"Defaultoverview",)} Related Topics



To launch the bitmap image and vector drawing editors
1. Open the album or sub-album containing the item that references the file you want to edit.
2. Double-click or SHIFT-double-click the item (depending on the preferences you have set). The program 

launches the appropriate editor based on the format of the file.
Note

You can set preferences for how to launch the mini-editor on the Editors page in File, Preferences.

{button ,AL(`edit_over;edit_proc;;;;',0,"Defaultoverview",)} Related Topics



To flip an image
1. Click Image, Flip.
2. Click Horizontally to create a left-to-right mirrored image, or Vertically to create a top-to-bottom mirrored 

image.

{button ,AL(`edit_proc;vector_edit_proc;bitmap_edit_proc;;;',0,"Defaultoverview",)} Related Topics



To rotate an image
1. Click Image, Rotate.
2. Click a degree of rotation.

If you choose Custom, the Custom Rotate dialog box appears, where you can set any degree of rotation.

{button ,AL(`edit_proc;vector_edit_proc;bitmap_edit_proc;;;',0,"Defaultoverview",)} Related Topics



To scale a vector graphic
1. Click Image, Scale.

The Scale dialog box appears.
2. Click Absolute to assign exact measurements to either dimension, or Proportional to scale the image as a 

percentage of its original size.
3. Type values into the Width and Height boxes.
Tip

If you enable the Maintain Aspect Ration option, when you change one dimension, the other one 
automatically changes to maintain the width to height ratio of the original image.



To change the size of a bitmap image
1. Click Image, Resample.

The Resample dialog box appears.
2. Click Absolute to assign exact measurements to either dimension, or Proportional to scale the image as a 

percentage of its original size.
3. Type values into the Width and Height boxes.
Tip

If you enable the Maintain Aspect Ration option, when you change one dimension, the other one 
automatically changes to maintain the width to height ratio of the original image.

Note
Changing the size of the image may cause loss of quality as the program chooses where to lose or add 

pixels for the new size.



To change the resolution of a bitmap image
1. Click Image, Resample.

The Resample dialog box appears.
2. Choose a value from the Resolution list box.
Notes

Changing the resolution of an image may cause loss of quality, especially going from a higher resolution to
a lower one.

The higher the resolution, the more disk space the image requires.



To crop a bitmap image
1. Click Image, Crop, Select Area.

The cursor changes to cross-hairs.
2. Drag to draw a rectangle around the area you want to keep.
3. Click Image, Crop Image.



To convert a bitmap image to a different color depth
1. Click Image, Convert to.
2. Click the desired color depth.
Note

The higher the color depth, the more disk space it requires.



To save changes made in the mini-editors
Click File, Update.

Note
You cannot update changes to .CDR, .EPS, .GEM, .PIC, .CCH or .PCD files.



To display a slide show of some of or all the items in an album
1. On the Slide Show page of the Tools, Options dialog box, choose Automatic or Manual.

If you choose Automatic, choose a delay period. This is the amount of time an image is displayed on screen 
before the next image is displayed. To include the items contained within sub-albums, enable that option.

2. Select the items you want to include in the slide show.
To create a slide show of all the items, select the album itself.

3. Click View, Slide Show.
The first image appears on screen. If you chose Manual, right-click to advance to the next image and click to 
return to the previous one.

{button ,AL(`slideshows_overview;;;;;',0,"Defaultoverview",)} Related Topics



To search for a specific item in an album
1. Select the items you want to search through.

You can select a sub-album to search through all its files. However, you cannot search through the root album.
2. Click Edit, Search.
3. Choose the type of term to search for, e.g., label, keyword, notes, etc.

To see the list of terms contained within the album, enable the Show ... box.
4. Choose the relationship between your term and the term you are searching for (like, exactly like, not like, not 

exactly like.)
For more detailed information about these operators, refer to the What's This? Help in the dialog box.

5. Type a search term in the box.
6. Click Add.
7. To search using multiple criteria strings, click the "and" or "or" button and repeat steps 3 to 6.

You can place brackets around combinations of criteria strings to ensure they are resolved first, regardless of 
the order they appear in the list.

8. Click Search.
A list of items that meet your criteria appears.

{button ,AL(`items_albums_overview;search_overview;;;;',0,"Defaultoverview",)} Related Topics



Corel MULTIMEDIA MANAGER 6.0 - Overview
Corel MULTIMEDIA MANAGER 6.0 is designed to help you organize, manage and manipulate your multimedia 
files. You can create albums and sub-albums to group your files any way you want. Graphics files are displayed 
as thumbnail images, so that you can easily identify the contents. You can assign keywords to individual items 
and to whole albums to help you search for a particular file in your collection.
Files can be moved and copied between albums using both Cut and Paste or drag and drop methods. You can 
also use these methods to insert files into other applications for editing. The program has two mini-editors as 
well, one for bitmap images and one for vector drawings.    There is also a slide show viewer to allow you to view 
your graphics files at full screen size.



Windows and workspaces
Corel MULTIMEDIA MANAGER 6.0 allows you to open multiple album windows at once within the main window. 
Each album window is split into two viewing areas with individual scrolling bars. The left viewing area shows the 
overall tree structure, while the area on the right shows    sub-albums and individual items. Small book-like icons 
represent collapsed albums, thumbnails represent graphics files, and icons represent non-graphics files.
You can also display a drive window along the bottom of the screen. This window shows you the drives, 
directories and files on your system, and you can drag and drop files from the drive window into your albums. To 
display this window, enable the Drive Window option in the View menu.
Once you have set up a workspace, you can save it and reload it later. You can then save time by not having to 
resize and move windows, or browse through the Open dialog box to locate the albums you want to work on.
Note

You cannot move, copy, rename or delete files from the drive window.



Working with items and albums
In the Corel MULTIMEDIA MANAGER 6.0 filing system, "items" are references to individual files on your computer 
system.
To manage large numbers of files, you group items into albums and sub-albums. These are similar to folders or 
directories in other file management systems. The album is saved as a file on disk. You can embed the file data 
represented by an item within an album.
Items representing graphics files are displayed as thumbnail images of the file contents, while items 
representing non-graphics files are displayed as icons. Different file types, such as sound, text, etc., use different
icons. Albums and sub-albums are represented with book icons.
Note

If you move item files to another drive or folder using Windows Explorer or another file management 
system, you will have to update the path information for those files in Corel MULTIMEDIA MANAGER. Otherwise, 
when you try to access the item, the program looks for it in its original location and gives you an error message 
saying that the file could not be found. You can update drive and path information through either the Batch Edit or 
Properties dialog box in the Edit menu.

{button ,AL(`batch_over;;;;;',0,"Defaultoverview",)} Related Topics



Working with multiple items
Sometimes you may want to change certain properties of more than one item in an album at a time. For 
example, you may have moved some of your original files to another disk drive and need to update the file links 
for the files, or you may want to change the thumbnail size of all the thumbnails. You can change multiple items 
using either the Properties dialog box or the Batch Edit dialog box. Both dialog boxes are accessed through the 
Edit menu or by clicking the right mouse button on one of the selected items.
The Properties dialog box is designed for making changes to one item at a time, but if you select more than one 
item, you do not have to reopen the dialog box to work with each different item. The items' thumbnail appears at
the right of the dialog box with a scroll bar underneath. You can scroll to each item and make changes to that 
item's properties without affecting the other items. To make different changes to several items, use the 
Properties dialog box.
The Batch Edit dialog box allows you to make global changes to all the selected items simultaneously. Because 
each item may start out with different properties, this dialog box cannot provide you with any information about 
individual items, so there is no General page or Notes page in the dialog box. If you specify a change to one of 
the File Link, Keywords or Thumbnail options, the program will make that change to all the items. If a selected 
item already has that option enabled, it will keep that option.
Note

If you want to make changes to all the items in an album and you want to use the Batch Edit dialog box, 
you can select the album in the left viewing area of the album window. However, if you want to use the Properties 
dialog box, you must select all the items in the right viewing area of the window    using the Select All command 
(Edit menu). Selecting the album will provide you with Properties options for the album, not the individual items.

{button ,AL(`items_albums_over;thumbnails_over;archiving_over;;;',0,"Defaultoverview",)} Related 
Topics



Thumbnails
Thumbnails are small representations of the contents of a graphics file. They appear in the right viewing area of 
the album window and provide you with a quick, visual reference to your files, which makes it easier for you to 
locate specific files. You can also print thumbnails so you can have a hard copy of the contents of your graphics 
files.
The data for thumbnails is saved in the album. You can change the size and color depth of the thumbnail. If you 
have a lot of items in an album, you may want to save the thumbnails in a compressed format. These 
preferences can be specified on the Thumbnail page of the Edit, Properties or Edit, Batch Edit dialog boxes.
When you edit an image, corresponding thumbnails are not automatically changed. If you change your file and 
you want to change the thumbnail, you have to open the album(s) containing the item and change one of the 
thumbnail properties. This regenerates the thumbnail, which lets you change the property back to its original 
status. You have to do this for each album containing a thumbnail of the image.
Note

The thumbnail size and the thumbnail display size are different. The thumbnail size, as specified in the 
Properties or Batch Edit dialog boxes, is the number of pixels used to make up the thumbnail. The larger the size, 
the more accurate the representation of the original image. To change the thumbnail display size, choose View, 
Thumbnail Size.

{button ,AL(`batch_over;;;;;',0,"Defaultoverview",)} Related Topics



Printing
You can print the file contents of album items, or just the thumbnails. Printing the file contents takes longer than 
printing only the thumbnails.
You have several options available for printing the files or thumbnails, such as whether to add a page header, 
whether to print frames around the thumbnails, and how many columns of thumbnails to have per page. These 
options are available from the Print dialog box (File menu).
You can also print pages with crop marks and registration marks, and specify other options for printing directly to
film.



Archiving files
When you first insert an item into an album, the item creates a link to the file's original location on disk. 
However, you can choose to embed the file data in a compressed format inside the album. If you want to 
transfer an album to someone else by floppy disk, for example, you can embed the file data so the person does 
not need a copy of the original files.
Embedding the files also helps you manage your hard disk space. Because the embedded data is compressed, 
you can delete the original file from your hard disk, leaving you with more free space for other files.
You cannot access file data that has been compressed. If you want to work on an embedded file, you must 
recreate a link to your hard or floppy disk, which will create a new copy of the uncompressed file on your disk. 
You can recreate the link while keeping the data embedded in the file item, or you can discard the embedded 
data while recreating the link.
Note

If you keep the embedded data and subsequently edit the image on your disk, the embedded file will not 
be updated unless you embed the file data again.

{button ,AL(`batch_over;;;;;',0,"Defaultoverview",)} Related Topics



Editing images
Corel MULTIMEDIA MANAGER 6.0 contains two mini-editors, one for editing bitmap images and the other for 
editing vector drawings. You can flip, rotate, and resize both bitmap and vector images. As well, the bitmap 
editor allows you to crop an image, change its resolution, and convert it to a different color depth. 
You can also launch a file's associated application directly from the album window. You can select the method for 
launching the mini-editor and the associated application on the Editors page of the Tools, Options, dialog box.
When you edit an image, the thumbnail rendering is not automatically updated. You can update the thumbnail by
changing any aspect of the thumbnail in the Properties, Thumbnail dialog box.
Note

If the file is located in more than one album, the thumbnail for each album will have to be updated 
individually.



Displaying slide shows
Corel MULTIMEDIA MANAGER 6.0 contains a slide show viewer so you can view your original files successively at 
full screen size. You can have the slides change automatically with a predetermined time delay, or you can 
change them manually using the mouse. You can also include items in sub-albums in the slide show. You specify 
your preferences on the Slide Show page of the Tools, Options dialog box.
You can have as many files as you want in your slide show. The slides appear in the order that the files are 
arranged in the album, regardless of the order in which they were selected. You can create a slide show of all the
files in an album by selecting the album itself. You can stop a slide show at any time by pressing the ESC key.



Searching for items
Corel MULTIMEDIA MANAGER 6.0 allows you to search for items among your albums. Once you have located the 
items, you can copy them to the Clipboard, make changes through the Properties and Batch Edit dialog boxes, 
print them, export them, or create a slide show with them. Search terms can be labels, keywords, descriptions, 
or notes which you have previously assigned to the dialog boxes. You can also search by the filename or path. 
You can search for terms that are "like", "exactly like", "not like" or "not exactly like" the terms assigned to the 
item. "Like" includes terms containing the string you've defined. If you're looking for a "keyword like pot", then 
any item containing the keywords "pot", "pots" ,"potato", or "hippopotamus" would be included. "Exactly like" 
would only include "pot". You should think of "not" as meaning "everything but terms that are (exactly) like ...". 
Therefore, if you were searching for a "keyword not exactly like pot", you would find all items except those 
containing the exact keyword "pot".
Note

Exactly like" is not case-sensitive. Therefore, if your search term is "pot", any items with the term "POT" 
would also be found. You can specify a case-sensitive search by enabling the Match case option.

A criteria string is a sentence of the following format:search type + search relationship + search term. For 
example, "label like bird", "keyword not like Africa" and "description exactly like house beside a lake" are all 
criteria strings. You can create more than one criteria string to narrow down your search. You can connect criteria
strings with an "and" or an "or" connector. If you specify "'keyword like animal' and 'keyword like elephant'", only
items containing both "animal" and "elephant" as keywords are found. If you replaced the "and" connector with 
an "or" connector, then any item with either keyword (but not necessarily both) is found. With more than two 
criteria strings, the program performs the "and" and "or" operations in the order in which they appear in the list. 
If you put brackets around multiple strings, the operations inside the brackets are performed first.

{button ,AL(`batch_overview;items_albums_overview;;;;',0,"Defaultoverview",)} Related Topics





Workspace dialog box
This dialog box allows you to save and reuse workspaces. rather than having to set up your work area from 
scratch each time you open Corel MULTIMEDIA MANAGER. For example, if you have opened two albums and 
arranged the windows side by side, you can save this arrangement as Workspace 1. The next time you're 
working in Corel MULTIMEDIA MANAGER, you can load Workspace 1, and the two albums will be opened and 
automatically placed side by side again.



A setting that contains information about all the items that appear in the open application, such as windows, 
toolbars, and open documents, and the layout of the items.



Lists workspaces previously saved and allows you to give a name to the workspace you are currently using and 
want to save.



Saves a workspace with the specified name.



Loads a previously saved workspace.



Removes a workspace from memory.



Closes the Workspace dialog box. 



New items page
This dialog box allows you to set preferences to apply to any new items that are added to an album. It will not 
change preferences for items that are already in an album.



When enabled, scans files for keywords and notes and assigns them to the item when it is added to an album.



When enabled, causes file data to be embedded in an item when it is added to an album.



Editors page
This dialog box allows you to select the method for launching the bitmap and vector mini-editors as well as 
applications that have been associated with a particular item.



Activates the appropriate mini-editor (bitmap or vector) when you double-click an item in an album window. 
Activates the item's associated application when you shift double-click the item.



Activates an item's associated application when you double-click the item in an album window. Activates the 
appropriate mini-editor (bitmap or vector) when you shift double-click the item.



Activates the appropriate mini-editor (bitmap or vector) when you shift double-click an item in an album window. 
Activates the item's associated application when you double-click the item.



Activates an item's associated application when you shift double-click the item in an album window. Activates 
the appropriate mini-editor (bitmap or vector) when you double-click the item.



If checked, causes the mini-editor to minimize if the Corel MULTIMEDIA MANAGER window is minimized.



Confirmation page
This dialog box allows you to choose which actions will cause a dialog box to be displayed which asks you if you 
really want to perform the action. If you choose not to have a dialog box displayed for an action, you will not 
have a chance to change your mind after you order the program to perform that action.



Causes a dialog box to be displayed which asks you if you really want to delete an item, sub-album or album.



Causes a dialog box to be displayed which asks you if you really want to replace an item, sub-album or album.



Causes a dialog box to be displayed which asks you if you really want to move or copy an item, sub-album or 
album.



Causes a dialog box to be displayed which asks you if you really want to cancel an action you've begun.



Workspace page
This dialog box allows you to set preferences for managing your workspaces.



Lists currently saved workspaces and allows you to choose which workspace will be displayed when you first 
launch Corel MULTIMEDIA MANAGER. If you choose None, neither the drive window nor any album windows will 
be displayed until you manually open them.



If checked, overwrites the current workspace with the new loaded one. If unchecked, new loaded workspace 
opens on top of the current one.



Slide Show page
This dialog box allows you to set preferences for running a slide show from the items in your albums. 



Advances each slide automatically after displaying for the amount of time specified in the Delay box.



Allows you to advance each slide manually using the mouse. Clicking the right mouse button displays the next 
slide, while clicking the left mouse button displays the previous slide. You can also move through the slides using
the keyboard. The BACKSPACE, LEFT ARROW and DOWN ARROW keys move display the previous slides; all other 
keys move to the next slide.



Sets the time a slide will be displayed before advancing to the next slide. Available only when the Automatic 
option is enabled.



When checked, all items within sub-albums are displayed in the slide show.



Allows you to choose the background color for the full-screen slide show display.



When enabled, the slide show continues until the ESC key is pressed, i.e., it doesn't stop at the last slide. Not 
available with manual mode.



When enabled, bitmap images are stretched to fit the entire page during a full-screen slide show. The image's 
height to width ratio is maintained.



Advanced page
This page allows you to choose advanced options for cutting and pasting or dragging and dropping file data.



When enabled, creates an OLE object when you cut and paste or drag and drop a file from Corel MULTIMEDIA 
MANAGER to another application. If disabled, the pasted/dropped file will be embedded.



When enabled, a file's thumbnail continues to be displayed when it is being dragged and dropped to other areas.



When enabled, opens the Paste Metafile dialog box when you cut and paste or drag and drop a vector graphic to 
another application. This dialog box allows you to scale the graphic before pasting/dropping it.



When enabled, opens the Paste Bitmap dialog box when you cut and paste or drag and drop a bitmap image to 
another application. This dialog box allows you to resample the image before pasting/dropping it.



Bookshelf contents dialog box
This dialog box displays all the albums currently stored in the Bookshelf. You can open or close an album from 
this dialog box as well as delete an album. To add an open album, choose Edit, Bookshelf, Add.



Lists all albums currently stored in the Bookshelf. Click, CTRL-click, or SHIFT-click to highlight the albums you 
want to open, close or remove from the Bookshelf.



Opens the highlighted album(s). You must click OK or Cancel to close the dialog box.



Closes the highlighted album(s). You must click OK or Cancel to close the dialog box.



Removes the highlighted album(s) from the Bookshelf. You must click OK to confirm the action. Does not remove 
the album from your disk.



Item Search dialog box
This dialog box allows you to search for items among your albums. Once you have located the items, you can 
copy them to the Clipboard, make changes through the Properties and Batch Edit dialog boxes, print them, 
export them, or create a slide show with them. Search terms can be labels, keywords, descriptions, or notes 
which you have previously assigned to the dialog boxes. You can also search by the filename or path. 
You can search for terms that are "like", "exactly like", "not like" or "not exactly like" the terms assigned to the 
item. "Like" includes terms containing the string you've defined. If you're looking for a "keyword like pot", then 
any item containing the keywords "pot", "pots" ,"potato", or "hippopotamus" would be included. "Exactly like" 
would only include "pot". You should think of "not" as meaning "everything but terms that are (exactly) like ...". 
Therefore, if you were searching for a "keyword not exactly like pot", you would find all items except those 
containing the exact keyword "pot".
Note

Exactly like" is not case-sensitive. Therefore, if your search term is "pot", any items with the term "POT" 
would also be found. You can specify a case-sensitive search by enabling the Match case option.

A criteria string is a sentence of the following format:search type + search relationship + search term. For 
example, "label like bird", "keyword not like Africa" and "description exactly like house beside a lake" are all 
criteria strings. You can create more than one criteria string to narrow down your search. You can connect criteria
strings with an "and" or an "or" connector. If you specify "'keyword like animal' and 'keyword like elephant'", only
items containing both "animal" and "elephant" as keywords are found. If you replaced the "and" connector with 
an "or" connector, then any item with either keyword (but not necessarily both) is found. With more than two 
criteria strings, the program performs the "and" and "or" operations in the order in which they appear in the list. 
If you put brackets around multiple strings, the operations inside the brackets are performed first.



Displays a    drop-down list that allows you to choose what kind of term you will be using to search for items with.
You can search by label, keyword, description, notes, filename or file path.



Displays a drop-down list that allows you to choose how you want to match the search term with the item terms. 
You can search for terms that are "like", "exactly like", "not like" or "not exactly like". "Not" is equivalent to 
"everything but terms that are ...".



Allows you to enter search term. The drop-down list contains all previous search terms that were added to the 
criteria list and subsequently searched for (i.e., if you changed your mind and closed the dialog box before 
searching, the search terms would not appear in the list).



Lists all the search terms in the album if the "Show ..." option is enabled. Changes according to the type of term 
you are searching. For example, if you are searching by label, only the labels in the album will appear in the list.



Adds the criteria string from the Search for section to the bottom of a list of previously defined strings. The 
second last string will have "and" added to it unless it already has an "or" specified.



Inserts the criteria string from the "Search for" section above the selected string in the list.



Replaces the selected criteria string in the list with the string from the "Search for" section. You must select the 
string before typing new terms in the "Search for" area. If the string being replaced contains an "and" or "or" 
operator, the new string will contain the same operator.



Removes selected criteria strings from the list.



Searches for items in the album that meet all the criteria in the list. Opens a dialog box listing the found items.



Instructs the program to display a list of all the current (labels, keywords, descriptions, notes, filenames or file 
paths) for the selected album. Changes depending on what search term type is selected. Helpful if you can't 
remember what terms you've assigned to various items.



Searches for items in all the sub-albums of the selected album. If not checked, the program only searches for 
items that do not appear within a sub-album.



Directs the program to search only for terms where the characters in the found items are the same case (upper 
or lower) as in the search term. For example, if the search criteria is "keyword like House", then items with the 
keywords "HOUSE"    or "house" are included in the items found.



Connects criteria strings. To be found, an item must meet both conditions on either side of the "and" connector.



Connects criteria strings. To be found, an item must meet one or the other, but not necessarily both, of the 
conditions on either side of the "or" connector.



Adds brackets around multiple selected criteria strings. The program performs the operations within the brackets
before performing any operations outside the brackets.



Removes the brackets surrounding selected strings.



Lists the criteria to be used in the search.



Search results dialog box
This dialog box lists all the items in the selected album that met the search criteria in the Item Search dialog 
box. It also allows you to select some or all of the items and perform certain functions with them from the 
buttons along the right side of the dialog box.



Copies the file's contents from the selected item to the Windows clipboard. From there, you can paste the item 
into another application. You should not select more than one item since only the last one selected remains on 
the clipboard; all previous ones are overwritten.



Opens the Properties dialog box. Any changes you make in that dialog box are applied to all selected items in the
Search Results list.



Opens the Batch Edit dialog box. Any changes you make in that dialog box are applied to all selected items in 
the Search Results list.



Opens the Print dialog box, from which you can print the thumbnails of the selected items in the Search Results 
list, or the actual file contents of the items.



Opens the Export dialog box, from which you can export the selected items in the Search Results list.



Creates an on-screen slide show using the file contents of the selected items. The slides will advance 
automatically or manually, depending on the setting on the Slide Show page of the File, Preferences dialog box.



Selects (highlights) all the items in the Search Results list. Any action you perform with the buttons on the right 
of the dialog box will apply to all these items.



Deselects (removes the highlighting from) all the items in the Search Results list. You can select some of the 
items in the list by clicking, CTRL+clicking or SHIFT+clicking.



File Links page
This page allows you to update the drive and path link information for items that have been moved through the 
file management system.
When you move a file from one drive or folder to another through Windows Explorer or some other file 
management system, Corel MULTIMEDIA MANAGER doesn't keep track of it. The item in the album will still be 
pointing to the original location. If you try to access that file and the contents are not embedded in the item, you
get an error message telling you that the program cannot find the file. To access the file, you need to update the 
drive and/or path information. If you have moved several files, you can select all those albums and just update 
the drive/path information once.
This page also allows you to archive (or unarchive) file data into the corresponding album item. If you have 
selected more than one item, all the items will have the same result, regardless of their original status. For 
example, suppose you have selected two items which have embedded data, and two items that have only links 
to files on disk. If you choose Embed data from Link, all four items will now have the file data embedded in them.



Instructs the program to change the item pointer for files that have been moved to a new drive. If you have 
moved files to a new drive, you must enable this option to have the item pointer updated. This applies even if 
you are changing the path using the Browse button, and the path includes the new drive.



Allows you to type the new drive where the file data for selected items is saved.



Instructs the program to change the item pointer for files that have been moved to a new folder.



Allows you to type the new path leading to the folder where the file data for selected items is saved. You should 
not include drive information in this box.



Opens a dialog box showing you the list of drives and folders on your system to help you locate which folder the 
file data is saved in.



Instructs the program to apply the chosen option to all the selected items in the album.



Embeds the file data for the selected items within the item in a compressed format. After embedding the data, 
you can remove the original file from your hard disk to save space, if required.



Creates a link from the album item to a file on disk. This is necessary if you delete the original file from disk after
you have embedded the data in the item, because you cannot access a file that is stored in a compressed 
format. Enabling this option creates a new copy of the file in the folder specified in the file link path for the item. 
If you enable this option and the file already exists on disk, you will be asked if you want to overwrite the file. 



Removes the embedded data from the item. Once the embedded data is removed, the item becomes a pointer 
to a file on disk.
Warning
If you have deleted the original file data from your disk and then you choose this option, you will lose your entire 
file contents.



Keywords page
This page allows you to add or delete keywords from all the selected items in the album. You can search for 
items in an album using the keywords as search terms.



Allows you to type new keywords to assign to all the selected items in the album.



Lists the keywords that will be assigned to all of the selected items in the album.



Adds the New Keyword to the Item Keywords list.



Removes the selected keywords from the Item Keywords list.



Thumbnail page
This page allows you to specify options for generating the thumbnails that will represent the selected items in an
album. You can choose the thumbnail's color type, the method of generation, the thumbnail's size, and whether 
to save it in a compressed format.
This dialog box cannot provide information about the properties of an item's thumbnail, since many items with 
different properties may be selected. Therefore, if you choose Unchanged or Don't Change as the setting for one 
of the options, the thumbnail for each item retains its current status for that option. Any other setting you specify
is applied to all the selected items' thumbnails.
Note

The thumbnail file data and thumbnail display are not the same. For example, although the display 
matches the color type of the thumbnail file, the size will not necessarily be the same.



Allows you to choose whether to display a thumbnail, and if so, what color depth the thumbnail image should be.
Color choices are black and white, 16 colors, grayscale, 256 colors or 16 million colors (24-bit color). If you 
choose None (no thumbnail), the album items are represented by a blank page icon. If you choose a color type, 
the thumbnails are displayed with that type.



Maintains the currently used method of thumbnail generation for each item's thumbnail.



Generates the thumbnails for the selected items from the information contained in the source image's file 
header. The thumbnails are generated more quickly but less accurately than if the file data is used.



Generates the thumbnails for the selected items from the image data in the source image's file. The thumbnails 
are a more accurate representation of the source image, but take longer to generate than if only the information 
contained in the file header is used.



Allows you to choose how large the thumbnail file image should be. As the thumbnail size increases, the image 
becomes a more accurate representation of the source image.
The thumbnail size and the thumbnail display size are not the same thing. To improve the accuracy of the 
display, you should match the display size to the thumbnail's size. To change the display size of the thumbnail, 
choose View, Thumbnail Size.



Maintains the current method of saving each item's thumbnail data.



Stores the thumbnail data in a compressed format for all the selected items in the album. If you have many 
items in an album, you can significantly reduce the amount of space taken up by the thumbnail data if you 
enable this option. However, each time you open the album, the thumbnails will take more time to display, since 
they have to be uncompressed first.



Stores the thumbnail data in an uncompressed format. 



General page
This page provides you with general information about the album.



Allows you to change the name of the selected album.
Note

You cannot change the name of the root album.



Allows you to assign a description to the selected album. This description is added to each item in the album.



Indicates the path of the selected album within any other albums.



Displays the number of unique keywords assigned to any items within the selected album.



Indicates the default drive for items added to the album.



Detailed page
This page provides detailed information about the selected album.



Displays the name of the selected album.



Displays the number of items in the selected album.



Displays the number of sub-albums in the selected album.



When enabled, items in the selected album's sub-albums are scanned to provide the detailed information.



Lists all the items in the selected album.



Lists all the sub-albums in the selected album.



Keywords page
This page provides information about the keywords assigned to items in the selected album.



Displays the number of keywords assigned to items in the selected album.



Displays a list of all the keywords assigned to items within the album.



When enabled, keywords in sub-albums are displayed as well.
Note

The first level of sub-albums are considered as items; therefore, even if this option is not enabled, the 
keywords in items in those albums are included in the list.



Displays the number of references of the keyword selected in the keyword list (above), i.e., how many times the 
keyword is used in the constituent items in the album.



Thumbnail page
This page allows you to specify how to generate the thumbnail for new items added to the selected album. You 
can choose the thumbnail's color type, the method of generation, the thumbnail's size, and whether to save it in 
a compressed format.
Note

The thumbnail file data and thumbnail display are not the same. For example, although the display 
matches the color type of the thumbnail file, the size is not necessarily the same.



Allows you to choose whether to display a thumbnail, and if so, what color depth the thumbnail image should be.
Color choices are black and white, 16 colors, grayscale, 256 colors or 16 million colors (24-bit color). If you 
choose None (no thumbnail), the item is represented by a blank page icon. If you choose a color type, the 
thumbnail is displayed withthat type.



Generates the thumbnails for the selected item from the information contained in the source image's file header.
The thumbnail is generated more quickly but less accurately than if the file data is used.



Choose a method of compression from the two options below. 



Choose a method of thumbnail generation from the two options below. 



Generates the thumbnail for the selected item from the image data in the source image's file. The thumbnail is a
more accurate representation of the source image, but takes longer to generate than if only the information 
contained in the file header is used.



Allows you to choose how big the thumbnail file image should be. As the thumbnail size increases, the image 
becomes a more accurate representation of the source image.
The thumbnail size and the thumbnail display size are not the same thing. To improve the accuracy of the 
display, you should match the display size to the thumbnail's size. To change the display size of the thumbnail, 
choose View, Thumbnail Size.



Stores the thumbnail data in a compressed format. If you have many items in an album, you can significantly 
reduce the amount of space taken up by the thumbnail data if you enable this option. However, each time you 
open the album, the thumbnails will take more time to display, since they have to be uncompressed first.



Stores the thumbnail data in an uncompressed format. 



General page (Properties dialog box)
This page provides you with general information about the individual items in the album.



Allows you to change the name of the selected file. This name only identifies the item within the album; it has no
effect on the original file.



Allows you to assign a description to an item. You can use this description when performing an item search.



Displays a list of attributes pertaining to the selected file.



Identifies the path of the item within the album.



Identifies the path of the source file.



Provides information about how the file is stored, and the size of the file.



Identifies the type of data in the file, e.g., bitmap, vector, animation, etc.



Lists all keywords assigned to the item.



Provides information about the properties of the item's thumbnail.



Keywords page
This page displays the keywords assigned to the selected item and the album the item is in. You can also assign 
new keywords to the item.



Allows you to assign a new keyword to the selected item.



Lists the keywords assigned to the selected item.



Adds the keyword from New Keyword to the Item Keywords list.



Removes the keyword selected in the Item Keywords list from the item.



Lists the keywords assigned to all the items at the same album level.



Lists the keywords in all the items in the root album and all sub-albums.



File Links page
This page provides information about the item's source file's location and size. It also allows you to embed data 
into the album, create a link to a disk, or discard the embedded data.



Displays the attributes assigned to the current file.



Displays the permissions assigned to the current file.



Choose an file update method from the options below.



Allows you to type the new drive where the file data for selected items is saved.



Instructs the program to change the item pointer for files that have been moved to a new folder.



Indicates the size of the source file.



Opens a dialog box showing you the list of drives and folders on your system to help you locate which folder the 
file data is saved in.



Indicates the date of the most recent modification to the source file.



Indicates the time of the most recent modification to the source file.



Indicates the application associated with the source file. You create an association through your Windows 95 
operating system.



When checked, indicates the file is read-only.



When checked, indicates the file is a system file.



When checked, indicates the file is hidden.



When checked, indicates the file is archived.



When checked, indicates the file is an executable file, i.e., a file that launches an application.



When checked, indicates the file has a Read permission attached to it.



When checked, indicates the file has a Write permission attached to it.



When checked, indicates the file has special permissions attached to it.



Instructs the program to apply the chosen option to the selected item. 



Embeds the file data for the selected items within the item in a compressed format. After embedding the data, 
you can remove the original file from your hard disk to save space, if required.



Creates a link from the album item to a file on disk. This is necessary if you delete the original file from disk after
you have embedded the data in the item, because you cannot access a file that is stored in a compressed 
format. Enabling this option creates a new copy of the file in the folder specified in the file link path for the item. 
If you enable this option and the file already exists on disk, you will be asked if you want to overwrite the file. 



 Removes the embedded data from the item. Once the embedded data is removed, the item becomes a pointer 
to a file on disk.
Warning

If you have deleted the original file data from your disk and then you choose this option, you will lose your 
entire file contents.



Notes page
This page allows you to assign notes to an item. You can use the notes during an item search.



Provides a space for typing notes about the selected item.



Thumbnail page
This page allows you to specify how to generate the thumbnail that will represent the selected item in an album. 
You can choose the thumbnail's color type, the method of generation, the thumbnail's size, and whether to save 
it in a compressed format.
Note

The thumbnail file data and thumbnail display are not the same. For example, although the display 
matches the color type of the thumbnail file, the size is not necessarily the same.



Choose a method of file generation from the options below.



Choose a method of file compression from the options below.



Choose a method of file generation from the options below.



Choose a method of file compression from the options below.



Allows you to choose whether to display a thumbnail, and if so, what color depth the thumbnail image should be.
Color choices are black and white, 16 colors, grayscale, 256 colors or 16 million colors (24-bit color). If you 
choose None (no thumbnail), the item is represented by a blank page icon. If you choose a color type, the 
thumbnail is displayed withthat type.



Allows you to choose how big the thumbnail file image should be. As the thumbnail size increases, the image 
becomes a more accurate representation of the source image.
The thumbnail size and the thumbnail display size are not the same thing. To improve the accuracy of the 
display, you should match the display size to the thumbnail's size. To change the display size of the thumbnail, 
choose View, Thumbnail Size.



Generates the thumbnails for the selected item from the information contained in the source image's file header.
The thumbnail is generated more quickly but less accurately than if the file data is used.



Generates the thumbnail for the selected item from the image data in the source image's file. The thumbnail is a
more accurate representation of the source image, but takes longer to generate than if only the information 
contained in the file header is used.



Stores the thumbnail data in a compressed format for the selected item in the album. If you have many items in 
an album, you can significantly reduce the amount of space taken up by the thumbnail data if you enable this 
option. However, each time you open the album, the thumbnails will take more time to display, since they have 
to be uncompressed first.



Stores the thumbnail data in an uncompressed format. 



Assigns the current thumbnail settings to new items added to an album.



Displays the current default settings for album thumbnails.



Animation Export dialog box
This dialog box allows you to choose which frames of an animation file to export to bitmap file format.



Lists the name of all animation files currently selected within the album.



Displays each frame of the currently selected animation file. Click the scroll buttons to advance and rewind the 
frames.



Provides a space for you to specify the first frame of the animation file to be exported. All frames between this 
and the specified last frame are exported.



Provides a space for you to specify the last frame of the animation file to be exported. All frames from the 
specified first frame to this one are exported.



Clockwise and counterclockwise are reversed: but OK.



Custom Rotate dialog box
This dialog box allows you to rotate the file image to any degree of rotation.



Sets the angle of rotation.



Rotates the image in a counterclockwise direction.



Rotates the image in a clockwise direction.



Rotates the image without closing the dialog box. This allows you to change the degree of rotation without 
having to open the dialog box again. Click OK to close the dialog box.



Image Information dialog box
This dialog box provides information about the bitmap image.



Indicates the color type of the bitmap image.



Indicates the width of the image in pixels.



Indicates the height of the image in pixels.



Indicates the number of pixels per inch vertically in the image.



Indicates the number of pixels per inch horizontally in the image.



Resample/Scale dialog box
This dialog box allows you to resample or scale a bitmap image or vector graphic, i.e., change its size. The 
resolution of bitmap images can also be changed using this dialog box. 
Note

Resampling an image can cause loss of quality as the program decides where to throw away and where to 
add pixels.



When enabled, resamples the image using absolute dimension values.



When enabled, resamples the image as a percentage of the current dimensions.



Allows you to change the width of your image to an absolute value in pixels.



Allows you to change the width of your image as a percentage of its original size.



Allows you to change the height of your image to an absolute value in pixels.



Allows you to change the height of your image as a percentage of its original size.



When enabled, resamples the image proportionately. As soon as you change a setting for either the horizontal or 
vertical dimension, the other dimension changes automatically.



Allows you to change the resolution of the image. The setting is applied to both the horizontal and vertical 
dimensions.



Provides information about the application.



Provides information about the version of the application.



Provides information about the author of the application.



Provides information about the application's copyright.



Opens the Font dialog box, which allows you to choose a font for the printed header.



Allows you to write custom text for the printed header.



Removes the selected keyword from the list.



Resamples or scales the image without closing the dialog box. This allows you to change the size of the image 
without having to open the dialog box again. Click OK to close the dialog box.



Rename dialog box
This dialog box allows you to choose a new name for a sub-album. When a sub-album is created, it is called Sub-
Album1 (2, 3, etc.,) depending on how many are created.
Note

To rename the root album, use the Save As command in the File menu. 



Displays the current name of the selected album/sub-album.



Displays the current name of the selected album/sub-album.



Allows you to type a new name for the selected album/sub-album.



Allows you to type a new name for the selected album/sub-album.



Displays list of items found that meet the criteria you described in the Search dialog box.



Selects all the items in the list so you can perform batch operations on them.



Allows you to choose the direction to rotate the image.



Allows you to choose a typeface. 



Allows you to choose a typeface.



Allows you to choose text attributes. 



Allows you to choose text attributes.



Allows you to choose a font size. 



Allows you to choose a font size.



Applies the current font settings without closing the dialog box.



Displays a sample of the chosen font. 



Displays a sample of the chosen font.



About Dialog box
all aliased to this single topic



Displays the version, user registration, and serial number of the application, as well as system disk space and 
memory currently available.



Confirm DB



Displays the name of the file you are working with.



Cancels the confirmation. The dialog box closes without proceeding with any action.



Replace 



Delete



Export DB options (Unique to MMMANAGER)



Displays a drop-down box listing several color depth options. Apply a color depth to the item before exporting.



Enable to include any and all constituent sub-albums included in the album.



Displays a drop-down box listing one or more methods of file compression. The list of compression methods 
varies with the file format (export filter) selected.



Closes this dialog box and initiates export.



Click this to display an overview of this dialog box. 
For Help on an item, click ? at the top of the dialog box, and then click the item.



Closes this dialog box without saving any changes you have made. 



When enabled, suppresses the dialog box that lets you specify options for exporting a file to or from the specified
file format. The program automatically assigns default settings.



Help



Click this to display an overview of this dialog box. 
For Help on an item, click ? at the top of the dialog box, and then click the item.



Printing Options dialog box
The Printing Options dialog box lets you control the way files and thumbnails are printed. 



Enable to control dialog box settings when working with files. 
Note

When enabled, the Thumbnail Options controls are grayed out.



Enable to control dialog box settings when working with thumbnails.



Enter the numbers of thumbnails to be printed per row on the printout.



Enable to print a frame around the thumbnail images.



Enable to regenerate the thumbnails before printing.



Enable to print the file name below each thumbnail on the page.



Enable to print the path below each thumbnail on the page.



Enable to include the file header when printed.



Enable to include the file header on each page of a multi-page printing task.



Enable to print consecutive page numbers on each page of a multi-page printing task.



Enter the custom text you want to appear as a header on each page printed in a multi-page printing task.



Enable to print a border around the entire file or page of thumbnail images.



Enable to apply the options to all sub-albums attached to an album.



Click to open the Font dialog box where you choose a font for the header you have chosen. 





New command (File menu)
Creates a new album. An empty album window will appear on the screen. The album is titled Album1 (2, 3, etc.), 
depending on how many new albums have been created. To change the name of the album, use the Save As 
command in the File menu. You can insert items into the album by using the Insert Item command in the Edit 
menu, or by dragging and dropping items from the Drive window or another open album.



Open command (File menu)
Loads an existing album into the Corel MULTIMEDIA MANAGER window.



Close command (File menu)
Closes the active album. If any changes have been made to the album since the last Save command, you are 
prompted to save them. 



Save command (File menu)
Saves the active album to disk. If you have made any changes to the album since the last Save command, the 
new version overwrites the old version without asking you for confirmation. If you have renamed the album since
you created it, the Save As dialog box automatically opens.



Save As command (File menu)
Allows you to rename an album and save it to disk. You cannot change the file format of an album.



Select Source command (File menu)
Opens the Select Source dialog box, which lets you choose a TWAIN image input source such as Corel Image 
Source or HP’s Deskscan II. The sources that appear in the selection box depend on the scanner driver(s) 
installed on your system. If the scanner you want does not appear in the Select Source dialog box, then the 
TWAIN driver has not been installed, or the computer does not recognize it due to possible system hardware 
conflicts. Refer to your scanner’s documentation to verify proper installation and operation.



Acquire Image command (File menu)
Allows you to access external devices and control input devices, such as scanners or video capture boards, 
without exiting Corel OCR-TRACE.



Export command (File menu)
Exports files to different file formats.



Send command (File Menu)
Lets you send images to other users via the Microsoft Exchange. The Inbox Setup Wizard will help you setup your
mailbox so you can send and send images through e-mail.



Print command (File menu)
Allows you to print the contents of the selected items' source files, or the corresponding thumbnails.



Print Settings command (File menu)
Opens the Print Settings dialog box where you control settings for the printing of files and thumbnails.



Most Recently Used Files command (File menu)
Lists the most recently used file(s). You can open one of these files by clicking here instead of using the File, 
Open command.



Exit command (File menu)
Exits Corel MULTIMEDIA MANAGER 6.0. You are prompted to save any changes before the application is closed.



Slide Show command (View menu)
Creates a screen slide show from the selected items' source files. The Corel MULTIMEDIA MANAGER window 
disappears and each image is shown at full size on a blank background. If you select an album on the left 
viewing area of the album window, all the items in the album appear in the slide show. To include items 
contained within sub-albums, you must enable that option on the Slide Show page of the Tools, Options dialog 
box. You can also choose whether to advance the slides manually or automatically. To stop the slide show at any 
time, press ESC.



Workspace command (File menu)
Opens the Workspace dialog box, which allows you to save, load, and delete workspaces. A workspace describes 
the working area of the application, including windows, toolbars and open files, as well as their layout.



Cut command (Edit menu)
Sends the selected item to the Windows Clipboard and removes it from the album. 



Copy command (Edit menu)
Sends the selected item to the Windows Clipboard and keeps a copy in the album.



Paste command (Edit menu)
Pastes an item from the Windows Clipboard into the current album.



Delete command (Edit menu)
Removes the selected item(s) from the album.



Select All command (Edit menu)
Selects all items and/or sub-albums in the right viewing area of the album window.



Rename command (Edit menu)
Allows you to rename an item and or sub-album. You can only select one item or sub-album at a time. The name 
you give the item is also its label, which can be used as a search term. You cannot have more than one item with
the same name within the same album level. To rename the root album, use the Save As command (File menu).



Add command (Edit menu)
Adds the active album to the bookshelf. Adding albums to the bookshelf saves you time when you want to load 
an album, since you don't have to go through all the levels in the File, Open dialog box.



Open command (Edit menu)
Loads the album currently selected in the bookshelf into the Corel MULTIMEDIA MANAGER window.



Contents command (Edit menu)
Opens the Bookshelf dialog box, which allows you to open, close or delete an album from the bookshelf.



Insert Sub-Album command (Edit menu)
Creates a new sub-album within the currently open root album or sub-album.



Insert Item command (Edit menu)
Opens the Insert Item dialog box, which allows you to add items to an album.



Search command (Edit menu)
Opens the Search dialog box, which allows you to locate items within your albums. You can use labels, keywords 
notes, descriptions, filenames and file paths assigned to the items as search terms. Different criteria strings can 
be combined to narrow your search field.



Batch Edit command (Edit menu)
Opens the Batch Edit dialog box, which allows you to edit the file links, keywords, or thumbnails of multiple items
simultaneously.



Properties command (Edit menu)
Opens the Properties dialog box, which allows you to change the properties for individual selected items. You can
select multiple items, but you must make changes to each item by itself. The items' thumbnails appear in a 
preview box with a scroll bar underneath so you can go to each item and make the appropriate changes.



Indicate Expandable command (View menu)
When enabled, displays an icon with a + sign to indicate that an album can be further expanded, and a - sign to 
indicate the album is completely expanded.



Show Lines command (View menu)
Shows or hides the lines between albums and sub-albums in the left viewing area of the album window.



Toolbars command (View menu)
Opens the Toolbars dialog box, which allows you to choose which toolbars to display.



Color Correction: None command (View Menu)
Improves or optimizes the linearity of your monitor so that on-screen images appear to be as similar as possible 
to a white-balanced photograph. None provides no color correction.



Color Correction: Fast command (View Menu)
Improves or optimizes the linearity of your monitor so that images appear as similar on-screen as possible to a 
white-balanced photograph. Fast provides a general color approximation.



Color Correction: Accurate command (View Menu)
Improves or optimizes the linearity of your monitor so that on-screen images appear to be as similar as possible 
to a white-balanced photograph. Accurate provides the best possible screen colors.



Color Correction: Simulate Printer command (View Menu)
Optimizes the linearity of your monitor so that on-screen images appear to be as similar as possible to a white-
balanced photograph. Simulate Printer displays screen colors as they would appear when printed.



List command (View menu)
Lists the items/sub-albums in a format with the icon/thumbnail on the left and the name of the item/sub-album 
beside it. The list goes down a column, then over to the top of the next column on the right.



Details command (View menu)
Lists the sub-albums/items in one column and includes details about the size and the date of items.



Thumbnails command (View menu)
Lists the sub-albums/items in a format with the name of the sub-albums/items below the icon/thumbnail. The list 
goes down a column, then over to the top of the next column on the right.



Name command (View menu)
Sorts the sub-albums/items in alphabetical order by name.
Note

Sub-albums always appear before individual items.



Size command (View menu)
Sorts the sub-albums/items from smallest to largest by size of the source file.
Note

Sub-albums always appear before individual items.



Type command (View menu)
Sorts the items by grouping them based on the source file formats. File types are sorted alphabetically based on 
the three-letter extension. For example, HOUSE.CMX would come before HOUSE.TIF. Within a file type, the items 
are sorted alphabetically by name.



Date command (View menu)
Sorts the items based on the date and time of the source file, from earliest to latest.



Default command (View menu)
Sorts the items by when they were added to the album.



Small command (View menu)
Displays 16 pixel by 16 pixel thumbnails of items.
For the most accurate representation of the thumbnail file, choose Small in the Size box on the Thumbnails page 
of the Properties, or Batch Edit dialog box (Edit menu).



Medium command (View menu)
Displays 32 pixel by 32 pixel thumbnails of items.
For the most accurate representation of the thumbnail file, choose Medium in the Size box on the Thumbnails 
page of the Properties, or Batch Edit dialog box (Edit menu).



Large command (View menu)
Displays 64 pixel by 64 pixel thumbnails of items.
For the most accurate representation of the thumbnail file, choose Large in the Size box on the Thumbnails page 
of the Properties, or Batch Edit dialog box (Edit menu).



Extra Large command (View menu)
Displays 128 pixel by 128 pixel thumbnails of items.
For the most accurate representation of the actual thumbnail file, you should choose Extra Large in the Size box 
on the Thumbnails page of the Properties, or Batch Edit dialog box (Edit menu).



Font command (View menu)
Opens the Font dialog box, which allows you to change the font, style, and size of the lettering for album and 
item names. The changes only apply to the active album. The left and right viewing areas must be changed 
separately. All items within each viewing area will have the same font.



Set as Default command (View menu)
Sets the current album settings, such as item sort order, splitter bar location, text font size, etc., as default 
settings. New albums will have the same settings when created.



Main command (View menu)
Shows or hides the main toolbar.



Launcher command (View menu)
Shows or hides the launcher toolbar, which contains buttons for launching other applications from within Corel 
MULTIMEDIA MANAGER.



Bookshelf command (View menu)
Shows or hides the bookshelf toolbar, which contains buttons for adding items to the bookshelf and opening 
items from it, as well as the drop-down list of albums contained within it.



Status Bar command (View menu)
Shows or hides the status bar at the bottom of the Corel MULTIMEDIA MANAGER window.



Drive Window command (View menu)
Shows or hides the Drive Window. This window displays the hierarchy and contents of the folders throughout 
your computer system. You can drag and drop items from the Drive Window into an album.



Options command (Tools menu)
Opens a six-page dialog box that allows you to set a number of preferences for working in Corel MULTIMEDIA 
MANAGER. You should go through all the pages at least once to see what your options are. For overview 
information on each page, click the Help button, or use the What's This? button to obtain information on each 
control.



Customize command (Tools menu)
Opens the Customize dialog box, which allows you to customize toolbars, menus, and keyboard shortcuts.



Color Wizard command (View Menu)
he Color Manager lets you define a profile of the color reproduction characteristics of your desktop publishing 
system. This profile ensures that the colors captured through the scanner are consistent with those you see on 
the monitor, which in turn are consistent with the colors reproduced by the printer.
The color manager is presented as a wizard, which walks you through each stage of setting up a profile for each 
of your devices. You can select from the pre-packaged profiles provided by Corel, or you can create a set of 
custom device profiles to fully optimize and control color reproduction at every pre-press stage. Once your have 
defined the device profiles, the color manager automatically generates the system profile. 



Select Color Profile command (Tools Menu)
Lets you choose a system profile from the library of profiles that you've created for your applications. This is a 
quick way of changing the color mapping characteristics of your system "on the fly" without using the Color 
Manager Wizard.

Use the Color Manager Wizard to create or edit system profiles.



New Window command (Window menu)
Creates another album window containing a copy of the active window.



Cascade command (Window menu)
Overlaps multiple album windows within the Corel MULTIMEDIA MANAGER main window.



Tile Horizontally command (Window menu)
Stacks multiple album windows below each other, with each window filling the entire width of the Corel 
MULTIMEDIA MANAGER main window.



Tile Vertically command (Window menu)
Places multiple album windows beside each other, with each window filling the entire height of the Corel 
MULTIMEDIA MANAGER main window.



Arrange Icons command (Window menu)
When enabled, minimized windows are arranged along the bottom of the workspace.



Close All command (Window menu)
Closes all open album windows. If changes have been made to an album since the previous Save command, you 
are prompted to save those changes.



Close command (Window menu)
Closes the active album. If any changes have been made to the album since the last Save command, you are 
prompted to save them. 



Refresh command (Window menu)
Refreshes the Drive window. If the Drive window was open when you made a change to the file structure through
Windows Explorer or other file management system, you need to refresh the drive window to ensure it contains 
the most up-to-date information.



Currently Open Albums list
Lists each currently opened album. To access a particular album from the list, click on the album name.



Help Topics command (Help window)
Opens the Corel MULTIMEDIA MANAGER Help file on the Contents page.



What's This? command (Help menu)
Provides access to context sensitive Help. Click the What's This? command, then click a menu item, toolbar, or 
other screen item to get a description of its function.



Technical Support command (Help Menu)
Opens the Technical Support help file that provides details on product support for Corel applications, including 
support services, import and export filters information, error messages, and troubleshooting tips.



About command (Help menu)
Provides version, copyright and registration information about Corel MULTIMEDIA MANAGER 6.0.



 V I E W E R S



Update command (File menu)
Saves changes that have been made in the editor to the file data.
Note

You cannot update changes to .CDR, .EPS, .GEM, .PIC, .CCH or .PCD files.



Exit command (File menu)
Exits the Corel Clipart Editor.



Undo command (Edit menu)
Undoes the last command executed.



Copy command (Edit menu)
Copies the image to the Windows Clipboard and retains the original.



Flip Horizontally (Image menu)
Transforms the graphic to a left-to-right mirrored image of itself.



Flip Vertically (Image menu)
Transforms the graphic to a top-to-bottom mirrored image of itself.



Rotate 90 Clockwise command (Image menu)
Rotates the graphic 90 degrees clockwise.



Rotate 90 Counterclockwise command (Image menu)
Rotates the graphic 90 degrees counterclockwise.



Rotate 180 (Image menu)
Rotates the graphic 180 degrees.



Custom Rotate (Image menu)
Opens the Custom Rotate dialog box, which allows you to rotate the image to any degree of rotation.



Scale command (Image menu)
Opens the Scale dialog box, which allows you to change the size of the vector graphic.



Toolbar command (View menu)
Shows or hides the toolbar.



Status Bar command (View menu)
Shows or hides the status bar.



Refresh command (Window menu)
Refreshes the image.



Zoom In command (Window menu)
Changes the cursor to a magnifying glass. Click to zoom in by preset amounts, or drag a marquee around the 
area to isolate.



Zoom Out command (Window menu)
Zooms image out to preset levels each time you click.



Zoom 1 to 1 command (Window menu)
Zooms the image to its actual size, i.e., one inch in the image equals one inch on your monitor.
Note

If your monitor is not calibrated, the image may not appear at its actual size. To calibrate your monitor, 
hold a ruler against an image whose dimensions you know and adjust the screen settings until the width and height 
on-screen are the actual dimensions.



Zoom To Fit command (Window menu)
Displays the graphic at the zoom level where it fills the entire window.



Zoom To Page command (Window menu)
Zooms the image to the level where the page fills the window.



Index command (Help menu)
Opens the Corel MULTIMEDIA MANAGER Help file to the Index page.



About the CMX/RIP viewers (Help menu)
Provides version, copyright and registration information about Corel MULTIMEDIA MANAGER 6.0 CMX and RIP 
viewers.



Using Help (Help Menu)
Provides help about how to use online Help and access information.



Open command (File menu)
Loads a vector graphic file to be edited.



Open command (File menu)
Loads a bitmap image file to be edited.



BITMAP-UNIQUE ITEMS



Exit command (File menu)
Exits the Corel Bitmap Editor application.



Resample command (Image menu)
Opens the Resample dialog box, which allows you to change the size and resolution of the bitmap image.



Select Area command (Image menu)
Changes the cursor to cross hairs. Drag to draw a marquee around the area to be cropped.



Crop Image command (Image menu)
Crops the image to the area defined by the Crop marquee.



Convert to Black and White command (Image menu)
Converts image to black and white (2-bit) mode.



Convert to 16 Colors command (Image menu)
Converts image to paletted 16-color (4-bit) mode.



Convert to Grayscale command (Image menu)
Converts image to 256-step grayscale (16-bit) mode.



Convert to 256 Colors command (Image menu)
Converts image to paletted 256-color (16-bit) mode.



Convert to RGB command (Image menu)
Converts image to RGB (24-bit) mode.



Information command (Image menu)
Opens the Image Information dialog box, which provides information about the color type, size, and resolution of 
the image.





Print dialog box
The Print dialog box allows you to set basic print settings, to set more complex print settings, and to print. Use 
the dialog box to indicate:

which device driver to use
whether to print to the device or to a file instead
which pages or objects to print
how many copies you require
whether to collate the pages
which printer color profile to use
which printing style to use

You can also choose the following:
To change or to review your printer settings
To set more complex parameters, including color separation specifications, and preview your print job
To print using the settings you have chosen

{button ,AL(`dial_print;;;;',0,"Defaultoverview",)} Related Topics





Print Options dialog box
The Print Options dialog box allows you to set more complex parameters, including color separation 
specifications and to preview your print job.
Printing style
Use Printing style to select, create, edit, and delete printing styles. Printing style allows you to save the Print 
Options settings for later use.
Preview box

Use the Preview box to position and size your artwork. The Preview box also allows you to review color-separated
jobs separation by separation.

Reference tools

Use reference tools to add reference marks to your print job (e.g., crop marks and page number), as well as to 
specify whether you wish to print a negative or positive image and whether you wish to print with the film emulsion 
up or down.

Layout page
Use Layout page options to position and size your artwork.
The Layout style options allow you to print your work in different forms. For example, you can create a greeting 
card or a booklet with your work by properly applying layout styles.
Separations page
Use the Separations page to print color separations and to specify color separation parameters, including 
enabling automatic color trapping. You can also enable Use advanced settings. Once this option is enabled, click 
Advanced to set advanced color separation settings (i.e., halftone screen settings and color trapping).
Options page
Use the Options page to set various advanced options.
The Fountain steps option allows you to specify how many steps your linear fountain fills will contain when 
printed.
The Screen frequency option allows you to specify what halftone screen frequency you will use.
Note

If you are using color separations and advanced settings, set the screen frequency in advanced settings
The PostScript Preferences button allows you to change your PostScript settings if you are using a PostScript 
device driver.
The Proofing options allow you to specify specific types of objects to print (e.g., text only). They also allows you 
to print colors as black or grayscale, to print text as black, and to fit printer's marks (such as crop marks and 
calibration bars) and layout to the page.
The Print job information sheet option prints a report with information about your print job. Use the Info Settings 
to customize the information sheet.
The Special settings option allows you to change settings that were previously edited in CORELPRN.INI.
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Print Job Information dialog box
The Print Job Information dialog box allows you to specify what type of information you want included in the print
job report. You can direct the report to a printer or text file or both.

{button ,AL(`dial_print;;;;',0,"Defaultoverview",)} Related Topics





PostScript Preferences dialog box
The PostScript Preferences dialog box allows you to set advanced PostScript options. You can optimize object 
outlines and fills for printing, and control the way your PostScript driver handles fonts and bitmaps.

{button ,AL(`dial_print;;;;',0,"Defaultoverview",)} Related Topics





Save Print Style dialog box
The Save Print Style dialog box allows you choose a name for the current print style (i.e., the current settings in 
Print Options). You can also change any settings you wish in Settings to save in style.
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Print Setup dialog box
The Print Setup dialog box allows you to select a device driver. Click Properties to change or review your printer 
settings.
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Edit Layout Style dialog box
The Edit Layout Style dialog box allows you to create custom layout styles. By increasing the Across and Down 
values, you allow space for several working pages on a single sheet of paper. The options in this dialog box allow
you to place the working pages in any order.
Note

When you create a custom style you are creating a template for the entire print job. If your document has 
a lot of pages, Corel will place subsequent pages in an order based on the page order of the template. For example, 
if page seven is place on the right page of a booklet, page fourteen will appear on the next right page.

{button ,AL(`dial_print;;;;',0,"Defaultoverview",)} Related Topics





Edit Positioning dialog box
The Edit Positioning dialog box allows you to place several existing printable pages on a single printable page, or 
to place several copies of an existing printable page on a single page. You can also set page margins in this 
dialog box.
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Advanced Separations Settings dialog box
The Advanced Separations Settings dialog box allows you to customize the color separations. You can specify 
screen technology, adjust individual color separations, create color trapping for individual color separations, and 
select a halftone type.
Consult your service bureau to ensure that all options are set properly.

{button ,AL(`dial_print;;;;',0,"Defaultoverview",)} Related Topics



Opens a Windows dialog box which allows you to set printing options not controlled by Corel.



Opens the Print Options dialog box which allows you to set advanced printing parameters such as sizing and 
positioning, halftone screening, color separations, etc.



Indicates which device driver is selected. Click the arrow to access a list of other available printer and 
imagesetter drivers.
If the driver you need is not listed, install it by using the usual Windows procedure.



Ensures that colors will print as expected.
The printer color profile shown here matches the printer that was chosen in the System Profile (Color Manager).
If you want your print job to be filtered through a different profile, you must go back to the Color Manager, select
the appropriate printer, and generate a new System Profile.



Stores a configuration of print settings that can be used again.



Stores a configuration of print settings that can be used again.



Saves the current print settings as a new style.



Deletes the selected style.



Creates a .PRN file from your print job (instead of actually printing).



Prepares the .PRN file for printing from a Macintosh computer.



Identifies the number of copies that will be printed.
Note

When printing to file, request one copy only, with no collation.



Prints one full set of the selected pages before printing the second full set (e.g., a first set of pages 1 to 10 will 
print, before the second set of pages 1 to 10 will print, and so on).
If you do not enable Collate, the requested number of copies of each selected page will print before the next 
page will print (e.g., five copies of page 1 will print before five copies of page 2 will print, and so on).



Prints one full set of the selected pages before printing the second full set (e.g., a first set of pages 1 to 10 will 
print, before the second set of pages 1 to 10 will print, and so on).
If you do not enable Collate, the requested number of copies of each selected page will print before the next 
page will print (e.g., five copies of page 1 will print before five copies of page 2 will print, and so on).



Print all pages in your document.



Prints only the objects that are currently selected.



Prints only the page currently displayed.



Specifies the pages, or the range of pages, to print.
A dash (-) between numbers defines a range of sequential pages (e.g., 1-5 will print pages 1 to 5).
A comma (,) between numbers defines a series of non-sequential pages (e.g., 1,5 will print pages 1 and 5 

only).
Any combination of dashes and commas is supported (e.g., 1-3, 5, 7, 10-12 will print pages 1, 2, 3, 5, 7, 

10, 11 and 12).
Inserting a tilde (~) between two numbers will cause those two pages plus every second page in between 

to print. For example, 1~6 will print pages 1, 3, 5 and 6. If you enter 2~6, pages 2, 4 and 6 will print.
The option works in conjunction with the Print Odd/Even Pages option.



Specifies the pages, or the range of pages, to print.
A dash (-) between numbers defines a range of sequential pages (e.g., 1-5 will print pages 1 to 5).
A comma (,) between numbers defines a series of non-sequential pages (e.g., 1,5 will print pages 1 and 5 

only).
Any combination of dashes and commas is supported (e.g., 1-3, 5, 7, 10-12 will print pages 1, 2, 3, 5, 7, 

10, 11 and 12).
Inserting a tilde (~) between two numbers will cause those two pages plus every second page in between 

to print. For example, 1~6 will print pages 1, 3, 5 and 6. If you enter 2~6, pages 2, 4 and 6 will print.
The option works in conjunction with the Print Odd/Even Pages option.



Allows you to specify whether odd, even, or both odd and even pages will be printed.



Displays your file as it will print and allows you to size and reposition your image. Right click on the preview 
window to choose one of four options: Preview Image, Preview in Color, Full Image Drag, and Print This Sheet 
Now.
Note

For your image to appear, you must enable Preview image. Otherwise your image will be represented by a 
bounding box.



Displays your file as it will print and allows you to size and reposition your image. Right click on the preview 
window to choose one of four options: Preview Image, Preview in Color, Full Image Drag, and Print This Sheet 
Now.
Note

For your image to appear, you must enable Preview image. Otherwise your image will be represented by a 
bounding box.



Allows you to move back in a multi-page document.



Allows you to move forward in a multi-page document.



Changes to a full screen preview. Click it again to return to a normal preview.



Displays your file in the Preview box as it will print.
Preview Image is a handy feature. Enable it, unless the image is complex and takes a long time to display. If you 
disable the preview, a bounding box will still indicate the position and size of your image.



Allows you to choose whether the Preview box will display a composite view of your print job or only a specific 
color separation.
Note

This feature is only available when Print Separations is enabled.



Prints the filename, current date, and time (and tile number, if applicable) at the bottom of the sheet.
If applicable, color separation information (color, screen frequency and angle, plate number) is printed at the top
of the sheet.
Note

To see the file information, you must define a working page size that is smaller than the dimensions of the 
actual sheet of paper or film that is used to image the work. If not, you can request that the file information be 
printed within the page.



Places page numbers on the printed sheets.
Note

To see the page numbers, you must define a working page size that is smaller than the dimensions of the 
actual sheet of paper or film that is used to image the work.



Causes the file information to print within the page.
Tip

If the working page size is identical to the paper or film size, enable File Info Within Page. Make sure the 
artwork is positioned so that the file information does not overlap it.



Prints crop marks. These marks are used as alignment aids when trimming the printed output down to its final 
size.
Note

To see the crop marks, you must define a working page size that is smaller than the dimensions of the 
actual sheet of paper or film that is used to image the work.



Prints crop marks only along the outer edge of the sheet.
Tip

This option is often preferable when you are printing multiple layouts per sheet.



Prints registration marks on each sheet. These marks serve as guides for aligning color separations.
Note

To see the registration marks, you must define a working page size that is smaller than the dimensions of 
the actual sheet of paper or film that is used to image the work.



Prints a bar of the six basic colors (red, green, blue; cyan, magenta, yellow) beside your artwork. These color 
patches are used to verify the quality of the printed output.
Note

To see the calibration bar, you must define a working page size that is smaller than the dimensions of the 
actual sheet of paper or film that is used to image the work.



Prints a Densitometer Scale, a bar of varying shades of gray, on each separation sheet. This is an advanced 
feature that allows you to check the accuracy, quality, and consistency of the output with an instrument called a 
densitometer.
Note

To see the densitometer scale, you must define a working page size that is smaller than the dimensions of 
the actual sheet of paper or film that is used to image the work



Prints a negative image when enabled.



Specifies that the film emulsion faces down when enabled.
Emulsion is the coating of light-sensitive material on a piece of film.



These options allow you to resize and reposition your artwork.
Note

These options do not affect the artwork itself, only the way it is printed.



Applies positioning and sizing to all pages.



Identifies the unit of measurement that is used when you specify the layout of your artwork.



Specifies the placement of your artwork on the page. The Top value indicates the distance from the top edge of 
the printable page.



Specifies the placement of your artwork on the page. The Top value indicates the distance from the top edge of 
the printable page.



Specifies the placement of your artwork on the page. The Left value indicates the distance from the left edge of 
the printable page.



Specifies the placement of your artwork on the page. The Left value indicates the distance from the left edge of 
the printable page.



Resizes your printed artwork (not the original document) according to the width specified.



Resizes your printed artwork (not the original document) according to the width specified.



Scales the width of your printed artwork (not the original document) by the specified percentage.



Scales the width of your printed artwork (not the original document) by the specified percentage.



Scales the height of your printed artwork (not the original document) by the specified percentage.



Scales the height of your printed artwork (not the original document) by the specified percentage.



Resizes your printed artwork (not the original document) according to the height specified.



Resizes your printed artwork (not the original document) according to the height specified.



Automatically centers your artwork on the page.



Automatically scales your artwork so that it fits the printable page.
Note

Unless Maintain aspect ratio is enabled, Fit to Page will distort your image.



Constrains resizing and scaling so that the height and width ratio of the artwork is maintained.



Enables a limit for bleeds. The bleed limit determines how far beyond the crop marks a graphic can extend when
printed.
The corresponding value identifies how far beyond the crop marks the bleed can extend.



Enables a limit for bleeds. The bleed limit determines how far beyond the crop marks a graphic can extend when
printed.
The corresponding value identifies how far beyond the crop marks the bleed can extend.



Enables a limit for bleeds. The bleed limit determines how far beyond the crop marks a graphic can extend when
printed.
The corresponding value identifies how far beyond the crop marks the bleed can extend.



Allows you to print large artwork on multiple sheets, or tiles, that can later be assembled to form the whole 
picture.



Indicates the level of flatness that will be applied to curves when you print.
Tip

Increasing the flatness reduces printing time and therefore is useful when you need to produce quick 
proofs. Be careful however as a flatness level set too high will produce distorted curves.



Causes Corel to automatically increase the flatness in increments of 2, as needed. Attempts to print an object 
will stop when the flatness value exceeds the value set in the Set Flatness To box by 10. At this point, the printer 
skips the problematic object and goes on to the next object.



Specifies the maximum allowable number of control points per curve. Reducing this number helps alleviate 
printing problems caused by objects that are too complex.



Allows one or more warnings to be issued if objects that are too complex and could cause printing problems are 
detected.



This value reflects the number of steps that will be used to render any fountain fills in your artwork. A low value 
(less than 20) will print faster but the transition between shades may be coarse, which causes what is known as 
banding. A higher value (over 40) will result in a smoother blend but longer printing times. 
Note

Fountain steps that are set in the Options dialog box only affect the way fountain fills display on your 
monitor. To control how the fountain fills actually print, you must set the value for fountain steps here or in the 
Fountain Fill dialog box.



Warns you of potential banding (the appearance of discreet strips in a fill) which is caused by to few steps in a 
fountain fill, when it is enabled.
Note

This warning only applies to linear fountain fills.



Prints a job information sheet with your print job. This report contains information about the application that 
produced the job, the driver that was used, the print settings, the font information, and the file links.



Opens the Job Information Sheet dialog box, which allows you to specify which categories of information you 
want included in the report.



Allows you to choose an option and assign a new setting to it.
Note

The Special Settings options allow you to change settings that were previously edited in the CORELPRN.INI 
file.



Allows you to choose an option and assign a new setting to it.
Note

The Special Settings options allow you to change settings that were previously edited in the CORELPRN.INI 
file.



Allows you to choose an option and assign a new setting to it.
Note

The Special Settings options allow you to change settings that were previously edited in the CORELPRN.INI 
file.



Allows you to choose an option and assign a new setting to it.
Note

The Special Settings options allow you to change settings that were previously edited in the CORELPRN.INI 
file.



Identifies the basic halftone screen frequency that your job will print at.
Screen frequency is expressed as a number of lines per inch (lpi). This value refers to the number of lines of dots 
(or other shapes) that make up a halftone screen. A halftone screen is a pattern of shapes of various sizes that is
used to simulate a continuous tone image.
Note

Check with your service bureau for the optimum setting for your print job.



Enables the use of PostScript level 2 features.
Note
This option is only available to level 2 PostScript devices. If you are not certain whether you will be printing on a 
level 2 postscript device, DO NOT enable this option.



Enables an analysis of your file and the various print settings you have specified, and, if necessary, automatically
increases the number of steps used to render fountain fills to avoid banding. 
Note

This option may increase print time, but it will ensure the best possible rendering of fountain fills.



Enables an analysis of your file and the various print settings you have specified. If the number of steps in a 
fountain fill is greater than the number that your output device can render, the number of steps used to render 
the fountain fill is decreased automatically. 



Downloads Type 1 fonts to the output device. Generally, this option is enabled because it is particularly beneficial
when you want to print large tracts of text that use only a few fonts. Printing is faster as each font is first 
downloaded, and then only referenced by text that uses it.
If you disable this option, fonts are output as graphics (either curves or bitmaps). This may be useful if the file 
contains a large number of fonts that would take longer to download, or not download at all, because of sheer 
size.



Converts True Type fonts to Type 1 fonts. If you enabled the Download Type 1 Fonts option, by default the 
Convert True Type to Type 1 is also enabled. This ensures that True Type fonts are converted to Type 1 fonts so 
that they can be downloaded. 
Only disable this option if your output device has difficulty interpreting the Type 1 fonts.



Tells the service bureau's OPI server to substitute the corresponding high-resolution images for the low-resolution
ones in your file. This substitution is done before your print file is rasterized and imaged to film.



Defines bitmaps in RGB values instead of the usual CMYK values that are found in PostScript files.
Tip

Use this option when you are outputting to RGB devices (e.g., slidemakers).
Also use this option when you are printing to CMY devices. It is easier for these devices to translate from 

RGB to CMY than from CMYK to CMY.



Separates color artwork into its component colors, causing each component color to print out on a single sheet.
If you used a process color model (which uses four colors to simulate any color), you'll get up to four sheets per 
page.
If you used spot colors, one sheet per color is printed.



Allows you to print the separations in color (i.e., on a color printer). Separations are usually printed in black, with 
a screen to represent shading. This option allows you to print the separations in color instead.



Converts any spot colors present in your artwork to process colors.
Note

This does not affect the artwork itself, only the way it is printed.



Prints all plates, including those that contain no image.
Note

Printing empty plates wastes film and adds to the cost of your job. Generally, you'll want to leave this 
option disabled.



Specifies which color separation(s) to print.
The list of colors shows all separations used in your artwork. You can choose to print all separations, one 
separation only, or any combination of separations.



Allows you to adjust the advanced settings of your color separations, which includes setting halftone screens and
creating color trapping.
Note

Do not adjust these settings without first talking to your service bureau or printing shop.



Opens the Advanced Separations Setting dialog box that allows you to set advanced screening parameters such 
as screening technology, screen frequency and angle per color plate, overprinting per plate, halftone dot type, 
etc.



Identifies the imagesetter and screening technology that will be used to image your job.
Proprietary screening technologies supported by Corel include AGFA Balanced screening, Linotronic RT and, HQS 
screening.



Identifies the imagesetter and screening technology that will be used to image your job.
Proprietary screening technologies supported by Corel include AGFA Balanced screening, Linotronic RT and, HQS 
screening.



Identifies the resolution (in dots per inch, or "dpi") the job will be printed at.



Identifies the resolution (in dots per inch, or "dpi") the job will be printed at.



Identifies the basic screen frequency (in lines per inch, or "lpi") the job will be printed at.
Note

The higher the screen frequency setting, the more intense the colors and the sharper the image. The lower
the screen frequency, the lighter the colors and the less sharp the image. 

A high frequency gives you fewer levels of gray; a low frequency gives you more levels of gray.
The upper limit of your screen frequency is define by the type of printing press to be used and the type of 

paper stock.



Identifies the basic screen frequency (in lines per inch, or "lpi") the job will be printed at.
Note

The higher the screen frequency setting, the more intense the colors and the sharper the image. The lower
the screen frequency, the lighter the colors and the less sharp the image. 

A high frequency gives you fewer levels of gray; a low frequency gives you more levels of gray.
The upper limit of your screen frequency is define by the type of printing press to be used and the type of 

paper stock.



Identifies the screen frequency the selected color separation will be printed at. The default values are based on 
the imagesetter, screening technology, and basic screen frequency chosen; it is best not to change these values.
Note

Check with your service bureau before modifying these values.



Shows the screen angle for the selected color separation. Screen angles are used to offset the different films in 
process color separations to avoid moiré patterns. The default values are based on the imagesetter, screening 
technology, and basic screen frequency chosen; it is best not to change these values.
Note

Check with your service bureau before modifying these values.



Allows you to select a color to print over any underlying color (instead of the underlying color being knocked 
out), thereby making white gaps impossible. This option is best used when the top color is much darker than the 
underlying color, otherwise an undesirable third color might result (e.g., red over yellow would result in an 
orange object).
When you enable Overprint color both text and graphics are selected by default. If you do not want one of these 
options to overprint, disable it.



Allows you to select a color to print over any underlying color (instead of the underlying color being knocked 
out), thereby making white gaps impossible. This option is best used when the top color is much darker than the 
underlying color, otherwise an undesirable third color might result (e.g., red over yellow would result in an 
orange object).
When you enable Overprint color both text and graphics are selected by default. If you do not want one of these 
options to overprint, disable it.



Allows you to select a color to print over any underlying color (instead of the underlying color being knocked 
out), thereby making white gaps impossible. This option is best used when the top color is much darker than the 
underlying color, otherwise an undesirable third color might result (e.g., red over yellow would result in an 
orange object).
When you enable Overprint color both text and graphics are selected by default. If you do not want one of these 
options to overprint, disable it.



Allows you to specify a halftone screen for your drawing if you are printing to a PostScript device. A halftone 
screen is a pattern of shapes that is used to simulate shades of colors (i.e. darker to lighter) while using the 
same ink. Dot, line, diamond, elliptical, and Euclidean are only a few of the available halftone types.



Allows you to specify a halftone screen for your drawing if you are printing to a PostScript device. A halftone 
screen is a pattern of shapes that is used to simulate shades of colors (i.e. darker to lighter) while using the 
same ink. Dot, line, diamond, elliptical, and Euclidean are only a few of the available halftone types.



Creates color trapping by assigning an outline to an object that is the same color as the object's fill, and by then 
having the outline overprint underlying objects.
To be able to apply Auto-spreading to an object, it must

not already have an outline
be filled with a uniform fill
not already be designated to overprint

The maximum trap value defines the amount of spread that autotrapping assigns to an object, along with the 
object's color. The lighter the color, the greater the percentage of the maximum trap value. The darker the color, 
the smaller the percentage of the maximum trap value.

The value for Text Above determines the minimum font size to which auto-spreading is applied. Applying auto-
spreading to small font sizes can make the text illegible.



Creates color trapping by assigning an outline to an object that is the same color as the object's fill, and by then 
having the outline overprint underlying objects.
To be able to apply Auto-spreading to an object, it must

not already have an outline
be filled with a uniform fill
not already be designated to overprint

The maximum trap value defines the amount of spread that autotrapping assigns to an object, along with the 
object's color. The lighter the color, the greater the percentage of the maximum trap value. The darker the color, 
the smaller the percentage of the maximum trap value.

The value for Text Above determines the minimum font size to which auto-spreading is applied. Applying auto-
spreading to small font sizes can make the text illegible.



Creates color trapping by assigning an outline to an object that is the same color as the object's fill, and by then 
having the outline overprint underlying objects.
To be able to apply Auto-spreading to an object, it must

not already have an outline
be filled with a uniform fill
not already be designated to overprint

The maximum trap value defines the amount of spread that autotrapping assigns to an object, along with the 
object's color. The lighter the color, the greater the percentage of the maximum trap value. The darker the color, 
the smaller the percentage of the maximum trap value.

The value for Text Above determines the minimum font size to which auto-spreading is applied. Applying auto-
spreading to small font sizes can make the text illegible.



Creates color trapping by assigning an outline to an object that is the same color as the object's fill, and by then 
having the outline overprint underlying objects.
To be able to apply Auto-spreading to an object, it must

not already have an outline
be filled with a uniform fill
not already be designated to overprint

The maximum trap value defines the amount of spread that autotrapping assigns to an object, along with the 
object's color. The lighter the color, the greater the percentage of the maximum trap value. The darker the color, 
the smaller the percentage of the maximum trap value.

The value for Text Above determines the minimum font size to which auto-spreading is applied. Applying auto-
spreading to small font sizes can make the text illegible.



Creates color trapping by assigning an outline to an object that is the same color as the object's fill, and by then 
having the outline overprint underlying objects.
To be able to apply Auto-spreading to an object, it must

not already have an outline
be filled with a uniform fill
not already be designated to overprint

The maximum trap value defines the amount of spread that autotrapping assigns to an object, along with the 
object's color. The lighter the color, the greater the percentage of the maximum trap value. The darker the color, 
the smaller the percentage of the maximum trap value.

The value for Text Above determines the minimum font size to which auto-spreading is applied. Applying auto-
spreading to small font sizes can make the text illegible.



Creates color trapping by assigning an outline to an object that is the same color as the object's fill, and by then 
having the outline overprint underlying objects.
To be able to apply Auto-spreading to an object, it must

not already have an outline
be filled with a uniform fill
not already be designated to overprint

The maximum trap value defines the amount of spread that autotrapping assigns to an object, along with the 
object's color. The lighter the color, the greater the percentage of the maximum trap value. The darker the color, 
the smaller the percentage of the maximum trap value.

The value for Text Above determines the minimum font size to which auto-spreading is applied. Applying auto-
spreading to small font sizes can make the text illegible.



Creates color trapping by assigning an outline to an object that is the same color as the object's fill, and by then 
having the outline overprint underlying objects.
To be able to apply Auto-spreading to an object, it must

not already have an outline
be filled with a uniform fill
not already be designated to overprint

The maximum trap value defines the amount of spread that autotrapping assigns to an object, along with the 
object's color. The lighter the color, the greater the percentage of the maximum trap value. The darker the color, 
the smaller the percentage of the maximum trap value.

The value for Text Above determines the minimum font size to which auto-spreading is applied. Applying auto-
spreading to small font sizes can make the text illegible.



Causes any object that contains 95% black or more to overprint underlying objects.
Note

This is a useful option for artwork containing a lot of black text, but it should be used with caution on 
artwork with a high graphics content.



Provides preset page layouts and allows you to store custom styles.



Provides preset page layouts and allows you to store custom styles.



Opens the Edit Layout dialog box.



Specifies the number of working pages to place on a single printable page.



Specifies the number of working pages to place on a single printable page.



Places the current layout in each frame of the printable page.



Allows you to set the amount the images on each tile overlap with the images on adjacent tiles.



Allows you to set the amount the images on each tile overlap with the images on adjacent tiles.



Allows you to set the amount the images on each tile overlap with the images on adjacent tiles based on a 
percentage of the page width.



Allows you to set the amount the images on each tile overlap with the images on adjacent tiles based on a 
percentage of the page width.



Specifies the placement of your artwork on the page. The Left value indicates the distance from the left edge of 
the printable page.



Resizes your printed artwork (not the original document) according to the width specified.



Resizes your printed artwork (not the original document) according to the height specified.



Stores the page positioning settings specified in the Positioning dialog box.



Opens the Positioning dialog box. This dialog box allows you to specify positioning settings that can be save in 
Positioning styles.



Stores the page positioning settings specified in the Positioning dialog box.



Prints only vector graphics unless combined with Print bitmaps or Print text.



Prints only bitmaps unless combined with Print vectors or Print text.



Prints only text unless combined with Print vectors or Print bitmaps.



Prints all text in black.



Prints using the full color capabilities of the selected printing device.



Prints all colors in black.



Prints all colors in grayscale.



Opens the Postscript Preferences dialog box.



Scales everything that will be printed so that it fits within the printable page of the current printer. Use this 
setting to proof a large layout on your desktop printer.
This option is only intended for proofing, and should be disabled for the final output. If you wish to scale your 
artwork to fill the printable page, you should use the fit to page option. Position and size measurements reflect 
the size of the final output, not the size of the proof.



Provides information about the current printing device.



Provides information about the current printing device.



Provides information about the current printing device's location.



Provides information about the current printing device.



Displays a list of documents that you can print.



Allows you to choose what to print.



Stores a configuration of print settings that can be used again.



Stores a configuration of print settings that can be used again.



Displays a list of the current device's mode settings.



Displays information about the current printing device.



Displays a list of the current device's capabilities.



Displays information about the current printing device.



Specifies which color separation(s) to print.
The list of colors shows all separations used in your artwork. You can choose to print all separations, one 
separation only, or any combination of separations.



Shows all separations used in your artwork. Click each one to change frequency, angle, and to enable 
overprinting.



Shows all separations used in your artwork. Click each one to change frequency, angle, and to enable 
overprinting.



Displays the present print style, or a name you have typed for a new style.



Provides a list of the present print options and allows you to change them.



Allows you to save this dialog box's settings.



Makes the right margin equal to the left margin, and the bottom margin equal to the top margin.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Automatically sets the gutters.



Allows you to specify the distance between each layout frame that is placed on the printable page. You can also 
change the units.



Allows you to specify the distance between each layout frame that is placed on the printable page. You can also 
change the units.



Allows you to specify the distance between each layout frame that is placed on the printable page. You can also 
change the units.



Allows you to specify the distance between each layout frame that is placed on the printable page. You can also 
change the units.



Displays a model of the printable page based on the positioning settings.



Automatically sets the margins.



Specifies the number of rows of positioning frames to be placed on the printable page.



Specifies the number of columns of positioning frames to be placed on the printable page.



Allows you to specify the distance between each layout frame that is placed on the printable page. You can also 
change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to specify the distance between each layout frame that is placed on the printable page. You can also 
change the units.



Stores the page positioning settings specified in this dialog box.



Saves the present positioning settings.



Deletes the selected positioning style.



Specifies the number of rows of positioning frames to be placed on the printable page.



Specifies the number of columns of positioning frames to be placed on the printable page.



Stores the page positioning settings specified in this dialog box.



Specifies the number of working pages to position across the printable page.



Specifies the number of working pages to position across the printable page.



Specifies the number of working pages to position down the printable page.



Specifies the number of working pages to position down the printable page.



Places the current working page in each frame of the printable page.



Keeps the frame size equal to the working page size.



Displays a model of how the pages will be arranged on the printed sheet.



Allows you to specify the distance between each working page that is placed on the printable page. You can also 
change the units.



Allows you to specify the distance between each working page that is placed on the printable page. You can also 
change the units.



Allows you to specify the distance between each working page that is placed on the printable page. You can also 
change the units.



Allows you to specify the distance between each working page that is placed on the printable page. You can also 
change the units.



Shows the other side of a double sided layout.



Allows you to print on both sides of the page.
Note

When you enable this option, and you print to a non-double sided printer, Corel automatically runs a wizard
that ensures all of the pages are ordered and oriented correctly.



Provides preset page layouts and allows you to store custom styles.



Saves the present layout settings.



Deletes the selected layout style.



Selects a page to be placed on the layout sheet.



Selects a page to be placed on the layout sheet.



Allows you to specify whether the top of the selected page points up or down.



Allows you to specify whether the top of the selected page points up or down.



Allows you to specify the distance between each working page that is placed on the printable page. You can also 
change the units.



Allows you to specify the distance between each working page that is placed on the printable page. You can also 
change the units.



Shows the contents of the Print Job Information Sheet.



Allows you to specify what information the Print Job Information Sheet will contain.



Allows you to specify what information the Print Job Information Sheet will contain.



Allows you to specify what information the Print Job Information Sheet will contain.



Allows you to specify what information the Print Job Information Sheet will contain.



Allows you to specify what information the Print Job Information Sheet will contain.



Allows you to specify what information the Print Job Information Sheet will contain.



Sends the Print Job Information Sheet to a .TXT file.



Allows you to specify the .TXT file the Print Job Information Sheet is sent to.



Sends the Print Job Information Sheet to a printer.



Allows you to specify the printer the Print Job Information Sheet is sent to.



Places the current working page in each frame of the printable page.



BOO



Allows you to choose proofing options.



Allows you to choose an option and assign a new setting to it.
Note

The Special Settings options allow you to change settings that were previously edited in the CORELPRN.INI 
file.



Provides information about the current printing device.



Provides information about the current printing device.



Provides information about the current printing device's location.



Provides information about the current printing device.



Provides information about the current printing device, and allows you to change devices.



Allows you to specify the number of copies and whether to collate them.



Allows you to specify color trapping settings.



Allows you to change screening options for the selected color separation.



Provides a list of the present print options and allows you to change them.



Allows you to specify the distance between each layout frame that is placed on the printable page. You can also 
change the units.



Allows you to set the page margins. You can also change the units.



Allows you to specify the distance between each working page that is placed on the printable page. You can also 
change the units.



Sets PostScript font handling.



Sets PostScript bitmap handling.



Allows you to enable PostScript warnings.



Allows you to specify what information the Print Job Information Sheet will contain.



Allows you to choose the output format and destination of the Print Job Information Sheet.



To print all pages
1. Click File, Print.
2. Choose All.

{button ,AL(`g_h_pt_print;;;;;',0,"Defaultoverview",)} Related Topics



To print only the current page
1. Click File, Print.
2. Choose Current Page.

{button ,AL(`g_h_pt_print;;;;;',0,"Defaultoverview",)} Related Topics



To print only certain pages
1. Click File, Print.
2. Choose Pages.
3. Choose Even Pages, Odd Pages, or Even and Odd from the pages list box.
4. Type the pages you want printed in the pages box.
Note

A dash (-) between numbers defines a range of sequential pages (e.g., 1-5 will print pages 1 through 5).
A comma (,) between numbers defines a series of non-sequential pages (e.g., 1,5 will print pages 1 and 5 

only).
Any combination of dashes and commas is supported (e.g., 1-3, 5, 7, 10-12 will print the following pages: 

1, 2, 3, 5, 7, 10, 11 and 12).
Inserting a tilde (~) between two numbers will cause those two pages plus every second page in between 

to print. For example,1~6 will print the following pages: 1, 3, 5 and 6. If you enter 2~6, pages 2, 4 and 6 will print.

{button ,AL(`g_h_pt_print;;;;;',0,"Defaultoverview",)} Related Topics



To print only vectors, bitmaps or text
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Enable Vectors, Bitmaps, Text, or a combination of these.
5. (Optional) Enable Print All Text In Black if you want to print text in black instead of in color.

{button ,AL(`g_h_pt_print;;;;;',0,"Defaultoverview",)} Related Topics



To print only certain layers
1. Click Layout, Layers Roll-Up.
2. Enable or disable the Printable option for each layer, as required.

{button ,AL(`g_h_pt_print;;;;;',0,"Defaultoverview",)} Related Topics



To immediately print the sheet being previewed
1. Point to the Preview box.
2. Click the right mouse button, click Print This Sheet Now.

{button ,AL(`g_h_pt_print;;;;;',0,"Defaultoverview",)} Related Topics



To print a memo
1. Select the memo you want to print.
2. Click Edit, Note object, Open.
3. Click File, Print from inside the Memo window.
4. Choose a printing device.

{button ,AL(`g_h_pt_print;;;;;',0,"Defaultoverview",)} Related Topics



To select a device
1. Click File, Print.
2. Choose a printer or imagesetter from the Name list box. If the device driver you need is not listed, install it 

following the usual Windows procedure.
Tip

If you're proofing or printing a job in-house, choose the driver for your local device.
If you're sending a file to a service bureau, choose the device driver that's specified by the service bureau.

{button ,AL(`g_h_pt_settingjob;;;;;',0,"Defaultoverview",)} Related Topics



To set the device properties
1. Click File, Print.
2. Click Properties.
3. If printing to a PostScript device, set only the Page Size, Orientation, Tray, and Resolution here. Leave all other 

options at their default and set them from Print options instead.
or
If printing to a non-PostScript device, set all relevant options here.

Note
As these are Windows-controlled options, see your Windows documentation for more information.

Tip
To verify the extent of the unprintable area for the selected device, click Unprintable Area.
To print on both sides of the page (duplex printing), click More Options.

{button ,AL(`g_h_pt_settingjob;;;;;',0,"Defaultoverview",)} Related Topics



To print to file
1. Click File, Print.
2. Enable Print to File.
3. Enable For Mac if your print file is being sent to a service bureau with Macintosh equipment.

PostScript files created using the Print to File option contain two Control-D (^D) characters that prevent them 
from printing on any PostScript device controlled by Macintosh computers. Enabling the For Mac option 
removes the ^D characters from the files.

4. Click OK.
5. Type a filename and choose a destination. The appropriate extension (.PRN) will be appended to your filename.

{button ,AL(`g_h_pt_settingjob;;;;;',0,"Defaultoverview",)} Related Topics



To select a print style
1. Click File, Print.
2. Choose a print style from the Style list box.

{button ,AL(`g_h_pt_settingjob;;;;;',0,"Defaultoverview",)} Related Topics



To edit an existing print style or create a new one
1. Click File, Print.
2. Click Options.
3. (Optional) Choose an existing print style to edit from the Style list box.
4. Change the print options.

5. Click .
6. Choose a name for the style.

Tip
When you click Cancel instead of OK in the Print dialog box, all of the changes you have made in print 

options are discarded. If you do not want to lose these changes and you need to click Cancel (i.e. you need to 
change your work before you print), save your settings as a print style.

{button ,AL(`g_h_pt_settingjob;;;;;',0,"Defaultoverview",)} Related Topics



To delete a print style
1. Click File, Print.
2. Click Options.
3. Select a print style to delete from the Style list box.

4. Click .

{button ,AL(`g_h_pt_settingjob;;;;;',0,"Defaultoverview",)} Related Topics



To print color artwork in black or grayscale
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Click All Colors As Black or All Colors As Grayscale.

{button ,AL(`g_h_pt_settingjob;;;;;',0,"Defaultoverview",)} Related Topics



To use a printer color profile
1. Click File, Print.
2. Enable Printer Color Profile if you want your print job processed using the profile that is shown.
Note

If you want your print job to be processed through a different profile, you must go back to the Color 
Manager and select another printer profile.

{button ,AL(`g_h_pt_settingjob;;;;;',0,"Defaultoverview",)} Related Topics



To print multiple copies
1. Click File, Print.
2. Type the number of copies you need in the Number of copies number box.

{button ,AL(`g_h_pt_settingjob;;;;;',0,"Defaultoverview",)} Related Topics



To collate multiple copies
1. Click File, Print.
2. Enable Collate.
Note

Choosing Collate allows you to print one full set of the selected pages before printing the second full set 
(e.g., a set of pages 1 to 10 will print before a second set of pages 1 to 10 will print, and so on). Otherwise the 
requested number of copies of each selected page will print going on to the next page (e.g., five copies of page 1 
will print, before five copies of page 2 will print, and so on).

{button ,AL(`g_h_pt_settingjob;;;;;',0,"Defaultoverview",)} Related Topics



To preview your print job
1. Click File, Print.
2. Click Options.
3. Enable Preview Image.
Tip

You can choose whether you prefer the preview to be on or off by default. Click the Options tab, and from 
Special Settings choose Preview Image Default. Set to On By Default or Off By Default.

You can also toggle the preview on or off by clicking the Preview box with the right mouse button and then 
clicking Preview Image on the pop-up menu.

Preview Image is a handy feature. We recommend that you enable it unless the image is complex and 
takes a long time to display. If you disable the preview, a bounding box will indicate the position and size of your 
image.

{button ,AL(`g_h_pt_preview;;;;;',0,"Defaultoverview",)} Related Topics



To preview your color separations
1. Click File, Print.
2. Click Options.
3. Enable Preview Image.
4. Choose composite (all color separations together) or a single color separation (e.g., cyan) from the list box.
Note

You can only view individual Color separations if you have enabled color separations in Print Options.
Tip

You can choose whether you prefer the preview to be on or off by default. Click the Options tab, and from 
Special Settings choose Preview Image Default. Set to On By Default or Off By Default.

You can also toggle the preview on or off by clicking on the Preview box with the right mouse button and 
then clicking Preview Image on the pop-up menu.

Preview Image is a handy feature. We recommend that you enable it unless the image is complex and 
takes a long time to display. If you disable the preview, a bounding box will indicate the position and size of your 
image.

{button ,AL(`g_h_pt_preview;;;;;',0,"Defaultoverview",)} Related Topics



To specify a color or grayscale print preview
1. Point to the Preview box.
2. Click the right mouse button. Enable Preview In Color to specify a color preview. Disable this option to specify a

grayscale preview.
Tip

Displaying individual color separations in grayscale instead of color can be helpful when you are 
attempting to study color distribution. Yellow in particular can be difficult to discern against a white background. 
Even magenta and cyan, if sparse, can be easier to discern when displayed in grayscale.
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To enlarge the preview box
Click the enlarge icon at the top-left corner of the Preview box.
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To move from page to page in print preview
Click one of the page-flipper buttons. The button pointing left flips back through the pages and the button 

pointing right flips forward.
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To specify full image or marquee drag in print preview
1. Point to the Preview box.
2. Click the right mouse button. Enable Full Image Drag to keep the image visible while it is being repositioned. 

Disable this option to change the image to a marquee box while it is being repositioned.
Tip

The default is Full Image Drag. To make the default drag marquee, click the Options tab, and in Special 
Settings, and choose Print Preview Drag Mode. Change the setting to Drag Marquee.
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To size your artwork when printing
1. Click File, Print.
2. Click Options. 
3. Click the Layout tab.
4. (optional) Enable (or disable) Maintain Aspect.
5. Assign the height and width values in the unit of measurement you want

or
Drag the handles in the Preview box.

Note
You can only size your artwork this way when you are using the Full Page layout style with no rows or 

columns, or when you are using the Manual layout style.
If you enabled Maintain Aspect, you can only resize the image proportionally.
This option does not affect the artwork itself, only the way it is printed.
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To fit your artwork to the page when printing
1. Click File, Print.
2. Click Options. 
3. Click the Layout tab.
4. (optional) Enable (or disable) Maintain aspect ratio.
5. Click Fit to Page.
Note

Your artwork is automatically scaled (up or down) so that it fits the printable page. Your image will be 
distorted if you do not enable Maintain Aspect.

This option does not affect the artwork itself, only the way it is printed.
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To maintain the aspect ratio of your artwork when sizing
1. Click File, Print.
2. Click Options. 
3. Click the Layout tab.
4. Enable Maintain aspect ratio.
Note

This is the default setting.
This option does not affect your artwork. When you are finished printing you will still be able to change the 

aspect ratio of your work.
Tip

The height and width ratio of an image is known as its "aspect". If you are resizing or scaling your artwork 
using the print preview, it is a good idea to enable Maintain Aspect to prevent image distortion.
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To manually position your artwork when printing
1. Click File, Print.
2. Click Options. 
3. Click the Layout tab.
4. Change the Top value (distance from the top of the printable area) and the Left value (distance from the left 

side of the printable area).
or
Drag the graphic in the Preview box.

Note
This option does not affect the artwork itself, only the way it is printed.
If you select the Manual Layout style, you can place several working pages on a single printable page. 

Each of these pages can be sized and positioned individually. You can also use the Clone Page option to place 
several copies of the same working page on a single sheet of paper.
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To automatically center your artwork when printing
1. Click File, Print.
2. Click Options. 
3. Click the Layout tab.
4. Enable Center image.
Note

This option does not affect the artwork itself, only the way it is printed.
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To set a bleed limit
1. Click File, Print.
2. Click Options.
3. Click the Layout tab.
4. Enable Bleed Limit.
6. Enter a bleed limit value. This value represents the distance the artwork will be allowed to bleed beyond the 

crop marks (i.e. the edge of final paper size).
Note

This setting has no effect unless the working page size is smaller than the printable page and your artwork
extends beyond the edge of the working page (see Page layout (and printing) in related topics).

Consult your service bureau or printing shop to determine the appropriate bleed limit for your job. 
Excessive bleeds waste film and may cause other problems.
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To print large artwork as tiles
1. Click File, Print.
2. Click Options. 
3. Click the Layout tab.
4. Enable Print tiled pages.
5. Indicate by how much you want the tiles to overlap. Enter a value (e.g., a quarter of an inch) or a percentage 

of the page size.
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To apply position and size settings to all pages when printing
1. Click File, Print.
2. Click Options.
3. Click the Layout tab.
4. Enable Apply Settings to All Pages.
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To choose a layout style in the Print Options dialog box
1. Click File, Print.
2. Click Options.
3. Click the Layout tab.
4. Choose a layout style from the Layout Styles list box.
Note

If you chose a layout style    before you open the print dialog box (i.e. using Page Setup) then the 
appropriate layout style will automatically be selected in the print dialog box. If you change it (with the exception of
Full Page)your work will not print correctly.

Tip
If you have created your work in a Full Page layout then you may choose to print this work using a different

layout style. For example, if you have designed a four-page document set up as Full Page, but would like to print it 
as a top-fold or side-fold card, you can choose the appropriate card style here. Or you may have designed a 
business card as full-page document and elect to print it using the labels layout.
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To edit a layout style in the Print Options dialog box
1. Click File, Print.
2. Click Options.
3. Click the Layout tab.
4. Choose a layout style to edit from the Layout style list box.
5. Click the Layout style, Edit button.
6. Indicate the number of working pages from the Corel document to include on each printable page in the 

Across and Down number boxes.
7. Indicate the size of the gutters (space between pages) in the Horizontal and Vertical number boxes. You can 

change the unit of measurement in the Units number box on the right.
8. Click each box on the model of the of the printable page and choose a page number and an angle.
9. If you will be printing on both sides of the paper, enable Double sided layout. Click Flip Page to see each side.
Note

When you select Double sided layout and you print on a non-duplex printer, a wizard automatically 
provides instructions on how to insert the pages.
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To save a layout style in the Print Options dialog box
1. Click File, Print.
2. Click Options.
3. Click the Layout tab.
4. Click the Layout style, Edit button.
5. Edit a layout style (see related topics).

6. Click .
7. Choose a name for the layout style.
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To delete a layout style in the Print Options dialog box
1. Click File, Print.
2. Click Options.
3. Click the Layout tab.
4. Click the Layout style, Edit button.
5. Choose a layout style from the Layout style list box.

6. Click .
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To print several pages on a single sheet of paper
1. Click File, Print.
2. Click Options.
3. Click the Layout tab.
4. Click the Positioning, Edit button
5. Indicate how many rows and columns of the chosen layout you want printed per sheet.
6. Indicate the size of the gutters (space between rows and columns) in the Horizontal and Vertical number 

boxes. You can change the unit of measurement in the Units number box on the right.
or
Enable Auto Spacing.

7. (Optional) Enable Clone frame.
8. (Optional) Enable Maintain document page size.
Note

When you use Rows and Columns without enabling Clone Frame or Maintain document page size, each 
page of your work will be reduced in size and placed into a single frame (the intersection of one row and column). 
Each frame is placed starting with the first page at the top left and then each succeeding page is placed from left to
right and down.

If you enable Clone Frame, only one page of your work is placed in all of the frames for that sheet. In this 
way you can print multiple copies of one piece of artwork on a single sheet.

If you enable Maintain document page size each frame will be the same size as the page size specified in 
the document. For example, if you create a document on an 8.5 inch by 11 inch page, the frames will be 
constrained to that size. Thus, if you choose 11 inch by 17 inch paper, and specify 2 rows by 2 columns, some of the
frames will not fit on the page.

When you use Rows and Columns with a layout style that places several working pages on a single 
printable page (e.g., Tent-Card) each printable page is treated as a frame.
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To change the margins of the printed sheet of paper
1. Click File, Print.
2. Click Options.
3. Click the Layout tab.
4. Click the Positioning, Edit button
5. Indicate the size of the margins in the Left, Right, Top, and Bottom number boxes. You can change the unit of 

measurement in the Units number box on the right.
or
Enable Auto Margins.

6. If you want the left and right margins to be equal, and you want the top and bottom margins to be equal, 
enable Equal Margins.
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To save settings in the Edit Positioning dialog box
1. Click File, Print.
2. Click Options.
3. Click the Layout tab.
4. Click the Positioning, Edit button.
5. Change the settings (see related topics).
6. Click .

7. Choose a name for the settings.
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To delete settings in the Edit Positioning dialog box
1. Click File, Print.
2. Click Options.
3. Click the Layout tab.
4. Click the Positioning, Edit button.
5. Choose a saved settings name from the Positioning list box.

6. Click .
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To print file information
1. Click File, Print.
2. Click Options.
3. Enable File Info Button.
4. (Optional) Enable File info within page.
Note

To see the file information, you must define a working page size that is smaller than the dimensions of the 
actual sheet of paper or film that is used to image the work, or you must indicate that the file information should be
printed within the page. If you do print the file information within the working page, make sure the artwork is 
positioned so that the file information does not overlap it.
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To print crop marks
1. Click File, Print.
2. Click Options.
3. Enable Crop Marks.
4. (Optional) Enable Exterior crop marks only.
Note

To see the crop marks, you must define a working page size that is smaller than the dimensions of the 
actual sheet of paper or film that is used to image the work.

If you are printing multiple pages per sheet (e.g., 2 rows by 2 columns), and you will not be cutting these 
pages into individual sheets, you may want to enable Exterior crop marks only. If you disable this option there will 
be crop marks around each row and column.
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To print registration marks
1. Click File, Print.
2. Click Options.
3. Enable Registration Marks.
Note

To see the registration marks, you must define a working page size that is smaller than the dimensions of 
the actual sheet of paper or film that is used to image the work.

Tip
Corel offers a variety of registration mark styles. Look up what's available under Registration Mark Type in 

Special Settings on the options page in Print options. Choose a different style if you prefer. This option is available 
to PostScript devices only.
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To print page numbers
1. Click File, Print.
2. Click Options.
3. Enable Page numbers.
Note

To see the page numbers, you must define a working page size that is smaller than the dimensions of the 
actual sheet of paper or film that is used to image the work.

{button ,AL(`g_h_pt_reftools;;;;;',0,"Defaultoverview",)} Related Topics



To print a calibration bar
1. Click File, Print.
2. Click Options.
3. Enable Calibration Bar.
Note

To see the calibration bar, you must define a working page size that is smaller than the dimensions of the 
actual sheet of paper or film that is used to image the work.
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To print a densitometer scale
1. Click File, Print.
2. Click Options.
3. Enable Densitometer Scale.
Note

To see the densitometer scale, you must defined a working page size that is smaller than the dimensions of
the actual sheet of paper or film that is used to image the work.

{button ,AL(`g_h_pt_reftools;;;;;',0,"Defaultoverview",)} Related Topics



To print negative film
1. Click File, Print.
2. Click Options.
3. Enable Negative Film.
Tip

Do not choose negative film if you are outputting to a desktop printer.Check with your service bureau. Be 
especially careful if you require negative film: if you enable Negative Film and the service bureau's equipment is 
also set to negative, you will end up with positive film.
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To specify emulsion down 
1. Click File, Print.
2. Click Options.
3. Enable Emulsion Down
Note

Emulsion is the coating of light-sensitive material on a piece of film. Normally, images printed to a laser 
printer are printed with the emulsion up (button not enabled). Other types of reproduction may call for either 
emulsion up or down. Check with your service bureau.

Printing with the emulsion down produces a backwards image.
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To set the screen frequency
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Choose a screen frequency, expressed in lines per inch (lpi). Check with your service bureau for the optimum 

setting for your job.
Note

When the screen frequency is set to Default, your artwork is printed using the default screen frequency of 
the output device.

If you are using the Advanced settings, found on the Separations page in the Print Options dialog box, set 
the screen frequencies for each color separation here. These settings override the settings on the Options page.

This option is available to PostScript devices only.
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To set Level 2 usage
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Enable Use PostScript Level 2 Features.
Note
This option is only available to Level 2 PostScript devices. If you are not certain whether you will be printing on a 
Level 2 PostScript device, DO NOT enable this option.
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To test for complex objects
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Enable Complex Objects Warnings.
Note

This option is available to PostScript devices only.
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To reduce curve complexity by increasing flatness
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Increase the flatness value manually

or
enable Auto Increase Flatness.

Note
If you enable Auto Increase Flatness, the printer increases the flatness of curves in each object which is too

complex by increments of 2. If the object is still too complex when the flatness value exceeds the value in the Set 
Flatness To box by 10, the printer will skip the problematic object and go on to the next object. With this option 
enabled, the PostScript program is far less likely to cause errors on complex printing jobs.

If the printer skips an object because Auto increase flatness is enabled then the object will NOT appear in 
the final output. You will not be informed that this has happened while you print. The problem will only become 
evident when the print job is imaged to paper or film. Therefore it is important to inspect proofs before your job is 
printed.

This option is available to PostScript devices only.
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To reduce curve complexity by limiting control points
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Enter a value for Maximum points per curve.
Note

Reducing this number helps alleviate printing problems caused by objects that are too complex. A lower 
number of points per curve will not reduce quality but it will increase printing time.

This option is available to PostScript devices only.
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To verify fountain fills for banding
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Enable Banded fountain fill warnings.
Note

This warning only applies to linear fountain fills.
This option is available to PostScript devices only.
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To automatically increase fountain steps
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Enable Auto increase fountain steps.
Note

This option will increase the number of steps that are used to render fountain fills to avoid banding (the 
appearance of discreet strips in a fountain fill). This may increase printing time, but it will ensure the best possible 
rendering of fountain fills.

This option is available to PostScript devices only.
Tip

You can enable both Auto increase fountain steps and Optimize Fountain Fills. Fountain steps will be 
increased in fountain fills that require more steps and fountain steps will be reduced in fountain fills that have too 
many.
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To optimize fountain fills to reduce complexity
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Enable Optimize fountain fills.
Note

This option is available to PostScript devices only.
Tip

You can enable both Auto increase Fountain steps and Optimize Fountain Fills. Fountain steps will be 
increased in fountain fills that require more steps and fountain steps will be reduced in fountain fills that have too 
many.
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To download type 1 fonts
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Click Download Type 1 Fonts.
Note

If you enable the Download Type 1 Fonts , by default Convert True Type to Type 1 is also enabled. This 
ensures that True Type fonts are converted to Type 1 fonts so that they can be downloaded. Only disable this option 
if your output device has difficulty interpreting the Type 1 fonts.

This option is available to PostScript devices only.
Tip

Generally, you will want to leave this option enabled and let the driver download the Type 1 fonts to the 
output device. If you disable this option, fonts are output as graphics (either curves or bitmaps). This may be useful 
if the file contains a large number of fonts that would take an unacceptably long time to download, or not download 
at all, because of sheer size.
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To limit the number of bitmap fonts created
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. From the Special Settings group box, choose Bitmap Font Limit.
5. Enter a number between 0 and 250.
Note

This option applies to text that will be printed on a PostScript printer.
If the font used meets certain criteria, a bitmap version of the font is created in the printer's memory. 

Bitmap character descriptions are used because they look better at small point sizes and they print faster than the 
normal character outline descriptions. The fonts created in this way consume a large amount of PostScript memory. 
As a result, you may need to limit the number of such fonts created to avoid a PostScript error when you are 
printing.

The following criteria must be met for a bitmap version of the font to be created in printer memory:
The printed character size is no larger than 75 pixels. This corresponds to a point size of 18 at 300 dpi, 9 

points at 600 dpi, and so on.
The text is not scaled or skewed.
The text does not have an outline or a fill other than a uniform fill.
The text does not have any envelopes (non-linear transformations) applied to it.
The drawing is not being printed using the Sizing options or Fit To Page option in the Print Options dialog 

box.
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To set a bitmap font size threshold
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. From Special Settings choose Bitmap Font Size Threshold.
5. Enter a number between 0 and 1000. This value represents the bitmap height in pixels.
Note

The value set here determines if a Bitmap representation of the font can be created by the printer if the 
specific font is not loaded on the printer. The value represents the bitmap height in pixels. The higher the value, the
bigger the bitmaps. If a bitmap cannot be created, the text can be sent to the printer as curves.

This option applies to text that will be printed on a Postscript printer.
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To control bitmap conversion to grayscale
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. From the Special Settings group box, choose Color Bitmap Output.
5. Choose Send Color Bitmaps As Grayscale or Send Color Bitmaps As Color.
Note

The default setting calls for color bitmaps to be reduced to grayscale if they are going to a grayscale 
device. Transmission time is much faster this way and the file size is smaller. If you switch this setting to Send As 
Color the device will do the conversion which results in slower transmission and a larger file size.

This option is available to PostScript devices only.
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To output color bitmaps in RGB
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Enable Output Color Bitmaps in RGB.
Note

This option is available to PostScript devices only. 
Tip

PostScript output normally uses the CMYK color model. If outputting color bitmaps to an RGB or CMY 
device, enable the Output Color Bitmaps in RGB option. RGB devices will then receive ready-to-use RGB values 
(instead of CMYK). CMY devices will have an easier time translating RGB to CMY (3-color model to 3-color model) 
than CMYK to CMY (4-color model to 3-color model).

{button ,AL(`g_h_pt_postscript;;;;;',0,"Defaultoverview",)} Related Topics



To maintain OPI links
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Enable Maintain OPI links.
Note

To use OPI links, you must enable the "Link to high resolution file for output using OPI" option when 
importing your TIFF (or CT) files. These TIFF (or CT) images become known as OPI images. When your service 
bureau receives your print file, the OPI server substitutes the high-resolution images for the low-resolution images. 
If there are no OPI images in your file, the Maintain OPI Links option will not be available at print time.

Maintain OPI links is enabled automatically if you import your bitmaps correctly.
This option is available to PostScript devices only.

Tip
To proof a file that contains OPI images on a device that doesn't have the high-resolution files (e.g., your 

desktop printer), disable the Maintain OPI Links option.
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To request color separations
1. Click File, Print.
2. Click Options.
3. Click the Separations tab.
4. Enable Print Separations.
Tip

For special purposes, you may need to print separations in color. To do so, enable the In Color option.
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To convert spot colors to process colors
1. Click File, Print.
2. Click Options.
3. Click the Separations tab.
4. Enable Print Separations.
5. Enable Convert Spot Colors to CMYK.
Note

This does not affect the artwork itself, only the way it is printed.
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To select specific color separations
1. Click File, Print.
2. Click Options.
3. Click the Separations tab.
4. Enable Print Separations.
5. Choose the color separations to be printed.
Note

Colors created in a process color model break down into cyan (C), magenta (M), yellow (Y) and black (K) 
separations. Each spot color also has its own separation, identified by its color name and number. When you enable 
Print Separations, the list of colors displays all separations that are used in your artwork. You can choose to create a
.PRN file that includes all separations, one separation only, or any combination of separations, depending on the 
complexity of your artwork.

Tip
Generally, you should be able to save all the color separation information in one .PRN file. However, if your 

artwork is heavily loaded with special effects and several color separations (e.g., CMYK plus a number of spot 
colors), saving all color separation information in one .PRN file might result in an unwieldy file. In such a case create
a .PRN file for each separation. Include the seperation name in the filename for easier identification of your files.
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To print empty plates
1. Click File, Print.
2. Click Options.
3. Click the Separations tab.
4. Enable Print Separations.
5. Enable Print Empty Plates.
Tip

This option forces the printer or imagesetter to produce a sheet of paper or film even when there is 
nothing on them (e.g., there may be only yellow and black on a page but the cyan and magenta plates will be 
printed anyway if you are using process color). Normally, you would leave this option disabled to avoid wasting 
costly film. However, there may be instances when you want to force plates that are blank to print anyway.
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To customize a halftone screen
1. Click File, Print.
2. Click Options.
3. Click the Separations tab.
4. Enable Print Separations.
5. Enable Use Advanced Settings.
6. Click Advanced.
7. Change any of the following settings:

screen technology
halftone type (e.g., Line or Diamond)
printer or imagesetter resolution
the screen frequency and angle of any or all of the color separations.

8. Click OK
Note

Setting the halftone screens correctly is critical. Screens that are improperly set can result in undesirable 
moiré patterns and poor color reproduction. Consult your service bureau before you change any of these settings. If 
you are uncertain, use the default settings.

Tip
You can now set the screen frequency, screen angle and overprint options for spot colors as well as process

colors. For example, if you have a fountain fill made up of two spot colors, you can now set one to print at 45 
degrees and the other at 90 degrees.
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To trap by overprinting selected objects
1. Choose the pick tool.
2. Point to the object that requires color trapping.
3. Click the right mouse button, click OverPrint.
4. Enable Fill or Outline or both.
Note

Overprint Fill causes the top object to print over the underlying object (instead of the underlying object 
being knocked out), which makes "white gaps" impossible. This option is best used when the top color is much 
darker than the underlying color, otherwise an undesirable third color might result (e.g., red over yellow would 
result in an orange object).

Overprint Outline causes the top object's outline to print over the underlying object. The most common 
and safest choice is to assign the color of the top object's fill to the outline. When setting the outline thickness, bear
in mind that the outline straddles the path that defines the object's shape. Therefore, an outline of 0.30 points 
actually creates a trap of 0.15 points.

Note
Using color trapping effectively requires a solid understanding of the many variables involved in color 

printing. To ensure satisfactory results, it is important that you seek your service bureau's advice.
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To trap by overprinting selected color separations
1. Click File, Print.
2. Click Options.
3. Click the Separations tab.
4. Enable Print Separations.
5. Enable Use Advanced Settings.
6. Click Advanced.
7. Click the color separation to overprint.
8. Enable Overprint color.
9. Indicate whether you want graphics, text, or both to overprint.
Note

Using color trapping effectively requires a solid understanding of the many variables involved in color 
printing. To ensure satisfactory results, it is important that you seek your service bureau's advice.
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To trap by always overprinting black
1. Click File, Print.
2. Click Options.
3. Click the Separations tab.
4. Enable Print Separations.
5. Enable Always Overprint Black.
Note

Any object that contains 95% black or more will overprint any underlying objects. It is a useful option for 
artwork containing a lot of black text, but it should be used with caution on artwork with a high graphics contents.

Using color trapping effectively requires a solid understanding of the many variables involved in color 
printing. To ensure satisfactory results, it is important that you seek your service bureau's advice.

Tip
If your service bureau recommends a black threshold value other than 95%, click the Options tab, choose 

Overprint Black Threshold from the Special Settings Option list, and change the setting as required.
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To trap by auto-spreading
1. Click File, Print.
2. Click Options.
3. Click the Separations tab.
4. Enable Print Separations.
5. Enable Auto-Spreading.
6. (Optional) Enter a maximum trap value.
7. (Optional) Enter a value for Text Above (i.e., the minimum size to which auto-spreading is applied).
Note

Auto-Spreading creates color trapping by assigning an outline to the object that is the same color as its fill,
and having it overprint underlying objects. (Color trapping will be created for all objects in your file that meet three 
conditions: they don't already have an outline, they are filled with a uniform fill, and they haven't already been 
designated to overprint.)

The amount of spread assigned to an object depends on the maximum trap value and the object's color. 
The lighter the color, the greater the percentage of the maximum trap value. The darker the color, the smaller the 
percentage of the maximum trap value.

Applying auto-spreading to small text can make it illegible.
Note

Using color trapping effectively requires a solid understanding of the many variables involved in color 
printing. To ensure satisfactory results, it is important that you seek your service bureau's advice.
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To specify fountain steps
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Specify the number of steps to be used when rendering fountain fills.
Note

Fountain steps set from the Options dialog box only affect the way fountain fills display on your monitor. To 
control how they actually print, you must set the fountain steps on the Print Options page.

A low value will print faster but the transition between shades may be rather coarse, causing what is 
known as "banding". A higher value will result in a smoother blend but the printing times will be longer.

Tip
You can assign a custom fountain fill to one particular object. Select the object and 'open' the lock in the 

Fountain Fill dialog box (if the lock is closed then the number box is grayed out). Objects that are locked will print 
according to the number of steps assigned in the Print facilities. For example, you might want to set a high number 
of fountain steps for the one or two big objects in your drawing and leave the smaller items locked into the printer 
settings to be printed at a smaller step setting.
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To print a job information sheet
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Enable Print job information sheet.
5. (Optional) To customize this report, click Info Settings and indicate which categories of information are to be 

included. Also specify whether the job information is to be saved to a file or printed or both.
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To define special settings
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Choose an option from the Special Settings group box.
5. Choose a new setting for it.
Note

In previous versions of Corel products, these options were only changed by editing the CORELPRN.INI file. 
This new feature in the Print Options dialog box allows you to customize these options directly from the Corel 
program.

This is a list of all of the special settings:
Bitmap Font Limit (PostScript only)
Bitmap Font Size Threshold (PostScript only)
Composite Crop Marks (PostScript only)
Conform to DSC (PostScript only) 
Grayscale Driver Bitmap Output (PostScript only) 

Overprint Black Threshold (PostScript only)
Postscript 2 Stroke Adjust (PostScript only)
Registration Mark Type (PostScript only)
Bitmap Printing
Drive Banding
Fill Clipping
Page Orientation Warning
Preview Image Default
Print Preview Drag Mode
Text Output Method
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To print bitmaps in small chunks
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. From the Special Settings group box, choose Bitmap Printing.
5. Choose Output In 64K Chunks.
Note

This switch determines whether bitmaps are sent to non-PostScript printers all at once or in smaller blocks 
(below 64K). Usually, the driver tells the application which method it can or cannot handle. If you find that bitmaps 
do not print as expected, try forcing bitmaps to be output in a number of smaller blocks.
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To assign control over printer bands
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. From the Special Settings group box, choose Driver Banding.
5. Choose Let Driver Handle Banding (the printer driver creates the bands) or Send Bands to Driver (the Corel 

application splits the print job into bands before sending it to the printer driver).
Note

This option applies to non-PostScript printers only.
Tip

Some printers can't hold a full page in memory; therefore they must print the page in multiple passes, or 
"bands". The default setting lets the driver split the page into bands before sending them to the printer. If this 
proves too slow, or you encounter problems, request that Corel send the page to the driver already split into bands.
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To assign control over fill clipping
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. From the Special Settings group box, choose Fill Clipping.
5. Choose Use Driver Clipping For Fills or Use Software Clipping For Fills.
Note

This option applies to non-PostScript printers only.
Tip

Any fill other than Uniform fill (including Lenses and PowerClips) requires clipping if the object is not 
rectangular. The default setting is clipping controlled by the driver, because that usually means faster processing. If 
you encounter a problem printing non-Uniform fills, switch to clipping controlled by the software.
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To print to a black and white desktop printer
1. Click File, Print.
2. Choose a printer and make sure its properties are set correctly.
3. Make sure the Printer color profile and the Print to file options are NOT selected.
4. Indicate which pages or objects to print.
5. Indicate how many copies you need and whether to collate them.
6. (Optional) Click Options.

If required, enable file information, page numbering and crop marks.
Enable Preview Image and adjust the size and position of your artwork.
Click OK.

Note
The above procedure applies to printing a black and white composite to a black and white desktop printer. 

If you are printing color separations to a black & white desktop printer, also set the appropriate options under the 
Separations tab.
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To print to a color desktop printer
1. Click File, Print.
2. Choose the printer and make sure its properties are set correctly.
3. Verify that the Print to file option is NOT selected.
4. Make sure the printer color profile that matches your printer is identified and enabled. If the profile identified is

not the correct one, go to Tools, Color Manager and select the appropriate profile. Enable the correct profile in 
the Print dialog box.

5. Indicate which pages or objects to print.
6. Indicate how many copies you need and whether to collate them.
7. (Optional) Click Options.

If required, enable file information, page numbering and crop marks.
Enable Preview Image and adjust the size and position of your artwork.
Click OK.

Note
The above procedure applies to printing a color composite to a color desktop printer. If you are printing 

color separations to a color desktop printer also set the appropriate options under the Separations tab.
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To print to a color press
1. Prepare your project.

It is crucial that you start off on the right foot. Make sure you understand the importance of color management
and color correction. Also, consult your service bureau and printing shop AT THE VERY BEGINNING of your 
project. They will provide you with invaluable information. Skipping this preparatory step can result in costly 
errors or omissions.
Once you have all the necessary information from your service bureau and printing shop, and your artwork is 
ready, you will need to create a "print file"(.PRN). This is the file you will send to your service bureau.
For a better understanding of what will happen to your file once you send it out, review the information about 
going to press (see related topics).
To begin creating the .PRN file, click File, Print.

2. Set up the basics of the print job.
Enable Print to File. (You will enter a name for the file later, at step 7.)
Choose the imagesetter driver specified by your service bureau.
Make sure the printer color profile that matches the above imagesetter is selected. If it isn't, go to File, Color 
Manager and select the appropriate profile.
Specify a print range.
Set the number of copies to 1.

3. Set up the printable page.
Click Options and enable Preview Image.
Adjust the size and position of your artwork, if required.
Set the bleed limit, if required.
Choose a layout style, if required.

4. Set up the reference tools (below the Preview box).
Set the printers' marks as specified by your service bureau: file information, crop marks, registration marks, 
calibration bar, and densitometer scale. 
Choose negative or positive film and emulsion up or down, according to your service bureau's specifications.

5. Set the advanced options (Options tab).
If required, adjust the number of fountain steps.
Set the screen frequency. You can fine-tune this setting at step 6, if required.
Click PostScript Preferences and set all options that apply.
(optional) Enable Print job information

6. Set the color separation parameters (Separations tab) if applicable.
Enabled Print Separations. Make sure the In Color option is NOT enabled.
If required, enable Convert Spot Colors to CMYK.
Choose all the color separations; indicate whether you want empty plates printed.
Customize your halftone screen, in consultation with your service bureau, if required.
Choose the appropriate trapping strategy, in consultation with your service bureau, if required.

7. Click OK. 
At the prompt, enter a name for your print file.

8. Send out, proof, and approve your job for printing.
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To print Object Data
1. In the Object Data Manager dialog box, click File, Print.
2. (Optional) To print only the highlighted range of cells, choose Selection for Page Range.



To print thumbnails
1. Click File, Print options.
2. Click Print Thumbnails.
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To set thumbnail options
1. Click File, options.
2. Type the number of thumbnails per row.
3. If you want a frame around each thumbnail, enable Print Frame.
4. If you want the filename included with each thumbnail, enable Print Name.
5. If you want the file's path included with each thumbnail, enable Print Path.
6. If you want to print higher resolution thumbnails, enable Regenerate.
Note

If you enable Regenerate, your print job will take longer to print.
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To print files
1. Click File, Print options.
2. Click Print Files.
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To print a header
1. Click File, Print options.
2. Enable Print Header.

{button ,AL(`prn_mm;;;;;',0,"Defaultoverview",)} Related Topics



To set header options
1. Click File, Print options.
2. If you want a header on every page, enable Header on each page.
3. If you want to include page numbers in the headers, enable Print page numbers.
4. Type any text you want to include in the header in the Custon text box.
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To print a border around each page
1. Click File, Print options.
2. Enable Print border.
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To include sub-albums in the print job
1. Click File, Print options.
4. Enable Include Sub-Albums.
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To change the header font
1. Click File, Print options.
2. Click Font.
3. Change the font settings.
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The printer icon is in the second column from the left. When it is not grayed out (as in the fourth row), the layer will 
print.



The Enlarge Print Preview button allows you to switch from a regular to a full-screen print preview and back again.



These two arrow buttons allow you flip through the pages of your document. They are located at the lower-right 
corner of the Preview box.



The File Information button allows you to print the filename, current date, and time (and tile number, if applicable) 
at the bottom of the sheet.
If applicable, color separation information (color, screen frequency and angle, plate number) is printed at the top of 
the sheet.



The Crop Mark button allows you to print crop marks. These marks are used as alignment aids when trimming the 
printed output down to its final size.



The Registration mark button allows you to print registration marks on each sheet. These marks serve as guides for 
aligning color separations.



The Page Number button allows you to place page numbers on the printed sheets.



The Calibration bar button allows you to print a bar of the six basic colors (red, green, blue; cyan, magenta, yellow) 
beside your artwork. These color patches are used to verify the quality of the printed output.



The Densitometer Scale button allows you to print a Densitometer Scale, a bar of varying shades of gray, on each 
separation sheet. This is an advanced feature that allows you to check the accuracy, quality, and consistency of the
output with an instrument called a densitometer.



The Negative button allows you to print a negative image.



The Emulsion Down button allows you to specify that the film emulsion faces down.



File formats - Overview
Data in a computer file can be stored using several systems. The system that any one file uses is known as its 
file format. Different types of files, such as bitmap, vector, sound, text, etc., use different formats, but even 
within a type group, there can be dozens of different formats available. Formats are frequently referred to by the 
extension that gets added to the file when saving it in that format, e.g., .CMX, .BMP, .DOC, .AVI, .TIF, etc. In 
Windows 95-based applications, different formats use different icons when listed in file managers and dialog 
boxes, such as Corel PHOTO-PAINT's Open dialog box. 
File formats are often created for use by a specific application. For example, images created in CorelDRAW are 
stored as .CDR files. Some formats are more generic, such as the .TXT format, which is an ASCII file and not 
associated with any specific application.



File compression
Computer files are often stored in a compressed format to save space on your hard disk. There are several 
compression techniques that can be used, depending on the original file format. Generally, the more compressed
a file is, the slower it is to read from and/or write to.
Compression can be lossless or lossy. Lossless compression retains all the original data through the compression 
and decompression processes. Lossless compression is recommended for storing text or numerical data, such as 
spreadsheets. Lossy compression loses some of the original data, but depending on your requirements, this loss 
may not make a difference in the final result of your work. Lossy compression can compress your original files to 
a much greater extent than lossless compression, and so it may be desired when disk space is at a premium.
RLE, LZW, and CCITT are lossless compression techniques. JPEG is a lossy technique and is used mainly to 
compress color and grayscale continuous-tone images. The information that is discarded during compression 
does not seriously affect the image quality.



Color depth
Color depth refers to the number of colors that can be supported in a file. A 1-bit file supports two colors (usually
black and white), a 2-bit file supports four colors, a 4-bit file supports 16 colors, an 8-bit file supports 256 colors 
and a 24-bit file supports 16 million colors. A grayscale image is an 8-bit file, with 256 increments between black 
and white. The higher the color depth supported by a file, the more space the file takes up on disk.
When you save or export a file, you can often specify what color depth you want to save the image to. If you 
have few colors in your original image, saving to a higher color depth (e.g., 16 color to 256 color) should produce
an image whose colors are very similar to the original. However, if your original image has many colors, and you 
convert it to a lower color depth (e.g., 24 bit color to 256 color), the file will create a palette of colors and use 
combinations of these colors to attempt to simulate the original color of the pixel. The colors in the palette will 
depend on the colors in the original image. 
Different applications support different color depths. As well, some file formats support only certain numbers of 
colors. When deciding what file format to use when saving a file, you should consider any color limitations of the 
file format and the application you'll be using with the file.
Note

A file format that supports a large number of colors may not necessarily support all color depths less than 
its maximum. For example, a format may support 24-bit color, but not black and white.



Corel Filter Manager - overview
For an application to read a file that has been saved in a specific file format, it requires a translator to decode the
format information and open the file. This translator can be embedded into the application, but with the dozens 
of file formats available, it would require an enormous amount of memory.
The Corel Filter Manager contains translators for all the file formats supported by all the Corel applications. For 
example, if you're working in CorelDRAW and you wish to open a file that has been saved in a format other 
than .CDR, the filter manager translates the file so that the program can open it. If you want to save an image in 
a format other than .CDR, the filter manager translates the file into the other format before saving it.
Corel applications that create documents, such as CorelDRAW and Corel PRESENTS, have their own native file 
formats that they use to store document information. The Open and Save/Save As commands are used to load 
and save this information. The Import command is used to load individual images that have been saved in non-
native formats into an open document. The Export command is used to save images in non-native formats.
For applications that do not create documents, such as Corel PHOTO-PAINT and Corel OCR-TRACE, the Open and 
Save/Save As commands are used to load and save images.



Importing files
Corel applications support various file formats, but only some of them are native to the application. If you want 
to read a file that has a non-native format, you must import that file.
The Import command is located in the File menu. When you choose the command, a dialog box appears where 
you can choose the drive and folder where the file is saved. If you know the format of the file you want, you can 
choose it from the File As Type list to display only the files with that extension. To choose the file to import, 
double-click the filename in the display window.



Exporting files
Corel applications can save files in various file formats, but only some of them are native to the application. If 
you want to save a file in a non-native format, you must export that file.
The Export command is located in the File menu. When you choose the command, a dialog box appears where 
you can choose the drive and folder where the file is to be saved. You can choose a file type from the list box and
the format's extension appears in the File Name box. You can give the file a name by double-clicking the 
filename in the display window.



Bitmap file formats
Bitmaps are images made up of an array of rectangular dots ("pixels"). They are created in imaging programs, 
such as Corel PHOTO-PAINT, or when a paper document is scanned.
For information about bitmap file formats supported by Corel applications, click the format name below.
Adobe Photoshop (.PSD)
CALS Raster (.CAL)
Cursors (.CUR, .DLL, .EXE))
GEM Raster (.IMG)
Graphics Interchange Format (.GIF)
Icons (.ICO, .DLL, .EXE))
Joint Photographic Experts Group, JPEG (.JPG)
Kodak Photo CD (.PCD)
Macintosh Paint (.MAC)
OS/2 Bitmap (.BMP)
Paintbrush (.PCX)
Picture Publisher 4.0 (.PP4)
Resource Bitmaps (.DLL, .EXE)
Scitex (.CT)
Tag Image File Format, TIFF (.TIF)
Targa (.TGA)
Windows Bitmap (.BMP)



Windows Bitmap (.BMP) Microsoft Windows Bitmap. Bitmap file format developed by Microsoft Corporation. 
Supported by Microsoft Windows and Windows NT platforms on Intel machines. Supported by many applications. 
Supports 1-, 4-, 8-, 16-, 24- and 32-bit color. Unlimited image size. Supports RLE compression. Used widely to 
exchange and store bitmap information.



OS/2 Bitmap (.BMP): Bitmap file format developed by Microsoft Corporation and IBM. Supported by Intel 
machines running OS/2, MS-DOS, Windows and Windows NT. Supported by numerous applications, including non-
OS/2 and non-PC applications. Supports 1-bit, 4-bit, 8-bit and 24-bit color. Supports RLE compression. Maximum 
image size 64,000 pixels by 64,000 pixels. Used to store bitmap information.



CALS Raster (.CAL):    Bitmap file format developed by the United States Department of Defense. Supported by
all platforms. Supports monochromatic images only. Unlimited image size. Supports CCITT Group 4 compression. 
Used in most U.S. government document-handling applications. Also used as a data exchange format for 
technical graphics, Computer Aided Design and Computer Aided Manufacturing, and image processing 
applications.



Scitex (.CT): Bitmap file format. Supported by PC platform. Supported by most applications. Supports grayscale
and CMYK (32-bit) color. Does not support compression. Used primarily for color separations.



Cursors (.CUR, .DLL, .EXE): Resource file formats used to create cursors for Windows 3.1, Windows NT and 
Windows 95 interfaces. Supports 1-bit and 4-bit color. Corel applications can only import these formats.



Resource Bitmaps (.DLL, .EXE): Resource file formats used to create bitmaps (e.g., dialog boxes) for Windows
3.1, Windows NT, and Windows 95 interfaces. Supports 1-bit and 4-bit color. Corel applications can only import 
these formats.



Graphics Interchange Format (.GIF):    Graphics Interchange Format. Bitmap file format created by 
CompuServe Inc. Supported by MS-DOS, Macintosh, UNIX, Amiga, and other platforms. Supports 256 colors. 
Maximum image size is 64,000 pixels by 64,000 pixels. Supports LZW compression. Mainly used as an exchange 
format, but is supported by many applications. Can store multiple bitmap images in a single file.



Icons (.ICO, .DLL, .EXE): Resource file formats used to create icons for Windows 3.1, Windows NT and Windows
95 interfaces. Supports 1-bit and 4-bit color. Corel applications can only import these formats.



GEM Raster (.IMG):    GEM Raster. Bitmap file format native to the Graphical Environment Manager developed 
by Digital Research. Support by GEM, MS-DOS and Atari ST platforms. Supports 16,384 colors. Maximum image 
size is 64,000 pixels by 64,000 pixels. Supports RLE compression. Used mainly on the Atari ST platform, but is 
also frequently found in the PC desktop publishing environment.



Joint Photographic Experts Group, JPEG (.JPG):    Also known as JFIF (for JPEG File Interchange Format). 
Bitmap file format developed by C-Cube Microsystems. Supported by all platforms. Supports 24-bit color. 
Maximum image size is 64,000 pixels by 64,000 pixels. Supports JPEG compression. Used as a storage and 
exchange format for files containing data that has been compressed with JPEG.



Kodak Photo CD (.PCD):    Kodak Photo CD. Bitmap file format developed by Eastman Kodak. Supported by all 
platforms. and supports 24-bit color. Maximum image size is 2,048 pixels by 3,072 pixels. Used to store 
photographic images on CD-ROMs.



Paintbrush (.PCX):    Bitmap file format native to PC Paintbrush and Microsoft Paintbrush for Windows. 
Supported by MS-DOS, Windows, UNIX and other platforms, and numerous applications. Supports 24-bit color. 
Maximum image size is 64,000 by 64,000 pixels. Supports RLE compression. Widely used as a storage and 
exchange format for Windows-based applications.



Macintosh Paint (.MAC): Macintosh Paint, MacPaint. Bitmap file format developed by Apple Computer Inc. 
Supported by Macintosh platform. Supports monochrome artwork only. Maximum image size is 576 pixels by 720
pixels. Supports RLE compression. Used mainly by Macintosh graphics applications to store black and white 
graphics and clipart.



Picture Publisher 4.0 (.PP4): Bitmap file format developed by MicroGrafx. Supported by PC platforms. 
Supported by Picture Publisher. Supports 1-, 4-, 8-, 24-, and 32-bit color. Supports LZW compression. No 
maximum image size. Used for storage of bitmap information. Corel applications can only import this format.



Adobe Photoshop (.PSD):    Bitmap file format native to Adobe Photoshop 2.5. Supported by Macintosh and MS
Windows platforms. Maximum image size is 30,000 pixels by 30,000 pixels. Supports RLE compression. Widely 
used in commercial art sector.



Targa (.TGA):    Targa Image File. Bitmap file format developed by Truevision Inc. Supported by MS-DOS, 
Windows, UNIX, Atari, Amiga and other platorms. Supported by numerous applications. Supports 32-bit color. No 
maximum image size. Supports RLE compression. Used widely in paint, graphics and imaging applications. Also 
widely used for still video editing.



Tag Image File Format (.TIF):    Tagged Image File Format (TIFF). Bitmap file format developed by Aldus. 
Supported by MS-DOS, Macintosh, UNIX and other platforms and most paint, imaging, and desktop publishing 
applications. Supports 24-bit color. Supports RLE, LZW, CCITT Group 3 and Group 4, and JPEG compression. Very 
widely used format for storing and exchanging graphics information among platforms and applications.



Vector file formats
Vector images are stored as algebraic equations defining the various lines and curves of the drawing. They can 
also include bitmap information. They are created in illustration programs, such as CorelDRAW or bitmap tracing 
applications, such as Corel OCR-TRACE. Vector formats are not restricted to certain color depths.
For information about vector file formats supported by Corel applications, click the format name below.
Adobe Illustrator (.AI)
AutoCAD (.DXF)
Encapsulated PostScript (.EPS)
Hewlett Packard Graphics Language (.HGL)
IBM PIF (.PIF)
Interpreted PostScript (.PS)
MAC QuickDraw (.PCT)
MicroGrafix (.DRW)



Adobe Illustrator (.AI): Vector file format developed by Adobe Systems. Supported by Windows platform and 
numerous Windows-based illustration applications.
 



MicroGrafx Draw(.DRW): Vector file format developed by MicroGrafx. Supported by Windows platform and 
MicroGrafx Draw illustration application.



AutoCAD (.DXF):    Vector file format native to AutoCAD, a computer aided design application. Supported by 
MS-DOS platform Supports 256 colors. Can store three-dimensional objects. Cannot be compressed. Supported 
by many other CAD programs and some drawing programs, including CorelDRAW.



Encapsulated PostScript (.EPS): Vector file format developed by Adobe Systems. Supported by MS-DOS, 
Windows, Macintosh, UNIX, and other platforms. Supported by numerous applications. Used for illustration and 
desktop publishing applications and as a bitmap and vector data interchange.



Hewlett Packard Graphics Language (.HGL): Vector file format developed by Hewlett Packard. Supported by
PC and Macintosh platforms. Supported by all illustration applications. Widely used as a page description 
language.



MAC QuickDraw (.PCT):    Macintosh Picture, QuickDraw Picture. Vector file format developed by Apple 
Computer Inc. and native to QuickDraw. Supported by Macintosh platform. Supports 24-bit color. Supports 
PackBits and JPEG compression. Widely used in Macintosh applications using graphics. 



IBM PIF (.PIF): Vector file format developed by IBM. Supported by PC platform and IBM applications. Not widely 
used.



Interpreted PostScript (.PS): Vector file format developed by Adobe Systems. Supported by PC, Macintosh 
and UNIX platforms. Supported by all graphics applications. Used as a page description language. Very common 
in professional printing industry.



Metafile File Formats
Metafiles are a type of vector file format that are used to facilitate the exchange of information among 
applications. For example, .CMX is an exchange format used by all Corel graphics applications. For more 
information about metafile file formats supported by Corel applications, click the format name below.
Computer Graphics Metafile (.CGM)
NAPLAS Graphic Metafile (.NAP)
OS/2 PM Metafile (.MET)
Windows Metafile (.WMF)
WordPerfect Graphics (.WPG)



Computer Graphics Metafile (.CGM): Computer Graphics Metafile. Metafile format developed by the 
International Standards Organization and the American Standards National Institute. Supported by all platforms. 
Supports an unlimited number of colors and unlimited image size. Supports RLE and CCITT Group 3 and Group 4 
compression. Used to exchange vector and bitmap information between platforms. Supports the exchange of 
very sophisticated images.



OS/2 PM Metafile ( .MET): Presentation Manager Metafile. Vector file format developed by Microsoft 
Corporation and IBM. Supported by OS/2 platform. Supports unlimited colors. Supports RLE compression. Used to
store and exchange graphics information among OS/2-based applications.



NAPLAS Graphic Metafile (.NAP): Vector file format. Supported by PC and UNIX platforms and 
communications applications. Mainly used to communicate graphic images between computers.



Windows Metafile (.WMF):    Microsoft Windows Metafile. Vector file format developed by Microsoft 
Corporation. Supported by Windows platform and several Windows-based graphics applications. Supports 24-bit 
color. Widely used to store and exchange vector and bitmap data between Windows-based applications.



WordPerfect Graphics (.WPG): Vector file format developed by WordPerfect Corporation. Supported by MS-
DOS, Windows, Macintosh and UNIX platforms. Supported by WordPerfect and other word processing 
applications. Supports 256 colors. Supports RLE compression. Used to store document and image data.



Text file formats
For information about text file formats supported by Corel applications, click the format name below.
AmiPro for Windows
ASCII (.TXT)
MS Word for DOS, Windows (.DOC)
MS Word for MAC (.MCW)
MS Write (.WRI)
Rich Text Format (.RTF)
WordPerfect for DOS, Windows (.WP?)
WordStar for DOS, Windows (.WSD)
XYWrite for DOS III, III Plus, IV



MS Word for DOS, Windows (.DOC): Text file format developed by Microsoft Corporation. Supported by PC 
platform. Supported by MS Word and other word processing applications.



MS Word for MAC (.MCW): Text file format developed by Microsoft Corporation. Supported by PC platform. 
Supported by MS Word and other word processing applications.



Rich Text Format (.RTF):    Rich Text Format. Text file format created by Microsoft Corporation. Supported by 
MS-DOS platform and most word processing applications. Supports 256 colors. Does not support compression. 
Used mainly to exchange formatted text data among platforms and word processing applications.



ASCII (.TXT): Also known as ANSI. Text file format developed by the American National Standards Institute. 
Supported by all platforms and all applications. Standard text format. Widely used.



WordPerfect for DOS, Windows (.WP): Text file format developed by WordPerfect Corporation. Supported by 
PC platform. Supported by WordPerfect and other word processing applications.



MS Write (.WRI): Text file format developed by Microsoft Corporation. Supported by Windows platform. 
Supported by MS Write, a word processing application included with Windows 3.1 interface.



.WordStar for DOS, Windows (WSD): Text file format developed by WordStar. Supported by Windows 
platform. Supported by WordStar word processing application.



AmiPro for Windows: Text file format developed by Lotus Corporation. Supported by PC platform. Supported 
by AmiPro word processing application.



XYWrite for DOS III, III Plus, IV, Windows: Text file format. Supported by PC platform. Supported by XYWrite 
word processing application.



Presentation file formats
Presentation file formats are used to store information for business graphics applications. For information about 
presentation file formats supported by Corel applications, click the format name below.
Harvard Graphics 2.0 (.SHW)
Harvard Graphics 3.0 (.SH3)
Lotus Freelance (.FLW)
MS PowerPoint 2.0, 3.0 (.PPT)



Lotus Freelance (.FLW): Presentation file format developed by Lotus Corporation. Supported by PC platform. 
Supported by Lotus Freelance application. Used for storing business graphics information.



MS PowerPoint 2.0, 3.0 (.PPT): Presentation file format developed by Microsoft Corporation. Supported by PC 
platform. Supported by MS PowerPoint application. Used for storing business graphics information.



Harvard Graphics 3.0 (.SH3):. Presentation file format developed by Software Publishing. Supported by PC 
platform. Supported by Harvard Graphics and other applications. Used for storing business graphics information. 
Format is proprietary to Software Publishing.



Harvard Graphics 2.0 (.SHW): Presentation file format developed by Software Publishing. Supported by MS-
DOS platform. Supported by Harvard Graphics and other applications. Used for storing business graphics 
information. Format is proprietary to Software Publishing.



Sound file formats
Sound file formats are used to store digital audio information. For information about sound file formats supported
by Corel applications, click the format name below.
AIFF (.AIF)
Amiga Sound (.SVX)
MAC Sound (.SND)
MIDI (.MID)
Sound Blaster (.VOC)
Wave (.WAV)



AIFF (.AIF): Sound file format developed by Apple Computer Inc. Supported by Macintosh platform and 
applications. Supports ACE2, ACE8, MAC3 and MAC6 compression. Used for storing audio information.



MIDI (.MID): Sound file format developed by International MIDI Association. Supported by Windows platform 
and numerous applications. Used for creating digital sound for musical instruments.



MAC Sound (.SND): Sound file format developed by Apple Computer Inc. Supproted by Macintosh platform and
various Macintosh applications. Supports some compression. Used as a system resource format for storing audio 
information.



Amiga Sound (.SVX): Sound file format developed by Commodore. Supported by Amiga platform and 
applications. Does not support compression. Used for storing audio information.



Sound Blaster (.VOC): Sound file format developed by Creative Labs Inc. Supported by Windows and DOS 
platforms. Supports (4/3/2, 16-4), CCITT a-Law, and CCITT u-Law compression. Used for storing audio 
information.



WAVE (.WAV): Sound file format developed by Microsoft Corporation. Supported by Windows platform and 
applications. Supports MSADPCM, CCITT a-Law, CCITT u-Law and other compression. Used as the resource format
for storing audio information in Windows platform. 



Animation file formats
Animation file formats are used to store graphics information contained within animation frames. For information 
about animation file formats supported by Corel applications, click the format name below.
Autodesk FLIC (.FLC)
MacPICTS (.PCS, .PIC)
Microsoft Resource Interchange File Format, RIFF (.AVI)
MPEG (.MPG)
Quick Time (.QTM)



Microsoft Resource Interchange File Format, RIFF (.AVI): Animation file format developed by Microsoft 
Corporation. Supported by Windows and Windows NT platforms. Supported by Windows and OS/2 multimedia 
applications. Supports 256 colors. Supports RLE compression. Used to store audio, video and graphics 
information used in multimedia applications.



Autodesk FLIC (.FLC): Also known as .FLI or Flic. Animation file format native to Autodesk Animator and 
Animator Pro. Supported by Intel platforms. Supports 256 colors. Maximum image size is 64,000 pixels by 64,000
pixels. Supports RLE and delta compression. Used widely for animation sequences in animation graphics, 
Computer Aided Design and computer games applications. Not well suited for animating real-world images.



MPEG (.MPG): Animation file format developed by Motion Picture Experts Group of the International Standards 
Organization. Supported by all platforms. Supported by Xing Technologies MPEG player and other applications. 
Supports DCT compression. Maximum image size 4095 pixels by 4095 pixels by 30 frames per second. Used to 
encode audio, video, text, and graphical data.



MacPICTS (.PCS, .PIC): Animation file format developed by Macromedia. Supported by Macintosh platforms. 
Supported by Macromedia Director and Macintosh applications. Supports 256 colors. Supports PackBits and JPEG 
compression. Used to store animation data. Predecessor of Quick Time.



Quick Time (QTM): Animation file format developed by Apple Computer Inc. Supported by Apple Macintosh and
Microsoft Windows platforms. Supports 24-bit color. Maximum image size is 64,000 by 64,000 pixels. Supports 
RLE, JPEG and other compression techniques. Used to store audio and motion video information.



Corel native file formats
The following formats are native to Corel applications. For more information, click the format name.
CorelCHART (.CCH)
CorelDRAW (.CDR)
CorelFLOW (.CFL)
Corel Meta Exchange (.CMX)
Corel Metafile (.CMF)
Corel MOVE (.MOV)
Corel PHOTO-PAINT (.CPT)
Corel SHOW (.SHW)
Wavelet (.WVT)



CorelCHART (.CCH): Presentation file format.



CorelDRAW (.CDR): Vector file format. Used to save document information from all versions of CorelDRAW.



CorelFLOW (.CFL): Design file format. CorelFLOW creates flowcharts.



Corel Metafile (.CMF): Exchange format used in Corel Version 4 products.



Corel Meta Exchange (.CMX): Exchange format used in Corel products, Version 5 and higher.



CorelMOVE (.MOV): Animation file format.



Corel PHOTO-PAINT (.CPT): Bitmap file format. Supported by Windows platform and various image editing 
applications. Supports 1-, 2-, 4-, 8-, 16-, 24-, and 32-bit color, and 8-bit grayscale images. Can store masks and 
objects created in PHOTO-PAINT.



CorelSHOW (.SHW): Presentation file format.



Wavelet (.WVT): Bitmap file format. Supports 24-bit color. Supports Wavelet compression. Used to store bitmap
information at high compression levels.





OPEN DIALOG



Lists the folders and files in the selected location. To see what’s inside a folder, double-click it. You can also use 
the Look In box to see the hierarchy of folders.



Lists the available folders and files.    To see how the current folder fits in the hierarchy on your computer, click 
the down arrow. To see what’s inside a folder, click it. The box below shows the folders and files in the selected 
location. You can also double-click a folder or file in that box to open it.



Provides a space for you to type the name of the file. You can use * as a wildcard. For example, you can type *.* 
to see a list of all files.



Lists the type of files to display. This is useful for narrowing the list of files displayed to only those files you’re 
interested in.



Opens the file with the name, file type, and location you have specified.



Closes this dialog box without saving any changes you have made.



Displays a thumbnail image of the currently selected graphics file. If a non-graphics file is selected, the Preview 
window is de-activated and appears crossed through with an X. 

Note
You must enable the Preview check box to display graphics files in the Preview window. If this check box is disabled, 
the Preview window appears crossed through with an X.



Displays the progress of the selected file as it loads into the Preview window.



Use the scroll bar to visually scroll through a file containing more than one graphic item. Executable (EXE) files, 
for example, often contain icons and cursors which may be viewed in the Preview window.
Only graphics files will appear in the Preview window. Non-graphics files are not displayed.



Click the Preview check box (if it is not already enabled) to see a thumbnail of your image. When Preview is 
disabled an X appears in the Preview window. Also, vector files that do not have a BMP header associated with 
them cannot be previewed and appear as an X.



Click the down arrow to display a drop-down box listing several different methods of opening files. You can load 
files as:

Full Image
Loads the entire file. If the file you are opening is too large for your system resources, "not enough memory" is 
displayed. The file is loaded as a partial area.

Crop
Loads a cropped area. The Crop Image dialog box opens. Crop an area.

Resample
Loads a resampled version of the file. The Resample dialog box opens. Resample an area.

Partial Load
Loads a partial area. The Partial Area dialog box opens. Select an area.



Click to view file information such as image size, file format, keywords, notes, and suppress filter.



Click to open the About Import Filter dialog box that displays information about the currently selected file/filter 
type (i.e., Corel PHOTO-PAINT Image, CPT).



Select filter.



Displays the image dimensions (in pixels) and image color mode.



Displays the file format of the currently selected image (e.g., Corel PHOTO-PAINT Image (CPT) Uncompressed).



Displays a list of all notes that are attached to the currently selected file.



Provides a space for you to type file keywords. These keywords are used to find files stored on your system. You 
can type single words, phrases, or combinations of both. Use commas to separate each keyword.



To use OPI links, you must enable the "Link to high resolution file for output using OPI" option when importing 
your TIFF (or CT) files. These TIFF (or CT) images become known as OPI images. When your service bureau 
receives your print file, the OPI server substitutes the high-resolution images for the low-resolution images. If 
there are no OPI images in your file, the Maintain OPI Links option will not be available at print time.



Enable the radio button to import the file onto a new slide.



Enable the radio button to import the file onto the current slide.



Enable the radio button to import the file onto the current background.



When enabled, suppresses the dialog box that lets you specify options for opening, importing, exporting, or 
saving a file to or from the specified file format. The program automatically assigns default settings.



Enable this check box when importing vector formats only. If turned on, CorelDRAW eliminates redundant points 
in the imported graphic. Set the tolerance value in the number box. This value controls how much the curve can 
vary from the original. A small value forces high accuracy, but will result in more points.



SAVE DIALOG



Lists the folders and files in the selected location. To see what’s inside a folder, double-click it. You can also use 
the Look In box to see the hierarchy of folders.



Lists the available folders and files. To see how the current folder fits in the hierarchy on your computer, click the
down arrow. To see what’s inside a folder, click it. The box below shows the folders and files in the selected 
location. You can also double-click a folder or file in that box to open it.



Provides a space for you to type the name of the file.



Lists the type of files to display. This is useful for narrowing the list of files displayed to only those files you’re 
interested in.



Closes this dialog box and saves any changes you have made.



Closes this dialog box without saving any changes you have made.



Click to displays an overview of this dialog box. For help on an item, click the ? button at the top of the dialog 
box, and then click the item.



Click to open the About Import Filter dialog box that displays information about the currently selected file/filter 
type (i.e., Corel PHOTO-PAINT Image, CPT).



Displays a list of all keywords that are attached to the currently selected file.



Displays a list of all notes that are attached to the currently selected file.



Displays a drop-down box listing the available compression types. The compression types vary with the file/filter 
type selected in the Save as type: drop-down box. Click to select a compression type before saving.



When enabled, suppresses the dialog box that lets you specify options for opening, importing, exporting, or 
saving a file to or from the specified file format. The program automatically assigns default settings.



Enable to create a backup copy of the file when saved. 



Enable to save only selected objects. 
Note

Ensure that you have selected the desired objects before choosing Save, otherwise this option will be grayed out.



CROP DIALOG



Overview info



Crop Image dialog box
The Crop Image dialog box allows you to crop an image before loading. The cropping is permanent and creates a 
new, smaller image.

For more information on the options included in this dialog box, use the What’s This? online Help tool.



What’s This?



Displays the path, file name, and file extension of the image to be cropped. 



Displays the image with a bounding box. Move the nodes on the bounding box to crop the image. Use the Hand 
cursor to move the bounding box to a specific area of the image.



Enter a number or use the scroll arrows to select the height of the cropped area.



Enter a number or use the scroll arrows to select the width of the cropped area.



Enter a number or use the scroll arrows to position the top of the cropped area.



Enter a number or use the scroll arrows to position the left side of the cropped area.



Click to select the entire image or to resize the bounding box to cover the entire area and reselect the cropped 
area.



Displays a drop-down box listing a number of image measurement units. The values displayed in the Width and 
Height number boxes will reflect the measurement unit selected here.



Displays the size of the new, cropped image in bytes.



RESAMPLE



Overview



Resample dialog box
The Resample dialog box creates a new image, resampled to a smaller size.

For more information on the options included in this dialog box, use the What’s This? online Help tool.



What’s This?



Displays the path, file name, and file extension of the image to be resampled.



Enter a number or use the scroll arrows to select the width of the resampled image.



Enter a number or use the scroll arrows to select the height of the resampled image.



Displays a drop-down box displaying a number of measurement units by which you can resample an image. The 
values displayed in the Width and Height boxes reflect the chosen unit of measurement. 



Displays the width of the original file according to the measurement unit selected in the Units drop-down box.



Displays the height of the original file according to the measurement unit selected in the Units drop-down box.



Controls the horizontal resolution of the image currently being resampled. Resolution refers to the fineness of 
image detail and the amount of information required to record, store, display and print an image. Resolution is 
measured in dots per inch (dpi), referring to the number of pixels used to construct an image. Choose a 
resolution in keeping with the resolution of both your monitor and (if you plan to print an image) printer. When 
you work with an image that you want to print, choose a resolution close to the maximum dpi output value of 
your printer, otherwise you may not be able to print much of what you see on screen. If you do not plan to print 
an image, you can freely choose a higher resolution to maximum image detail.



Displays the horizontal resolution of the original image prior to resampling.



Displays the vertical resolution of the original image prior to resampling.



Controls the vertical resolution of the image currently being resampled. Resolution refers to the fineness of 
image detail and the amount of information required to record, store, display and print an image. Resolution is 
measured in dots per inch (dpi), referring to the number of pixels used to construct an image. Choose a 
resolution in keeping with the resolution of both your monitor and (if you plan to print an image) printer. When 
you work with an image that you want to print, choose a resolution close to the maximum dpi output value of 
your printer, otherwise you may not be able to print much of what you see on screen. If you do not plan to print 
an image, you can freely choose a higher resolution to maximum image detail.



Enable to maintain equal horizontal and vertical resolution values. Any value entered in one box will cause the 
other box to change automatically.



Enable to maintain the image aspect ratio (the image width and height proportions rated in percentage values). 
Any value entered in one box will cause the other box to change automatically.



Displays the original image size in bytes prior to resampling.



Displays the new image size in bytes based on the current resampling settings.



BITMAP



Bitmap Import/Export dialog box
Use this dialog box to specify how you want to import or export bitmap files.

For more information on the options included in this dialog box, use the What’s This? online Help tool.



Displays a drop-down list box where you choose a color mode. Choose the number of shades of gray or the 
number of colors you want.
The greater the number of colors, the larger the file.

Black and white = 1 bit
16 shades of gray = 4 bits
256 shades of gray = 8 bits
16 colors = 4 bits
256 colors = 8 bits
16 million colors = 24 bits
CMYK image = 32 bits

Not all levels of color or grayscale are supported by all the bitmap formats. If you have chosen a bitmap format 
that does not support a gray or color format, the option will not appear in the list box. For example, SCITEX CT is 
only exportable in CMYK, 32-bit format.



Dithers the colors and gray shades in the file. Dithering may produce better results when you use fewer colors 
than the original image. If the image contains fountain fills or color blends, dithering can cause obvious banding. 
Here are some guidelines to help you decide whether to dither the bitmap:

When you are importing 16 or 256 colors or grays, use dithering.
When you intend to scale the bitmap in another application, dithering is not recommended.



Specifies the resolution (in dots per inch) for bitmaps. Choose one of the preset resolutions from the list box or 
choose Custom and type or choose the resolution in the DPI box.

Note
As the resolution increases, so does the size of the file and the time required to print the image.



Specifies the dimensions of the bitmap. Choose one of the preset sizes from the list box or choose Custom and 
type the dimensions in the Width and Height boxes. If a size is not selected, the original size of the image is 
used.



Compresses the imported file so that it takes less disk space. Compressed files take more time to save and load. 
Compression is optional for some bitmap formats; for others, compression is always performed.



Shows the estimated size of the imported file before compression. Compressed files will be smaller than the 
value displayed.



Returns to the settings that were in effect when you opened the dialog box.



Enable to maintain equal horizontal and vertical resolution values. Any value entered in one box will cause the 
other box to change automatically.



Controls the width of the file in pixels. To change the file width, type (or use the scroll arrows to select) a new 
value.



Controls the height of the file in pixels. To change the file height, type (or use the scroll arrows to select) a new 
value.



Type (or use the scroll arrows to select) a new vertical resolution (dpi) value. Resolution refers to the fineness of 
image detail and the amount of information required to record, store, display and print an image. Resolution is 
measured in dots per inch (dpi), referring to the number of pixels used to construct an image. Choose a 
resolution in keeping with the resolution of both your monitor and (if you plan to print an image) printer. When 
you work with an image that you want to print, choose a resolution close to the maximum dpi output value of 
your printer, otherwise you may not be able to print much of what you see on screen. If you do not plan to print 
an image, you can freely choose a higher resolution to maximum image detail. Enter a value in the number box 
or use the scroll arrows to select a dpi value.

Note
High resolutions require large amounts of disk space.



Type (or use the scroll arrows to select) a new horizontal resolution (dpi) value. Resolution refers to the fineness 
of image detail and the amount of information required to record, store, display and print an image. Resolution is
measured in dots per inch (dpi), referring to the number of pixels used to construct an image. Choose a 
resolution in keeping with the resolution of both your monitor and (if you plan to print an image) printer. When 
you work with an image that you want to print, choose a resolution close to the maximum dpi output value of 
your printer, otherwise you may not be able to print much of what you see on screen. If you do not plan to print 
an image, you can freely choose a higher resolution to maximum image detail. Enter a value in the number box 
or use the scroll arrows to select a dpi value.

Note
High resolutions require large amounts of disk space.



Creates a smoother graphics file by removing the jagged edges from the original.







Toggles guideline visibility. When Show Guidelines is disabled, guidelines will not appear on the screen.



Toggles the guideline snap on and off. When Snap To Guidelines is enabled, objects dragged close to a guideline 
will fall into alignment with it.



Removes all existing horizontal, vertical, and slanted guidelines.



Click here to display an overview of this dialog box.
For Help on an item, click the question mark at the top of the dialog box, and then click the item.



IDH_GUIDELINES_SETUP_GUIDE_ADD (0x5400003A)



IDH_GUIDELINES_SETUP_GUIDE_DELETE (0x5400003B)



IDH_GUIDELINES_SETUP_GUIDE_DELETE_ALL (0x5400003C)



IDH_GUIDELINES_SETUP_GUIDE_HORZ (0x5400003D)



IDH_GUIDELINES_SETUP_GUIDE_MOVE (0x5400003E)



IDH_GUIDELINES_SETUP_GUIDE_POS (0x5400003F)



IDH_GUIDELINES_SETUP_GUIDE_SHOW_GUIDELINES (0x54000040)



IDH_GUIDELINES_SETUP_GUIDE_SNAP_GUIDELINES (0x54000041)



IDH_GUIDELINES_SETUP_GUIDE_UNITS (0x54000042)



IDH_GUIDELINES_SETUP_GUIDE_VERT (0x54000043)



IDH_CDRUI_THREADLIST_CDRUI_ABORTPROCESS (0x5400001A)



IDH_CDRUI_THREADLIST_CDRUI_HIGHERPRIORITY (0x5400001B)



IDH_CDRUI_THREADLIST_CDRUI_LOWERPRIORITY (0x5400001C)



IDH_CDRUI_THREADLIST_CDRUI_SUSPENDPROCESS (0x5400001D)



IDH_CDRUI_THREADLIST_CDRUI_THREADHELP (0x5400001E)



IDH_CDRUI_THREADLIST_CDRUI_THREADTITLE (0x5400001F)



IDH_ROLLUPPAGE_LEFTMOVEDOWN (0x54000064)



IDH_ROLLUPPAGE_LEFTMOVEUP (0x54000065)



IDH_ROLLUPPAGE_RIGHTMOVEDOWN (0x5400006E)



IDH_ROLLUPPAGE_RIGHTMOVEUP (0x5400006F)



IDH_CDRUI_TOOLPAGE_CDRUI_TB_NOITEMS



IDH_SETUP_GRID_CDRUI_SNAPTOFRAMES



IDH_SETUP_GRID_CDRUI_SNAPTOMARGINS



IDH_SETUP_GRID_SHOWMARGINS2



IDH_SETUP_GRID_SNAPTOFRAMES2



The units in which the current value is expressed.



The minimum increment. This is the amount by which the value will increase or decrease when you click one of 
the spin box arrows.



The units in which the increment value is expressed.



The highest value you can use.



The units in which the maximum value is expressed.



The lowest value you can use.



The units in which the minimum value is expressed.



Displays the roll-ups and roll-up groups that arrange to the left side of the screen.



Displays the roll-ups and roll-up groups that arrange to the right side of the screen.



Moves the current roll-up or roll-up group from the right list to the left list.



Moves the current roll-up or roll-up group from the left list to the right list.



Adds a new, empty roll-up group to the left list.



Adds a new, empty roll-up group to the right list.



The roll-up configuration that will appear on start up.



Resets the roll-up arrangements to their original configuration.



Removes the current roll-up group from the left list.



Moves the current group down.



Moves the current group up.



Removes the current roll-up group from the right list.



Moves the current group down.



Moves the current group up.



Opens the Customize dialog box, where you can change the configuration of your toolbar buttons.



Deletes a custom toolbar, or resets a built-in toolbar.



Displays the available toolbars. Enable the checkbox next to a toolbar to activate it. Click the toolbar's name tag 
to rename it.



Creates a new toolbar. Click Customize to add buttons to the new toolbar.



Enables large toolbar buttons.



Enables medium toolbar buttons.



Enables small toolbar buttons.



Displays the available commands. Double-click a command category to open it.



Displays the available commands. Double-click a command category to open it.



Gives a short description of    the selected command.



Resets the keyboard assignments to their original configuration.



Shows the new keyboard combination that you want to assign to the command. If you need to make a correction,
press the Backspace key.
You can have up to four layers of keystrokes. For example, the key combination CTRL+ALT+1,2,3,4 is 
accomplished by holding down the CTRL and ALT keys, then pressing the 1,2,3, and 4 keys in succession.



Shows the new keyboard combination that you want to assign to the command. If you need to make a correction,
press the Backspace key.
You can have up to four layers of keystrokes. For example, the key combination CTRL+ALT+1,2,3,4 is 
accomplished by holding down the CTRL and ALT keys, then pressing the 1,2,3, and 4 keys in succession.



Displays any commands assigned to the keyboard combination you typed. You cannot have the same 
combination for more than one command.



Displays any commands assigned to the keyboard combination you typed. You cannot have the same 
combination for more than one command.



Automatically resolves conflicts by erasing the old keyboard assignment, and prompting you to assign a new 
combination to the old command.



Displays any existing shortcut keys for the current command.



Displays any existing shortcut keys for the current command.



The name of the current keyboard assignment set.



The name of the current keyboard assignment set.



Assigns the new keyboard combination to the current command.



Deletes the selected shortcut keys.



Loads a new keyboard assignment table.



Saves the current keyboard assignment table.



Gives a short description of    the selected command



Displays the available commands. Double-click a command category to open it.



Adds the selected command to the menu.



Removes the selected command from the menu.



Adds a separating line to a menu below the current selection.



Adds a new menu.



Moves the current menu or menu entry up.



Moves the current menu or menu entry down.



Displays the current menu structure. Double-click a menu or sub-menu to open it.



Resets the menu assignments to their original configuration.



Gives a short description of    the selected command



Gives a short description of any toolbar button you click.



Displays the available command categories. Click a category to display its command buttons.



Displays the command buttons for the current command category. Click a button to see its description, or drag it 
to add it to any toolbar on the screen.



A command button. Click it to see its description, or drag it to add it to any toolbar on the screen.



Resets the toolbar assignments to their original configuration.



You can also open the color palette menu by right-clicking the palette border.



These controls let you change the appearance of the on-screen color palette.



The colors in the current palette. Right-click the palette border to open the Color Palette menu.



Shows and hides the color swatch borders.



Toggles between large and small color swatches.



Shows and hides the No Color swatch.



Specifies the number of rows of colors to be displayed while the color palette is docked.



Specifies the number of rows of colors to be displayed while the color palette is docked.



Specifies the number of rows of colors to be displayed while the color palette is docked.



These controls let you change the effect of right-clicking the color palette.



Changes the effect of right-clicking a color swatch on the palette.



Changes the effect of right-clicking a color swatch on the palette.



Determines the number of horizontal grid lines per unit of measure.
To space the grid lines more than one whole unit of measure apart, enter fractional values from the keyboard. 
For example, to space the grid lines two inches apart, enter 0.5. The maximum number of grid lines is 200 per 
inch, 33.3 per pica, 1.01 per point, 7.87 per millimeter, 1.01 per didot, and 35.52 per cicero.



Determines the number of horizontal grid lines per unit of measure.
To space the grid lines more than one whole unit of measure apart, enter fractional values from the keyboard. 
For example, to space the grid lines two inches apart, enter 0.5. The maximum number of grid lines is 200 per 
inch, 33.3 per pica, 1.01 per point, 7.87 per millimeter, 1.01 per didot, and 35.52 per cicero.



Determines the number of vertical grid lines per unit of measure.
To space the grid lines more than one whole unit of measure apart, enter fractional values from the keyboard. 
For example, to space the grid lines two inches apart, enter 0.5. The maximum number of grid lines is 200 per 
inch, 33.3 per pica, 1.01 per point, 7.87 per millimeter, 1.01 per didot, and 35.52 per cicero.



Determines the number of vertical grid lines per unit of measure.
To space the grid lines more than one whole unit of measure apart, enter fractional values from the keyboard. 
For example, to space the grid lines two inches apart, enter 0.5. The maximum number of grid lines is 200 per 
inch, 33.3 per pica, 1.01 per point, 7.87 per millimeter, 1.01 per didot, and 35.52 per cicero.



Determines the horizontal position of the zero point for the rulers relative to the lower left corner of the working 
page. Useful as a reference point when sizing and placing objects. You can also use the ruler crosshairs to set the
Grid Origin.



Determines the horizontal position of the zero point for the rulers relative to the lower left corner of the working 
page. Useful as a reference point when sizing and placing objects. You can also use the ruler crosshairs to set the
Grid Origin.



You can choose another unit of measure for the horizontal ruler from the units box. When you change units, you 
must specify the Grid Frequency you want to use with that unit.



Determines the vertical position of the zero point for the rulers relative to the lower left corner of the working 
page. Useful as a reference point when sizing and placing objects. You can also use the ruler crosshairs to set the
Grid Origin.



Determines the vertical position of the zero point for the rulers relative to the lower left corner of the working 
page. Useful as a reference point when sizing and placing objects. You can also use the ruler crosshairs to set the
Grid Origin.



You can choose another unit of measure for the vertical ruler from the units box. When you change units, you 
must specify the Grid Frequency you want to use with that unit.



Displays markers showing where the grid lines are.
The frequency of the grid marks is determined by the current view. When you use the Zoom tool to magnify the 
view, the frequency of the grid marks increases.



Forces objects drawn or moved close to a grid line into alignment with the grid. You can also toggle Snap To Grid 
using the Snap To Grid command in the Layout menu.



Opens the Drawing Scale dialog box where you can set a scale to your drawing other than one to one.



Represents the distance in your drawing that is equivalent to the World Distance value.



Displays the current Page Distance units. Click in this field to display a list of available units. The Page Distance 
value is automatically converted when you change units.



Displays the current World Distance units. Click in this field to display a list of available units. The World Distance
value is automatically converted when you change units.



Selects one of several pre-defined drawing scales. The Page Distance and World Distance values are updated to 
reflect your choice.



Represents the real distance, in inches, that is equivalent to the Page Distance in your drawing. 



Creates a slanted guideline at the position and angle you have specified.



The guideline definition method. You can define a slanted guideline using two points, or a single point and an 
angle. A guideline defined by the points (1,1) and (5,5) would follow the same path as a guideline starting at 
(1,1) with a 45-degree angle.



The guideline definition method. You can define a slanted guideline using two points, or a single point and an 
angle. A guideline defined by the points (1,1) and (5,5) would follow the same path as a guideline starting at 
(1,1) with a 45-degree angle.



The horizontal position of the guideline's origin point.



The horizontal position of the guideline's origin point.



The horizontal position of the guideline's first origin point.



The vertical position of the guideline's origin point.



The vertical position of the guideline's origin point.



The vertical position of the guideline's origin point.



The vertical position of the guideline's first origin point.



The guideline's angle, or the horizontal position of the second origin point.



The guideline's angle, or the horizontal position of the second origin point.



The guideline's angle.



The horizontal position of the guideline's second origin point.



The vertical position of the guideline's second origin point.



The vertical position of the guideline's second origin point.



The vertical position of the guideline's second origin point.



The current guideline definition.



Displays the current guideline units. Click to display a list of available units. The guideline position value is 
automatically converted when you change units.
Changing the guideline units has no effect on the Ruler units. To change the ruler display units, use the Grid & 
Ruler Setup command in the Layout menu.



Displays a list of existing slanted guidelines. Click a guideline to edit it.



Removes the selected guideline.



Removes all existing horizontal, vertical, and slanted guidelines.



Moves the current guideline to the position and angle you have specified.



Creates a vertical guideline at the position you have specified.



The guideline position. Click Add to make a new guideline at this point, or Move to change the selected 
guideline's position.



Displays the current guideline units. Click to display a list of available units. The guideline position value is 
automatically converted when you change units.
Changing the guideline units has no effect on the Ruler units. To change the ruler display units, use the Grid & 
Ruler Setup command in the Layout menu.



Displays a list of existing vertical guidelines. Click a guideline to edit it.



Removes the selected guideline.



Removes all existing vertical guidelines.



Moves the current guideline to the position you have specified.



Creates a horizontal guideline at the position you have specified.



The guideline position. Click Add to make a new guideline at this point, or Move to change the selected 
guideline's position.



Displays the current guideline units. Click to display a list of available units. The guideline position value is 
automatically converted when you change units.
Changing the guideline units has no effect on the Ruler units. To change the ruler display units, use the Grid & 
Ruler Setup command in the Layout menu.



Displays a list of existing horizontal guidelines. Click a guideline to edit it.



Removes the selected guideline.



Removes all existing horizontal guidelines.



Moves the current guideline to the position you have specified.



Changes the current value.



Displays the roll-ups in this group. Click a roll-up to activate it, or drag it to another part of the screen to split it 
from the group.



Customize command
Opens the Customize dialog box, where you can customize your toolbars, menus, status bar information, 
keyboard shortcuts, and other properties of the Corel user interface.





Customizing keyboard assignments
Accelerator keys give you quick access to commands that you use frequently.
You can change built-in keyboard assignments, or assign an accelerator key combination to any command. You 
can create several sets of keyboard assignments to use for different types of operations, saving and loading sets 
as they are needed.

{button ,AL(`cdrui_over;;;;;',0,"Defaultoverview",)} Related Topics



To assign an accelerator key to a command
1. Click Tools, Customize.
2. Click Keyboard.
3. In the Commands box, double-click the command category folder containing the command you want to 

customize.
4. Click the command.
5. Click the Press new shortcut key box.
6. Press the keyboard combination that you want to assign to the command. If you need to make a correction, 

press the Backspace key.
You can have up to four layers of keystrokes. For example, the key combination CTRL+ALT+1,2,3,4 is 
accomplished by holding down the CTRL and ALT keys, then pressing the 1,2,3, and 4 keys in succession.

Tip
To automatically resolve accelerator conflicts, enable the Go to conflict on assign option.

{button ,AL(`cdrui_key_proc;;;;;',0,"Defaultoverview",)} Related Topics



To remove an accelerator key from a command
1. Click Tools, Customize.
2. Click Keyboard.
3. In the Commands box, double-click the command category folder containing the command you want to 

customize.
4. Click the command.
5. In the Current shortcut keys box, select the key combination you want to remove.
6. Click Delete.

{button ,AL(`cdrui_key_proc;;;;;',0,"Defaultoverview",)} Related Topics



To restore all keyboard assignments to their original settings
1. Click Tools, Customize.
2. Click Keyboard.
3. Click Reset All.

{button ,AL(`cdrui_key_proc;;;;;',0,"Defaultoverview",)} Related Topics



To save a set of customized keyboard assignments
1. Click Tools, Customize.
2. Click Keyboard.
3. Click Save As.
4. Choose the Accelerator File in which you want to save your assignments.
Tip

To change the default settings, save your custom accelerator set over the file DEFAULT.ACL.

{button ,AL(`cdrui_key_proc;;;;;',0,"Defaultoverview",)} Related Topics



To load a set of customized keyboard assignments
1. Click Tools, Customize.
2. Click Keyboard.
3. Click Load.
4. Choose the Accelerator File you want to load.

{button ,AL(`cdrui_key_proc;;;;;',0,"Defaultoverview",)} Related Topics





Customizing menus
Your Corel menus are completely customizable. You can add commands to existing menus, or you can add new 
menus to the menu bar. You can change the order of the menus and their commands to give you quick, easy 
access to the functions you use most.
Note

When you customize your menus, keep in mind that the help topics referring to those menus do not 
change.

{button ,AL(`cdrui_over;;;;;',0,"Defaultoverview",)} Related Topics



To change the order of menus and menu commands
1. Click Tools, Customize.
2. Click Menu.
3. In the Menu box, click the menu or menu command you want to move. Double-click to open a menu or sub-

menu.
4. Click Move Up or Move Down.

{button ,AL(`cdrui_menu_proc;;;;;',0,"Defaultoverview",)} Related Topics



To add a command to a menu
1. Click Tools, Customize.
2. Click Menu.
3. In the Commands box, double-click the command category folder containing the command you want to add.
4. Click the command.
5. In the Menu box, click the menu or sub-menu where you want to add the command.
6. Click Add.
Tip

Use the Separator button to add organizational lines to your menus.

{button ,AL(`cdrui_menu_proc;;;;;',0,"Defaultoverview",)} Related Topics



To remove a menu or menu command
1. Click Tools, Customize.
2. Click Menu.
3. In the Menu box, click the menu or menu command you want to remove. Double-click to open a menu or sub-

menu.
4. Click Remove.

{button ,AL(`cdrui_menu_proc;;;;;',0,"Defaultoverview",)} Related Topics



To rename a menu
1. Click Tools, Customize.
2. Click Menu.
3. In the Menu box, click the menu or menu command you want to rename. Double-click to open a menu or sub-

menu.
4. Click the command's name tag, and type the new name.

{button ,AL(`cdrui_menu_proc;;;;;',0,"Defaultoverview",)} Related Topics



To change a menu command's accelerator key
1. Click Tools, Customize.
2. Click Menu.
3. In the Menu box, click the menu or menu command you want to rename. Double-click to open a menu or sub-

menu.
4. Click the command's name tag, and insert an ampersand (&) before the letter you want to use as an 

accelerator.
5. Remove all unnecessary ampersands.

{button ,AL(`cdrui_menu_proc;cdrui_key_proc;;;;',0,"Defaultoverview",)} Related Topics



To add a new menu
1. Click Tools, Customize.
2. Click Menu.
3. Click Add Menu.
4. Type a name for the new menu.
Tip

You can add a sub-menu to an existing menu by first double-clicking the existing menu.

{button ,AL(`cdrui_menu_proc;;;;;',0,"Defaultoverview",)} Related Topics



To restore the original menu settings
1. Click Tools, Customize.
2. Click Menu.
3. Click Reset All.
Note

You will lose all changes to the menu settings.

{button ,AL(`cdrui_menu_proc;;;;;',0,"Defaultoverview",)} Related Topics









Customizing toolbars
Except for the toolbox and its flyouts, you have complete control over the commands on your toolbars. With 
simple mouse actions, you can dock, undock, resize, and move your toolbars anywhere on the screen.
You can also add and remove buttons to the built-in toolbars, or create your own toolbars containing only the 
commands you use most often.
Note

When you customize your toolbars, keep in mind that the help topics referring to those toolbars do not 
change.

{button ,AL(`cdrui_over;;;;;',0,"Defaultoverview",)} Related Topics





Customizing toolbars
You have complete control over your toolbars. With simple mouse actions, you can dock, undock, resize, and 
move your toolbars anywhere on the screen.
The Toolbars dialog box to controls which toolbars are displayed on the screen at any given moment.

{button ,AL(`cdrui_over;;;;;',0,"Defaultoverview",)} Related Topics





To move a toolbar
1. Click the border of the toolbar.
2. Drag it to its new location. Right-click to cancel the movement.
Tip

Double-click a toolbar's title or border to dock and undock it.

{button ,AL(`cdrui_toolbars_proc;;;;;',0,"Defaultoverview",)} Related Topics



To resize a toolbar
1. Move the cursor to the edge of a floating toolbar.
2. Drag the edge until the toolbar is the correct size. Right-click to cancel the movement.

{button ,AL(`cdrui_toolbars_proc;;;;;',0,"Defaultoverview",)} Related Topics



To display an existing toolbar
1. Click View, Toolbars.
2. Click the check box next to the toolbar that you want to activate.

{button ,AL(`cdrui_toolbars_proc;;;;;',0,"Defaultoverview",)} Related Topics



To create a custom toolbar
1. Click View, Toolbars.
2. Click New.
3. Type a name for the new toolbar.
4. Use the Customize command to add commands buttons to the new toolbar (See Related Topics).

{button ,AL(`cdrui_toolbars_proc;;;;;',0,"Defaultoverview",)} Related Topics



To add a button to a toolbar
1. Activate the toolbar you want to edit (See Related Topics).
2. Click View, Toolbars.
3. Click Customize.
4. In the Commands box, click the command category folder containing the command you want to add.
5. Drag the appropriate command button to the toolbar. Right-click to cancel the movement.
Tip

Click a button to see its description.
You can also hold down the CTRL and ALT keys and drag a button to copy it to another toolbar without 

opening the dialog box.

{button ,AL(`cdrui_toolbars_proc;;;;;',0,"Defaultoverview",)} Related Topics



To remove a button from a toolbar
1. Activate the toolbar you want to edit (See Related Topics).
2. Click View, Toolbars.
3. Click Customize.
4. Drag the button off the toolbar. Right-click to cancel the movement.
Tip

You can also hold down the ALT key and drag a button off a toolbar to delete it without opening the dialog 
box.

{button ,AL(`cdrui_toolbars_proc;;;;;',0,"Defaultoverview",)} Related Topics



To rename a toolbar
1. Click View, Toolbars.
2. Click the toolbar you want to rename.
3. Click the toolbar's name tag.
4. Type the new name.

{button ,AL(`cdrui_toolbars_proc;;;;;',0,"Defaultoverview",)} Related Topics



To move a toolbar button
1. Activate the toolbar you want to edit (See Related Topics).
2. Click View, Toolbars.
3. Click Customize.
4. Drag the button to another toolbar, or to another spot on the same toolbar. Right-click to cancel the 

movement.
Tip

To add space between two toolbar buttons, drag the right-most button slightly further to the right.
You can also hold down the ALT key and drag a button to move it without opening the dialog box.

{button ,AL(`cdrui_toolbars_proc;;;;;',0,"Defaultoverview",)} Related Topics



To delete a custom toolbar
1. Click View, Toolbars.
2. Click the custom toolbar you want to delete.
3. Click Delete.
Note

You cannot delete a built-in toolbar.

{button ,AL(`cdrui_toolbars_proc;;;;;',0,"Defaultoverview",)} Related Topics



To restore the original configuration of a built-in toolbar
1. Click View, Toolbars.
2. Click the built-in toolbar you want to reset.
3. Click Reset.

{button ,AL(`cdrui_toolbars_proc;;;;;',0,"Defaultoverview",)} Related Topics







Customizing the status bar
The status bar gives you constant, up-to-date information about your document. You can control the information 
it gives you so that you always know what you need to know about your work.

{button ,AL(`cdrui_over;;;;;',0,"Defaultoverview",)} Related Topics



To move the status bar
1. Right-click the status bar.
2. In the Status Bar menu, click Place at Top or Place at Bottom.

{button ,AL(`cdrui_status_proc;;;;;',0,"Defaultoverview",)} Related Topics



To change the number of status bar display regions
1. Right-click the status bar.
2. In the Status Bar menu, click Number of Regions.
3. Click the number of regions you want displayed.
Tip

You can have up to six regions displaying different information on a small status bar. When you use a large 
status bar, you have space for double that amount (see Related Topics).

{button ,AL(`cdrui_status_proc;;;;;',0,"Defaultoverview",)} Related Topics



To change what the status bar displays
1. Right-click the area of the status bar you want to change.
2. In the Status Bar menu, click Show.
3. Click the type of information you want to display.
Tip

To clear the current region, click None.

{button ,AL(`cdrui_status_proc;;;;;',0,"Defaultoverview",)} Related Topics



To resize the status bar
1. Right-click the status bar.
2. In the Status Bar menu, Click Large Status Bar or Small Status Bar.

{button ,AL(`cdrui_status_proc;;;;;',0,"Defaultoverview",)} Related Topics





Working with grids and rulers
Among its many powerful drawing aids, CorelDRAW allows you to display rulers at the edges of the Drawing 
window that help determine the size and position of objects in your drawing. CorelDRAW also provides an 
adjustable grid that lets you align these objects. Using these tools, you can give your drawing the precise look 
you want.
The Grid and Ruler Setup dialog box provides controls that let you set the grid and ruler parameters, including 
scale, units, and frequency. You can use rulers or a grid to help you align objects in your drawing.

{button ,AL(`guidelines_overview;;',0,"Defaultoverview",)} Related Topics





Drawing Scale dialog box
Use the Drawing Scale dialog box to set the scale for your drawing. For example, if you are drawing floor plans 
for your office, this feature allows you to specify how many units on your page (the Page Distance) are 
equivalent to a given number of units on the floor (the World Distance). 
Note

The units you specify in Page Distance are the units used by the Contour Roll-Up and Transform Roll-Up. 
These units are also the ones used for the rulers. However, if the Drawing Scale is set to its default values (where 1 
inch of Page Distance equals 1 inch of World Distance), the rulers use the units specified for Grid Frequency.

{button ,AL(`grid_and_ruler_overview;',0,"Defaultoverview",)} Related Topics





To set ruler parameters
1. Click Layout, Grid & Ruler Setup.
2. Click the Ruler tab.
3. In the Horizontal and Vertical Unit boxes, specify the unit of measurement you want displayed on the ruler.
4. Set the 0,0 point in the Horizontal and Vertical Original number boxes.

The 0,0 points determine the cursor and object position information you see in the Status Line. The coordinate 
values you specify in some dialog boxes are also based on the position of the 0,0 points.

5. Click OK.
Tip

You can drag the cross hairs onto the drawing window to set the Horizontal and Vertical origins.

{button ,AL(`grid_procedures;;;;',0,"Defaultoverview",`proc4')} Related Topics



To change the units of measurement on the rulers
1. Click Layout, Grid & Ruler Setup.
2. Click the Ruler tab.
3. In the Horizontal Units box, choose the unit of measurement you want the horizontal ruler to use.
4. In the Vertical Units box, choose the unit of measurement you want the vertical ruler to use.
5. Click OK.

{button ,AL(`grid_procedures;;;;',0,"Defaultoverview",`proc4')} Related Topics



To reposition the rulers
1. Hold down the SHIFT key and click the ruler you want to move.
2. Drag it to a new position.
Tip

To return a ruler to its previous position, hold down the SHIFT key and double-click it.
To move both rulers at once, hold down the SHIFT key and drag the intersection point of the two rulers.

{button ,AL(`grid_procedures;;;;',0,"Defaultoverview",`proc4')} Related Topics



To display or hide the grid
1. Click Layout, Grid & Ruler Setup.
2. Click the Grid tab.
3. Enable or disable the Show Grid check box.

{button ,AL(`grid_procedures;;;;',0,"Defaultoverview",`proc4')} Related Topics



To set grid parameters
1. Click Layout, Grid & Ruler Setup.
2. Click the Grid tab.
3. Under Grid Frequency, specify the number of Horizontal and Vertical grid lines you want per unit of measure.

The unit of measure corresponds to the unit set for the rulers.
4. Enable the Show Grid check box to display the grid in the drawing window. Enable the Snap to Grid check box 

to have objects snap to the grid.
Notes

When you change the ruler units, you must also specify a new grid frequency. Changing the grid frequency 
unit also changes the corresponding ruler unit. If the drawing scale setting is not 1:1, the Grid Frequency units 
appear grayed out and correspond to the drawing scale units.

To space the grid lines more than one whole unit apart, type a fractional value in the Grid Frequency field. 
If the unit of measure is set to inches, for example, you can specify 0.5 to space the grid lines two inches apart.

The Horizontal and Vertical field units are accurate up to two decimal places.

{button ,AL(`grid_procedures;;;;',0,"Defaultoverview",)} Related Topics





Working with guidelines
Guidelines provide a useful and easy way to align objects. Guidelines are non-printing lines that you can place 
anywhere in the drawing window. You can create any number of guidelines and have CorelDRAW save them 
along with your drawing.
The Guidelines Setup dialog box provides controls that let you set up horizontal, vertical, and slanted guidelines.
 

{button ,AL(`grid_and_ruler_overview;;;;;',0,"Defaultoverview",)} Related Topics



To move a horizontal or vertical guideline
1. Click Layout, Guidelines Setup.
2. Click the Horizontal or Vertical tab.
3. Choose the guideline you want from the list of guidelines. The guidelines are listed by location.
4. Specify the location you want relative to the 0 point on the guideline's ruler.
5. Change the unit of measure as required.
6. Click Move.
Tip

You can also move a guideline by dragging it. However, If you drag a horizontal or vertical guideline by the 
handles at the edge of the drawing window, it will convert to a slanted guideline, and cannot be converted back 
(see Related Topics).

{button ,AL(`guideline_procedures;;;;',0,"Defaultoverview",)} Related Topics



To move a slanted guideline
1. Click Layout, Guidelines Setup.
2. Click the Slanted tab.
3. Choose the guideline you want from the list of guidelines. The guidelines are listed by the coordinates of their 

endpoints.
4. Choose a two-point guideline or one that has an angle and one point.
5. Change the unit of measure as required.
6. Type the guideline's new endpoint coordinates in the four boxes provided; X1, Y1, X2, and Y2.
7. Click Move.
Tip

You can also move a guideline by dragging the handles where it meets the edge of the drawing window.

{button ,AL(`guideline_procedures;;;;;',0,"Defaultoverview",)} Related Topics



To set up a horizontal guideline
1. Click Layout, Guidelines Setup.
2. Click the Horizontal tab.
3. Type the units and the location relative to the 0,0 point on the rulers.
4. Click Add.
Tip

You can also set up a horizontal guideline by pointing to the horizontal ruler and dragging into the drawing 
window.

{button ,AL(`guideline_procedures;;;;;',0,"Defaultoverview",)} Related Topics



To set up a slanted guideline
1. Click Layout, Guidelines Setup.
2. Click the Slanted tab.
3. Type the units and endpoint coordinates (X1, Y1, X2, and Y2) relative to the 0,0 point on the rulers.
4. Click Add.
Tip

You can also set up a slanted guideline by creating a horizontal or vertical guideline, then dragging one of 
the handles until the guideline reaches the desired angle.

{button ,AL(`guideline_procedures;;;;',0,"Defaultoverview",)} Related Topics



To set up a vertical guideline
1. Click Layout, Guidelines Setup.
2. Click the Vertical tab.
3. Type the units and the location relative to the 0,0 point on the rulers.
4. Click Add.
Tip

You can also set up a vertical guideline by pointing to the vertical ruler and dragging into the drawing 
window.

{button ,AL(`guideline_procedures;;;;;',0,"Defaultoverview",)} Related Topics



To delete a guideline
1. Click Layout, Guidelines Setup.
2. Click the tab that corresponds to the type of guideline you want to delete.
3. Choose the guideline you want to delete.
3. Click Delete.
Tip

You can also delete a horizontal or vertical guideline by dragging it off the drawing window.

{button ,AL(`guideline_procedures;;;;;',0,"Defaultoverview",`proc4')} Related Topics



To position slanted guidelines using the rulers
1. If you don't see the horizontal and vertical rulers, click View and enable Rulers.
2. Point to the horizontal or vertical ruler.
3. Click and drag the guideline onto the drawing window.
4. Click and drag one of the guideline handles until it is at the desired angle.
Note

Once you have converted a horizontal or vertical guideline to a slanted guideline, you cannot convert it 
back.

{button ,AL(`guideline_procedures;;;;',0,"Defaultoverview",)} Related Topics



To position slanted guidelines using the Guidelines Setup box
1. Click Layout, Guidelines Setup.
2. Click Slanted Guideline.
3. Type the guideline angle relative to the 0,0 points on the ruler.
4. Click Add.

{button ,AL(`guideline_procedures;;;;',0,"Defaultoverview",)} Related Topics





(On the left or right side of the Navigator.) Adds a page to your document.



(In the bottom, left-hand corner of the window.) Helps you move through your document quickly.



(In the upper, right-hand corner of a roll-up.) Minimizes and maximizes the roll-up.



(On the right side of the Navigator.) Displays the last page of your document.



(On the left side of the Navigator.) Displays the first page of your document.



Jumps to the specified page of your document.



Launches installed Corel applications.



Removes the current fill or outline color.
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2D (two-dimensional)
3D (three-dimensional)
3D Riser
A sizes
ABK
Absolute reference
Active window
Actor
AI
Alignment, relative
Alignment, text
Alpha channel
Ambient_light
Amplify
Animation Frame
Animation Path
ANSI
Anti-alias
Application Command
Area
Argument
array
Artistic Text
Ascender
Ascending Scale
ASCII



Aspect ratio
Attitude
Attributes
Auto-panning
Autotrace
AVI
Axis
Axis Gridlines (3D charts)
Axis Riser Grid Lines
Axis Text

B size
Background
Background View
Backup
BAK
Bar (High-Low-Open-Close Chart)
Baseline
Baseline Shift
Bezier Curve
Bezier drawing mode
binary
Bipolar Line
Bit depth
Bitmap
Bitmap texture
Black point
Bleed
Blend
BMP
Boolean variable
Bounding box
breakpoint
Brighten
Brightness
Brightness and Contrast filter
Bulb light
Bullet
by reference
by value

Calibration
Calibration bar
Calligraphic
callout
Cap height
Category
Category Axis Grid Lines
CDR



Cel
Cel animation
Cell
Cell Addresses
Center of rotation
CGM
Channel
Character Attributes
Character Code
Character Set
Chart Objects
Chart Title
Charting Area
Charting Window
Check box
Child
Choke
Chromaticity
Cicero
CIE
Click
Clipart
Clipboard
Clipping hole
Clone
CMY
CMYK
Co-planar
Color depth
Color Manager
Color mask
Color mode
Color Palette
Color proof
Color Separation
Color, RGB
Colorimetric
Column Header Area
Column Header Labels
Combination Charts
Combining
Command
Command button
compile-time
Complex Object
Component, shader
Composite
Compound blend
Concentric



Conical camera
Conical fill
connector lines
constant
Constant Value
Constrain
Continuous tone
Contrast
Control menu
Control object
Control point
Corel PHOTO-PAINT
CORELAPP.INI
CORELDRW.INI
CORELFLT.INI
CORELFNT.INI
CORELPNT.INI
CORELPRN.INI
CorelTRACE
CPT
Create Object Mode
Crop
Crop marks
Cross section
Crosshairs
Cursor
Curve Fit Correlation Coefficient
Curve object
Cusp
Cusp Node

Data Axis Major Grid Lines
Data Axis Minor Grid Lines
Data Cell
Data Marker
Data Range
Data Sheet Error Values
data type
Database
Datasheet
Datasheet Functions
debug
declaration, constant
declaration, variable
Default Paragraph Text
Default printer
Default settings
Defringe
Densitometer scale



Descender
Descending Scale
Deselect
Destination file
Device driver
Dialog box
DIC
Didot
Dimension lines
Direction keys
Directory
Display screen:
Distant light
Dither
Dithered color
DLL
Dot gain
Double-click
Downloadable fonts definitions
DPI
Draft Mode
Drag
Drawing window
Drive
Duotone
Dupont palette
DXF

Edit
Editable preview
Em
Embedded object
Emboss
Emulsion
En
End node
Envelope
EOF
EPS
Equalize filter
Exponential Regression
Expression
Extension
Extrude

Face
Fade
Fade out
Feathering



FH3
Fibonacci
Field
File previewer
Fill color
Film
Film recorder
Filter
Financial Moving Average
Flyout
FOCOLTONE
Folder
Font
Footer
Footnote
Force Justification
Force Line Breaks
Formula
Formula Bar
Fountain fill
Four-color process
FPS
Frame
Freehand drawing mode
Full-color pattern
function
Functions
Functions, Shader

G-Buffer (Geometry Buffer)
Gamut
Gamut Mapping
GDF
GEM
GIF
Global Universe
Gradient
Gravity
Gray component replacement (GCR)
Grayscale image
Greeking
Grid
Grid Lines
Group
Guidelines
Gutter

Halftone
Halftone screen



Handles
Hanging Indent
Header
Headers (Category Axis)
Headers (Second Category Axis)
Hierarchy
Highlight
Highlighting box
Hints
Histogram
Hot Point
Hotkeys
Hourglass cursor
HPGL
HSB
Hue

Icon
identifier
Image setter
In-Cell Editing
Indent
initialization
Insert Video
Insertion Point
Instance
Integers
Intensity
Inter-character Spacing
Inter-Line Spacing
Inter-Paragraph Spacing
Inter-Word Spacing
Interruptible Display
intrinsic statement
Irrational Numbers
Isometric camera

Jaggies
JPEG (Joint Photographic Experts Group)
Justify

Kerning

LAB
Landscape
Layer
Leader Tabs
Left Wall
Letter Spacing



Limitcheck error
Line art
Line style
Linear fill
Linear Regression
Linked object
Lino
List box
Local Universe
LPI
Luminosity

Marquee
Marquee select
Mask
Mask Channel
Master
Master layer
Maximize
Mean
Menu
Menu bar
Merge mode
Minimize
Mirror
Mirror Editing
Mixed Reference
Modeling_box
Moire pattern
Monochrome
Moving Average 
Multimedia
Multiple select
Mute

Natural Logarithmic Regression
Negative
Nested powerclips
Newspaper-Style Columns
Nib
Nodes
Non-Numeric Axis
Numeric Axis (Data, 2nd Data, X, Y)

Object
Object/Group Coordinate System
One-point perspective
Opacity
Opaque



Open Prepress Interface (OPI)
Operator
Operators
Order box 
Orientation
Out-of-gamut color
Overprint

Page border
Paint Color
Paint mode
Paint program
Paint shape
Palette
PANTONE Process colors palette(definition)
PANTONE Spot colors palette(definition)
Paper Color
Paragraph Text
Parent
PAT
Path
Path name
PCT
PCX
Photo CD
Photographic Chroma Mapping
Photoshop PSD
PIC
Pica
PICT
PIF
Pipeline
Pitch
Pixel
Pixmap
Plane
Playback
PLT
Plug-in filters
Point
Point of view (also viewpoint)
Point Size
Polynomial Regression Line
Portable
Portrait
Position, absolute
Position, relative
Positive
PostScript



PostScript textures
Power Law Regression
PowerLine Node
PowerClip
Powerlines
Presentation Window
Preset brush type
Preview
Preview screen
Primary mouse button
Printable page
procedure
Process color
Projection
Proof
Prop
Pure color

QuickTime

Radial fill
Radio button
Range Kerning
Rasterizer
Rational Numbers
Ray tracing
Real Numbers
Reference
Reflection
Refraction
Registration mark
Relative Reference
Render
Resample
Resident fonts
Resolution
return value
RGB
Right Wall
Riser Bar
Roll
Roll-up
Root
Rotate
Row Header Area
Row Header Labels
Row Title Area
Row Title Label
Ruler crosshairs



Rulers
run
runtime

Sans Serif
Saturation
Scale
Scaling, object
Scaling, text
Scanner
Scatter Label (3D)
Scatter Line
Scatter Marker
Scientific Moving Average 
Scitext
SCODL
Screen angles
Screen frequency
script
Scroll
Second Category Axis Title
Second Y Axis
Second Y Axis Scale
Second Y Axis Title
Secondary mouse button
Section (in numeric format)
seed value
Segments
Select
Sentence element
Separators
Sequence
Series Header
Series Title
Serif
Service bureau
Shader
Shader Tree
Shadow
Shape
Show Correlation Coefficient
Single Cel Actor
Skew
Skinning
Slide
Slide sorter
Slide View
Smooth
Smooth Curve



Smooth Factor Box
Smooth Node
Snap
Source file
Speaker Notes
Specific Light
Spectral power distribution
Spot color
Spot light
Spreads
Square fill
Standard Deviation
Standard Illuminant
Start node
Status line
Stretch
Style Template
Styles
Subpaths
subroutine
Subscript
Superscript
Sweep Path
Symbol
Symmetrical
Symmetrical Node
Synchronization
syntax

Tab
Template
Text Styles
Texture fill
Texture map
TGA
Threshold
Thumbnail
TIFF (Tagged Image File Format)
Tile
Tiling
Timelines
Tint
Tints
Title bar
Toggle
Tolerance
Toolbox
TOYO Palette
trace



Transformation
Transition Effect
Translation
Translucence
Transparency mask
Transparent
Trap
True Color
TrueType Fonts
TRUMATCH
Two-color pattern
Two-point perspective
Type Assist
Type style
type-declaration character
Typeface

Undercolor removal (UCR)
Uniform color
Universe

Values
variable
Vector graphics
Vertex
Viewpoint

Waveform
Weight
Welding
WFN
White Point
Whole Numbers
WIN.INI
Window
Wireframe view
WMF
Word Spacing
Working Box
Working Box System
Working page
WPG
WYSIWYG

X-Axis
X-height

Y Axis
Yaw



YIQ

Z-Axis Scale (Left)
Z-Axis Scale (Right)
Z-Axis Title (Left)
Z-Axis Title (Right)
Z-Buffer
Zero Line




